Contents

Before you begin .......................................................... 11
Welcome ........................................................................... 11
How to use this guide ....................................................... 12
Symbols and conventions ................................................ 12
Related documentation .................................................... 13

1
What is the OrCAD Capture CIS System? .................... 15
CIS in the PCB design process .......................................... 16
The CIS work environment .............................................. 17
The CIS explorer window ............................................... 18
The part manager window ............................................... 21

2
Setting up OrCAD Capture CIS ........................................ 25
Creating a part database ................................................ 25
Choosing a database format ........................................... 26
CIS Database Feature Support ......................................... 27
Determining part properties ........................................... 29
Setting the field format ................................................ 37
Using more than one table ............................................. 37
Using related tables ..................................................... 37
Creating a part database from an existing design ............ 38
Extracting ERP or MRP database part information .......... 40
Setting up the ODBC data source ................................. 41
Creating a configuration file ......................................... 43
Using the database configuration wizard ....................... 45
Creating a configuration file manually ......................... 50
Editing a configuration file .......................................... 52
Setting database table property options ....................... 53
Defining part reference associations ............................................ 59
Setting administrative preferences ........................................... 63
Setting Relational Database preferences .................................... 67
Saving the configuration file .................................................... 69
Creating Crystal Reports templates ........................................... 69

3
Working with database parts .................................................... 73
Using the CIS interface ............................................................ 73
  Using the part manager window .............................................. 74
  Using the CIS explorer window ............................................. 76
Placing a database part on a schematic page ............................... 81
  Using the explorer to locate a database part .............................. 81
  Using the query feature to locate database parts ........................ 82
  Placing a local database part on your schematic ......................... 88
Browsing part properties ......................................................... 91
Creating a new database part .................................................... 92
  Deriving a new database part from the local part database ............ 92
  Deriving a new database part from a placed part ....................... 97
Linking a placed part to a database part ................................... 101
  Linking External Parts ....................................................... 102
  Setting linking preferences ................................................ 102
  Linking part occurrence(s) to a database part ......................... 108
Viewing a placed part’s database properties ............................... 110
  To view a placed part’s database properties ............................. 110
Copying part properties using the part manager ........................... 111
Exporting Variant List to PCB Editor using Part Manager ............... 112
  The Variant.cfg File ....................................................... 113
  To create the Variants.lst File .......................................... 113

4
Defining and Using Groups and Subgroups ............................... 115
Using the part manager window tree view ................................ 115
  The tree view structure .................................................. 115
  The Part Manager Window ................................................ 119
Creating BOM variants for your core design .................................................. 121
Adding folders to create new groups, subgroups, and BOM variants ............... 122
Populating groups and subgroups with components .................................... 124
Copying groups, subgroups, and BOM variants to quickly create new variants . 125
Renaming groups, subgroups, and BOM variants ......................................... 126
Deleting groups, subgroups, and BOM variants .......................................... 127
Changing groups of components from the schematic page editor .................. 128

5
Finalizing and documenting designs ............................................................ 131
Viewing and updating part status .................................................................. 131
  Opening the part manager ........................................................................... 132
  Updating the part status for your design .................................................... 133
  Saving the status report .............................................................................. 137
Creating bill of materials variants ................................................................. 137
  Creating a new BOM variant ....................................................................... 138
  Populating BOM variants .......................................................................... 139
  Modifying BOM variants .......................................................................... 140
  Renaming a BOM variant ........................................................................... 141
  Deleting BOM variants .............................................................................. 141
  Resolving part ambiguity ............................................................................ 144
Viewing design variants on a schematic page ............................................... 145
  Searching for variant information on a schematic page ............................... 147
  Customizing variant information display on a schematic page .................... 149
  Viewing variant properties ......................................................................... 150
  Viewing variant name in Title Block ............................................................ 150
  Previewing or printing design variant schematic pages ............................... 151
Creating reports ............................................................................................. 152
  Creating a standard CIS bill of materials ................................................... 153
  Including mechanical parts and assemblies in standard CIS BOM ......... 162
  Creating a report using a Crystal Reports template .................................. 171
  Creating a BOM variant report .................................................................... 176
# Menu commands

## Edit menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Part(s) To Group command</td>
<td>186</td>
</tr>
<tr>
<td>Copy command</td>
<td>186</td>
</tr>
<tr>
<td>Delete command</td>
<td>187</td>
</tr>
<tr>
<td>Derive Database Part command</td>
<td>187</td>
</tr>
<tr>
<td>Derive New Database Part command</td>
<td>188</td>
</tr>
<tr>
<td>Link Database Part command</td>
<td>188</td>
</tr>
<tr>
<td>New BOM variant command</td>
<td>188</td>
</tr>
<tr>
<td>New Group command</td>
<td>189</td>
</tr>
<tr>
<td>New Subgroup command</td>
<td>189</td>
</tr>
<tr>
<td>Paste command</td>
<td>189</td>
</tr>
<tr>
<td>Remove command</td>
<td>189</td>
</tr>
<tr>
<td>Remove Part(s) from Group command</td>
<td>190</td>
</tr>
<tr>
<td>Rename command</td>
<td>190</td>
</tr>
<tr>
<td>Resolve Ambiguity command</td>
<td>190</td>
</tr>
<tr>
<td>Revert to Common command</td>
<td>191</td>
</tr>
<tr>
<td>Set Part As Not Present command</td>
<td>191</td>
</tr>
<tr>
<td>Set Part As Present command</td>
<td>191</td>
</tr>
</tbody>
</table>

## Help menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>About OrCAD Capture CIS command</td>
<td>192</td>
</tr>
<tr>
<td>Known Problems and Solutions command</td>
<td>192</td>
</tr>
<tr>
<td>What's New command</td>
<td>192</td>
</tr>
<tr>
<td>Learning OrCAD Capture CIS command</td>
<td>192</td>
</tr>
<tr>
<td>Documentation command</td>
<td>193</td>
</tr>
</tbody>
</table>

## Options menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>CIS Configuration command</td>
<td>193</td>
</tr>
<tr>
<td>Verify Part Against (OLB) Libraries command</td>
<td>193</td>
</tr>
<tr>
<td>Extended CIS Linking command</td>
<td>194</td>
</tr>
</tbody>
</table>

## Place menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database Part command</td>
<td>195</td>
</tr>
</tbody>
</table>

## Reports menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Crystal Reports command</td>
<td>195</td>
</tr>
<tr>
<td>Standard command</td>
<td>196</td>
</tr>
<tr>
<td>Command</td>
<td>Page</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Variant Report command</td>
<td>196</td>
</tr>
<tr>
<td>Tools menu</td>
<td>196</td>
</tr>
<tr>
<td>Link Database command</td>
<td>197</td>
</tr>
<tr>
<td>View Database Part Command</td>
<td>197</td>
</tr>
<tr>
<td>Open command (Part Manager)</td>
<td>197</td>
</tr>
<tr>
<td>Update command (Part Manager)</td>
<td>198</td>
</tr>
<tr>
<td>Update All Part Status command</td>
<td>198</td>
</tr>
<tr>
<td>Update Selected Part Status command</td>
<td>199</td>
</tr>
<tr>
<td>Test Bench commands</td>
<td>199</td>
</tr>
<tr>
<td>Update menu</td>
<td>201</td>
</tr>
<tr>
<td>Place Database Part command</td>
<td>201</td>
</tr>
<tr>
<td>Re-search Database command</td>
<td>201</td>
</tr>
<tr>
<td>Refresh Part Types command</td>
<td>201</td>
</tr>
<tr>
<td>Refresh Symbols from Libs command</td>
<td>202</td>
</tr>
<tr>
<td>View menu</td>
<td>202</td>
</tr>
<tr>
<td>Configure Part Properties command</td>
<td>203</td>
</tr>
<tr>
<td>Database Part command (View menu)</td>
<td>203</td>
</tr>
<tr>
<td>Expand / Collapse Tree Item command</td>
<td>203</td>
</tr>
<tr>
<td>Footprint command</td>
<td>204</td>
</tr>
<tr>
<td>Part command</td>
<td>204</td>
</tr>
<tr>
<td>Show / Hide Tree View command</td>
<td>204</td>
</tr>
<tr>
<td>Toolbar command (CIS explorer)</td>
<td>204</td>
</tr>
<tr>
<td>Toolbar command (Part Manager)</td>
<td>205</td>
</tr>
<tr>
<td>Visibility command</td>
<td>205</td>
</tr>
<tr>
<td>Variant View Mode command</td>
<td>205</td>
</tr>
<tr>
<td>Relational Table View command</td>
<td>205</td>
</tr>
<tr>
<td>Hide Column command</td>
<td>206</td>
</tr>
<tr>
<td>Unhide Column command</td>
<td>206</td>
</tr>
</tbody>
</table>

7 Dialog box descriptions

Browse Data Source dialog box                                           | 207  |
CIS Configuration File dialog box                                        | 207  |
Configure Database dialog box                                             | 208  |
  Configure Database dialog box (Part Database tab)                      | 209  |
Configure Database dialog box (Administrative Preferences tab) ................. 212
Configure Database dialog box (Part Reference Associations tab) ............... 214
Configure Database dialog box (Relational Database tab) ......................... 215
Configure Part Property Display dialog box ........................................... 216
Crystal Reports Bill of Materials dialog box ............................................. 217
Database Configuration Wizard ............................................................. 218
   Database Configuration Wizard (Welcome Page) .................................. 218
   Database Configuration Wizard (Select Data Source) ............................ 219
   Database Configuration Wizard (Configuring Tables) ........................... 219
   Database Configuration Wizard (Property Types to Table Properties) ....... 220
   Database Configuration Wizard (Assigning Property Types) .................. 220
   Database Configuration Wizard (Assigning Property Tables) .................. 221
   Database Configuration Wizard (Property Transfer) ............................. 221
   Database Configuration Wizard (Selecting Browsable Properties) ............. 222
   Database Configuration Wizard (Setting Property Visibility) ................... 223
   Database Configuration Wizard (Selecting Keyed Properties) ................. 223
   Database Configuration Wizard (Assigning Activeparts Property Type) .... 224
Enter Parameter Values dialog box ....................................................... 224
New Database Part dialog box ............................................................ 225
Select Footprints dialog box ............................................................... 226
Select Schematic Part dialog box .......................................................... 227
Standard Bill of Materials dialog box ..................................................... 228
Unhide Columns dialog box .................................................................... 232
Update Part dialog box ........................................................................... 232
Variant Report dialog box ....................................................................... 233
Occurrence Level Settings dialog box ...................................................... 235
Extended CIS Linking dialog box ............................................................. 235
Select a Design Variant dialog box ......................................................... 236
Export Variant List dialog box ............................................................... 236

8
Window descriptions .................................................................................. 237
CIS explorer window ............................................................................... 237
   Footprint window ................................................................................. 237
   Part window ......................................................................................... 238
OrCAD CIS User Guide

Visibility window ............................................................... 238
Explorer window .............................................................. 239
Database parts window ....................................................... 241
Part manager window .......................................................... 242
Variant Property Viewer window ........................................ 243

9
Toolbar descriptions .......................................................... 245
CIS Explorer Toolbar .......................................................... 245
Part Manager Toolbar ........................................................ 246

10
Additional CIS Utilities ....................................................... 249
CIS Administration Tool ..................................................... 249
OrCAD - Viewlogic Translator ............................................ 257
OrCAD Capture CIS Starter Database Kit .............................. 257
OrCAD CIS Wizard ........................................................... 257
ESP CAD Library .............................................................. 258

11
CIS Error and Warning Messages ...................................... 259
Glossary .............................................................................. 265

Index .................................................................................... 277
Before you begin

Welcome

OrCAD® family products offer a total solution for your core design tasks: schematic- and VHDL-based design entry; FPGA and CPLD design synthesis; digital, analog, and mixed-signal simulation; and printed circuit board layout. What's more, OrCAD family products are a suite of applications built around an engineer's design flow—not just a collection of independently developed point tools. Schematics is just one element in our total solution design flow.

OrCAD® Capture CIS (henceforth referred to as Capture CIS or CIS) is a part management system that is available as an option for use with OrCAD Capture. Capture CIS helps you manage part properties (including part information required at each step in the printed circuit board design process, from implementation through manufacturing) within your schematic designs.
How to use this guide

This guide is designed so you can quickly find the information you need to use Schematics. To help you learn and use Capture CIS efficiently, this manual is separated into the following sections:

- “What is the OrCAD Capture CIS System?” on page 15
- “Setting up OrCAD Capture CIS” on page 25
- “Working with database parts” on page 73
- “Defining and Using Groups and Subgroups” on page 115
- “Finalizing and documenting designs” on page 131

Symbols and conventions

Our printed documentation uses a few special symbols and conventions.

<table>
<thead>
<tr>
<th>Notation</th>
<th>Examples</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+R</td>
<td>Press Ctrl+R</td>
<td>Means to hold down the Ctrl key while pressing R.</td>
</tr>
<tr>
<td>Alt, F, O</td>
<td>From the File menu, choose Open (Alt, F, O)</td>
<td>Means that you have two options. You can use the mouse to choose the Open command from the File menu, or you can press each of the keys in parentheses in order: first Alt, then F, then O.</td>
</tr>
<tr>
<td>monospace font</td>
<td>In the Part Name text box, type PARAM.</td>
<td>Text that you type is shown in monospace font. In the example, you type the characters P, A, R, A, and M.</td>
</tr>
<tr>
<td>UPPERCASE</td>
<td>In Capture, open CLIPPERA.DSN.</td>
<td>Path and filenames are shown in uppercase. In the example, you open the design file named CLIPPERA.DSN.</td>
</tr>
</tbody>
</table>
In addition to this guide, you can find technical product information in the online help, the online interactive tutorial, online books, and our technical web site, as well as in other books. The table below describes the types of technical documentation provided with OrCAD Component Information System (CIS).

<table>
<thead>
<tr>
<th>This documentation component</th>
<th>Provides this</th>
</tr>
</thead>
<tbody>
<tr>
<td>This guide—&lt;br&gt;OrCAD CIS User Guide</td>
<td>A comprehensive guide for understanding and using the features available in Capture CIS.</td>
</tr>
<tr>
<td>Online help</td>
<td>Comprehensive information for understanding and using the features available in Capture CIS. You can access help from the Help menu in Capture CIS, by choosing the Help button in a dialog box, or by pressing F1. Topics include:</td>
</tr>
<tr>
<td></td>
<td>■ Explanations and instructions for common tasks.</td>
</tr>
<tr>
<td></td>
<td>■ Descriptions of menu commands, dialog boxes, tools on the toolbar and tool palettes, and the status bar.</td>
</tr>
<tr>
<td></td>
<td>■ Error messages and glossary terms.</td>
</tr>
<tr>
<td></td>
<td>■ Reference information.</td>
</tr>
<tr>
<td></td>
<td>You can get context-sensitive help for a error message by placing your cursor in the error message line in the session log and pressing F1.</td>
</tr>
<tr>
<td>This documentation component . . .</td>
<td>Provides this . . .</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>Online interactive tutorial</td>
<td>A series of self-paced interactive lessons. You can practice what you’ve learned by going through the tutorial’s specially designed exercises that interact directly with Capture CIS. You can start the tutorial by choosing Learning Capture CIS from the Help menu.</td>
</tr>
<tr>
<td>OrCAD Capture CIS quick reference</td>
<td>Concise descriptions of the commands, shortcuts, and tools available in Capture CIS.</td>
</tr>
</tbody>
</table>
What is the OrCAD Capture CIS System?

Capture Component Information System (CIS) is a part management system that is available as an option for use with OrCAD Capture. OrCAD Capture CIS helps you manage part properties (including part information required at each step in the printed circuit board design process, from implementation through manufacturing) within your schematic designs.

CIS provides access to local (preferred parts database) and remote part databases that contain all relevant information for the parts used in your designs. This information may include company part numbers, part descriptions, PCB layout footprints, technical parameters (such as speeds, tolerances, and ratings), and purchasing information.

With CIS, you can select a part from your preferred parts database or a remote database and place it directly in your schematic design. You can configure CIS to transfer any or all properties associated with that part to the schematic when you place the part. CIS maintains a link to the engineering database part so that you can retrieve other part properties at any time. Linking placed parts to your preferred parts database gives you access to complete part information during the schematic design process.

If you need a part for your design that is not yet in the parts database, you can create the part in the design and add the part to your part database immediately or at a later time. You can also link a
non-database part you've created before to a database part at any time.

CIS in the PCB design process

1. To use CIS in your printed circuit board design flow, you or your system administrator must perform the following setup tasks.

2. Create the preferred part database. This involves creating and entering the part data appropriate for the database.

3. Set up the Open Database Connectivity (ODBC) data source to point to the preferred part database.

4. Configure the part management system.

Each of these tasks is described in Chapter 2, “Setting up OrCAD Capture CIS.”
Once the setup is complete, you can use CIS in Capture to:

- Select parts with associated properties from the database and place them on schematic pages in your design.
- Check the status of placed parts and update placed part properties to reflect changes to the database.
- Generate bills of materials and other reports using both design and part database information.

**Setup**

Create the part database → Set the ODBC data source → Configure CIS → Place database parts → Update part status → Create reports

**Design**

The CIS work environment

The CIS work environment includes two specialized windows that allow you to manage your local part database and explore sources of part data—the CIS explorer and the part manager. All the CIS functionality for these windows is integrated into Capture menus.
The CIS explorer window

The CIS explorer window allows you to search for and retrieve a variety of part information.

The main window contains the following window: the local part database.

The following table lists the windows available for each tabbed window.

<table>
<thead>
<tr>
<th>This window...</th>
<th>Is available in this tabbed window...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Footprint</td>
<td>Local part database</td>
</tr>
<tr>
<td>Part</td>
<td>Local part database</td>
</tr>
<tr>
<td>Relational Table</td>
<td>Local part database</td>
</tr>
<tr>
<td>Visibility</td>
<td>Local part database</td>
</tr>
<tr>
<td>Explorer</td>
<td>Local part database</td>
</tr>
<tr>
<td>Database parts</td>
<td>Local part database</td>
</tr>
</tbody>
</table>
The CIS explorer window displays in one of the following three modes, depending on which of the following CIS features you are using:

- Placing a database part
- Linking a database part to a placed part
- Viewing the database properties of a placed part

The mode is displayed as part of the window title bar.

Note:

The part window
The part window displays the Capture library part associated with the currently selected database part. If the part has a convert (such as a DeMorgan equivalent), you can select it. For a multiple-part package, you can select the specific part in the package.

The Relational table window
The relational table part window displays the relational table data for the selected part.

The visibility window
The visibility window displays the default settings for which part properties are visible on your schematic page. You can use the
visibility window to override these default settings. You can also set custom visibility settings for the current part selection.

<table>
<thead>
<tr>
<th>Property</th>
<th>Database Contents</th>
<th>Visible</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>51RF</td>
<td></td>
</tr>
<tr>
<td>Part Number</td>
<td>PCC910CQTR.NC</td>
<td></td>
</tr>
<tr>
<td>Schematic Part</td>
<td>discrete/CAPACITOR N</td>
<td></td>
</tr>
<tr>
<td>Part Type</td>
<td>Ceramic</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td>CAP 91PF 50V CERAMI</td>
<td></td>
</tr>
<tr>
<td>Voltage</td>
<td>50V</td>
<td></td>
</tr>
<tr>
<td>Tolerance</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Layout PCB Footprint</td>
<td>SMC_Dn02</td>
<td></td>
</tr>
<tr>
<td>Allegro PCB Footprint</td>
<td>SMC_Dn02</td>
<td></td>
</tr>
<tr>
<td>ESpace</td>
<td>C</td>
<td></td>
</tr>
<tr>
<td>Manufacturer Part Number</td>
<td>ECU-E11910UC0</td>
<td></td>
</tr>
<tr>
<td>Manufacturer</td>
<td>Panasonic - SCD</td>
<td></td>
</tr>
<tr>
<td>ActiveportsID</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

You can also use the visibility window to display a compact summary of the part properties and their contents for the part you have selected in the database parts window. You can see more of the properties and contents in this view because the visibility window displays them in rows rather than columns.

**The explorer window**

The explorer window allows you to search for parts using local data from your preferred part database. The window contains two tabbed sections—Explore and Query. In the explore tab, you can search for parts using a hierarchical tree organized by part type. The Query tab allows you to further filter your selection based on parametric or field data and save them.

**Note:** If you make changes to column width or hide a column in Explore view (Explore tab), the same settings will not be retained when you change to the Query view (Query tab) and vice-versa.
The database parts window

The database parts window displays the results of your part browsing and database queries.

<table>
<thead>
<tr>
<th>Table</th>
<th>Part Number</th>
<th>Part Type</th>
<th>Value</th>
<th>Description</th>
<th>Voltage</th>
<th>Tolerance</th>
<th>Schematic P</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Capacitor</td>
<td>PCC9100CQTR</td>
<td>Ceramic</td>
<td>91FF</td>
<td>CAP 91PF 50</td>
<td>50V</td>
<td>discreteC</td>
</tr>
<tr>
<td>2</td>
<td>Capacitor</td>
<td>PCC8200CQTR</td>
<td>Ceramic</td>
<td>82FF</td>
<td>CAP 82PF 50</td>
<td>50V</td>
<td>discreteC</td>
</tr>
<tr>
<td>3</td>
<td>Capacitor</td>
<td>PCC7500CQTR</td>
<td>Ceramic</td>
<td>75FF</td>
<td>CAP 75PF 50</td>
<td>50V</td>
<td>discreteC</td>
</tr>
<tr>
<td>4</td>
<td>Capacitor</td>
<td>PCC6000CQTR</td>
<td>Ceramic</td>
<td>60FF</td>
<td>CAP 60PF 50</td>
<td>50V</td>
<td>discreteC</td>
</tr>
</tbody>
</table>

Note: Roll the mouse wheel up and down to scroll through vertically in the database parts window.

Note: Hold down the SHIFT key and roll the mouse wheel up and down to scroll through horizontally.

Note: Click the mouse wheel button and drag it to the right or left in the database parts window to scroll horizontally.

Note: Click the mouse wheel button and drag it up or down in the database parts window to scroll vertically.

The part manager window

The part manager window summarizes the status of all the parts in your design and provides a graphical interface for creating bill of materials variants.

The part manager window consists of two panes:

Left side pane - Tree view

Right side pane - List view
The left side pane displays a tree view similar to Windows Explorer. The tree view is a hierarchy of groups, subgroups, and BOM Variants found in a design. You can quickly move components from Common to groups and subgroups to BOM Variants folders from the tree view. It allows you to create and edit groups, subgroups, and BOM variants. In the tree view, the core design is at the topmost level. Under the core design, there are the Groups and the BOM Variants folders at the same level.

You can show or hide the tree view using the Show/Hide Tree view menu command and its corresponding button on the toolbar. This command toggles between the show and hide mode.

You can also expand or collapse ALL of the folders underneath a selected folder in the tree view using the Expand/Collapse Tree Item command or the corresponding toolbar button. Folders on the same level, or higher than the selected, will not be expanded. For information about the part manager window tree view, see “Using the part manager window tree view” on page 115.
Right side pane - List view

The right side pane of the part manager displays a list view with the following information for each part in your design:

- Schematic page on which the part is placed
- Part reference designator
- Part value
- Part number
- Status of the placed part relative to the part database
- Database table that contains the placed part's associated database part
- Capture source library from which the part was placed
- Capture source package to which the part belongs

You can configure the part manager window to show other part properties in addition to the standard part information listed above.

To hide or show part properties in the part manager, choose Configure Part Properties Display from the View menu.
Setting up OrCAD Capture CIS

This chapter describes the tasks necessary to set up OrCAD Component Information System (CIS), including:

- “Creating a part database” on page 25
- “Setting up the ODBC data source” on page 41
- “Creating a configuration file” on page 43
- “Editing a configuration file” on page 52
- “Creating Crystal Reports templates” on page 69

Also included are procedures for setting up the CIS work environment, including “Creating Crystal Reports templates” on page 69.

Creating a part database

The part database is the entity that contains all the relevant information for the parts you use in your designs. You can think of a part database as one or more tables, with each row in a table representing a part and each column representing a part property.

Apart from the tables containing part property data (henceforth referred to as primary tables), your part database may also include tables with relational data. For example, your parts database may contain a Vendors table to support handling of multiple vendor / manufacture part numbers per unique company part number.

Note: Capture CIS supports a one-to-many database relationship between the part information tables and related tables.

Before you create your part database, you need to choose whether to use a database or spreadsheet application. You can create a database from an existing Capture design.
Then, when you create your part database, you need to carefully setup its structure and organization, including:

- Part property assignments. See “Determining part properties” on page 29.
- Field formats for properties. See “Setting the field format” on page 37.
- Number of tables used in the database implementation. See “Using more than one table” on page 37.

Using ODBC, CIS interfaces directly with your ODBC compliant database or spreadsheet. This means you can use your preferred application to create and maintain your part database.

**Note:** You can create a database from an existing Capture design. For more information, see “Creating a part database from an existing design” on page 38. You can also extract information for your part database from an MRP database. For more information, see “Extracting ERP or MRP database part information” on page 40.

**Note:** OrCAD CIS connects to your preferred parts database via an ODBC connection. This means that CIS supports any underlying database application that you connect via your ODBC connection.

### Choosing a database format

To take full advantage of the speed and power of CIS, you may want to use a database application rather than a spreadsheet application. As a general rule, you should use a database application for databases with more than 1,000 parts. Database applications offer the following advantages over spreadsheets:

- Comprehensive data management features
- Better performance for part searching
- Form-based entry for entering part information
- Safeguard against duplicate part numbers

The disadvantages of spreadsheets and delimited text files include:
Lack of structure

During data entry, spreadsheets allow you to configure every cell in a different format. This makes querying fields (columns) very difficult because CIS expects queried fields to be in a consistent format.

Lack of ANSI SQL compliance

Because databases are ANSI SQL compliant, their drivers do very little work in relaying SQL commands to connected data sources. In contrast, with non-SQL compliant spreadsheets, the ODBC driver is responsible for translating the SQL commands into functions that the spreadsheet can understand. This results in a dramatic increase in the time your queries can be processed. Query time increases are even more dramatic with text files because the driver must search for and compile a matching list entirely on its own. An optimized, SQL-compliant database format is several times faster than a spreadsheet with more than 100 parts or a text file of over 20 parts.

Lack of replication support

If you have users in more than one location accessing your database, you have either a single, central database or a replicated database. Replication is a method of storing a single database in more than one location. True databases support scheduled synchronization: they maintain data integrity by checking separate database transaction logs and replicating modifications on multiple systems. If you are using a spreadsheet or text program, you must check manually because your format does not support replication.

CIS Database Feature Support

CIS supports any underlying database application that you connect via your ODBC connection. However, when creating your parts database, keep in mind the following points when defining the fields and tables in the database.

1. Use of SQL in CIS Databases

CIS uses structured query language (SQL) to query, update, and manage the CIS relational databases.
2. Supported Data types for the Part Name field

- CHAR
- VARCHAR
- LONGVARCHAR

**Note:** If a CIS table defines a part name field with an unsupported data type, CIS will throw an error during the CIS configuration procedure.

3. Supported Data types for fields other than Part Name

CIS supports the following data types for any field defined in the tables of the parts database

- CHAR
- NUMERIC
- DECIMAL
- INTEGER
- SMALLINT
- FLOAT
- REAL
- DOUBLE
- DATETIME
- VARCHAR

**Note:** If a CIS table defines any field with an unsupported data type, CIS will throw an error during the CIS configuration procedure.

**Note:** If a CIS table defines any field with a DATETIME data type, the CIS will not display any error during the CIS configuration procedure, but will display these fields as empty in the tables of parts database.

4. Use of Double-quotes in table and field names

CIS uses double quotes (""") as the default field and table delimiter for database queries. This is the standard query delimiter
supported in popular ODBC databases such as Microsoft Access, Oracle and SQL Server.

If your ODBC database does not support double quotes as the query delimiter, database queries will fail. For such databases, you can specify the default field and table delimiters by adding the following two options under the [Part Management] section in the CAPTURE.INI file:

```
[Part Management]
Field Qualifier = <field delimiter>
Table Qualifier = <table delimiter>
```

5. **Use of Uppercase function**

CIS uses the database uppercase function to convert string variables in queries to uppercase. If the uppercase function supported in your database is not supported by CIS, database queries may fail. You can specify the corresponding uppercase function supported in such databases, by adding the following option under the [Part Management] section in the Capture.ini file:

```
[Part Management]
Upper Case Function = <name of function>
```

### Determining part properties

The first step in creating a part database is to determine the properties to include for each part. Typical properties in a part database include part number, part description, tolerance, rating, speed, timing parameters, PCB footprint, manufacturer, and cost. CIS supports an unlimited number of properties, so you can include as much information in your part database as you want.

There are no restrictions on database table property names. Also, the names you use in the database can be different than the property names you assign to the placed parts.

For example, you can name the Part Number property My Company Part Number. Also, you may call a property Tolerance in the database and Tol on the placed part.

Database property types and placed-part property names are defined during database configuration. For more information, see “Creating a configuration file” on page 43.
Note: Do not use the same property name more than once. For example, if you have two manufacturer columns in your database, call them Manufacturer 1 and Manufacturer 2.

When you transfer a property, that property is included in the schematic as an attribute of the placed part. Normally, you transfer properties that are required by CIS (such as Part Number and Schematic Part), used in the design process (such as Value, Tolerance, and Rating), or needed for use by other software products (such as PCB Footprint). Properties that aren’t transferred can still be included in a bill of materials report.

Parts in your database must include all of the properties in Table 1-1, “Required part properties” on page 31. Any of the optional properties in Table 1-2, “Optional part properties” on page 35 may also be added. Recommendations on whether to transfer properties to your design are included in both tables. Properties recommended for transfer to the design are either likely to be required for netlisting or are generally needed on printouts of the design.

Note: You may want to look at the sample part databases provided with CIS. The SQLite database, BENCH.DB, is provided in the \TOOLS\CAPTURE\SAMPLES folder. As you read this section, refer to this sample to get a better understanding of how to set up your part database.

Note: Your database can also contain mechanical (non-electrical) parts. However, you must not allow users to add mechanical parts to the database whose schematic representations (symbols) have pins. If mechanical parts with pins are placed in a design, they will invalidate netlists generated from that design. Capture CIS allows you to generate a BOM that lists all the mechanical parts and assemblies associated with an electrical part in your design. For more information, see “Including mechanical parts and assemblies in standard CIS BOM” on page 162.
### Table 2-1 Required part properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Transfer to design</th>
</tr>
</thead>
<tbody>
<tr>
<td>Part Number</td>
<td>Required to identify the part in association with the CIS Part_Number property type. This property is required by the part manager and the bill of materials report. CIS lets you enter more than one database part with the same number in the database. However, you should use a unique part number for each part and have no duplicate part entries in your database.</td>
<td>Required</td>
</tr>
<tr>
<td>Part Type</td>
<td>Identifies the part type. The Part Database Explorer uses this property to define the part database folder hierarchy. Use this property to facilitate part searches. Typical contents are resistor, resistor\fixed, capacitor, capacitor\electrolytic, IC, IC\Memory\SRAM, connector, and so on. The levels of the hierarchy are defined using the backslash () character (or any character you define in the configuration). You can define any number of levels in the hierarchy. This property is also used by the Part Reference Associations option. (See “Defining part reference associations” on page 59. This property is case-sensitive. Make sure you use uppercase-lowercase conventions consistently when entering values for this property.</td>
<td>No</td>
</tr>
</tbody>
</table>
Schematic Part (Symbol)
The part name. This property is required to use the Place Database Part command. Only the part name is necessary if the part is stored in the same directory as the custom schematic part libraries (.OLB files) that you configure in Capture. (See the OrCAD Capture User's Guide for more information about configuring part libraries.)

However, to make sure that you don't accidentally place an identically named part, you should include the library name, a backslash (\), and then the part name. Examples include:

DISCRETE\CAP
DISCRETE\DIODE
OPAMP\CMP01

In addition, you can use the explicit path so CIS can locate an unconfigured library. For example:

C:\MYLIB\DISCRETE\CAP

Caution:

Do not directly reference the schematic part libraries that are supplied with Capture CIS (resource libraries). Because the resource libraries in your installations of Capture CIS are often changed during upgrades to new software versions, the library names and paths in your database can be made invalid. Instead, create your own custom libraries by renaming the resource library files or copying individual parts from the resource libraries to your custom libraries.
You can also assign multiple schematic part names to a single part. Use the same format as above for each name and separate each one with the multi-value delimiter (by default, a comma). For example:

DISCRETE\CAPACITOR NON-POL, DISCRETE\CAP NP, DISCRETE\SMALL CAP

**Tip**

The default value of the multi-value delimiter is a comma. However, when setting administrative preferences during database configuration, you can change the character CIS recognizes as the delimiter to a colon, semi-colon, question mark, or vertical bar. For information, see “Setting administrative preferences” on page 63.

Then, when you update your design’s part status, CIS can approve and make current a schematic part which has several acceptable names. Also, if a database part has several different valid schematic parts, you will be able to choose any one of them when you are placing parts from the database parts window. All the configured schematic parts for the database part will be available from a drop-down list under the Schematic Part property name.

CIS locates the Capture library using the following set of prioritized rules:

1. Search the library at the explicit path, if provided.
2. Search the first library listed in Capture.ini that has a matching library filename.
3. Search all directories that contain configured libraries.

If no libraries are included specifically in your Capture design, CIS searches the LIBRARY directory in your Capture installation directory.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Transfer to design</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>You can also assign multiple schematic part names to a single part. Use the same format as above for each name and separate each one with the multi-value delimiter (by default, a comma). For example: DISCRETE\CAPACITOR NON-POL, DISCRETE\CAP NP, DISCRETE\SMALL CAP</td>
<td></td>
</tr>
</tbody>
</table>

**Tip**

The default value of the multi-value delimiter is a comma. However, when setting administrative preferences during database configuration, you can change the character CIS recognizes as the delimiter to a colon, semi-colon, question mark, or vertical bar. For information, see “Setting administrative preferences” on page 63.

Then, when you update your design’s part status, CIS can approve and make current a schematic part which has several acceptable names. Also, if a database part has several different valid schematic parts, you will be able to choose any one of them when you are placing parts from the database parts window. All the configured schematic parts for the database part will be available from a drop-down list under the Schematic Part property name.

CIS locates the Capture library using the following set of prioritized rules:

1. Search the library at the explicit path, if provided.
2. Search the first library listed in Capture.ini that has a matching library filename.
3. Search all directories that contain configured libraries.

If no libraries are included specifically in your Capture design, CIS searches the LIBRARY directory in your Capture installation directory.
The part value. Examples are 1.2K, 10.0uF, and 74ALS374. CIS supports the use of common magnitude identifiers (such as K and uF).

The database query uses intelligent unit conversion to interpret common magnitude identifiers in part definitions, since entries in part databases are often inconsistent (for example, the Value for a 2.7K resistor can be 2.7K, 2.700, 2.70K, 2.700K, 2700.0, 0.0027M, etc.). Unit suffixes (such as F for farads or H for henries) are ignored in translation.

The magnitude identifiers supported in CIS include:

<table>
<thead>
<tr>
<th>Identifier§</th>
<th>Represents</th>
<th>Magnitude§</th>
</tr>
</thead>
<tbody>
<tr>
<td>f</td>
<td>femto</td>
<td>10^{-15}</td>
</tr>
<tr>
<td>p</td>
<td>pico</td>
<td>10^{-12}</td>
</tr>
<tr>
<td>n</td>
<td>nano</td>
<td>10^{-9}</td>
</tr>
<tr>
<td>u</td>
<td>micro</td>
<td>10^{-6}</td>
</tr>
<tr>
<td>m</td>
<td>milli</td>
<td>10^{-3}</td>
</tr>
<tr>
<td>K</td>
<td>klio</td>
<td>10^{3}</td>
</tr>
<tr>
<td>M</td>
<td>mega</td>
<td>10^{6}</td>
</tr>
<tr>
<td>G</td>
<td>giga</td>
<td>10^{9}</td>
</tr>
<tr>
<td>T</td>
<td>tera</td>
<td>10^{12}</td>
</tr>
</tbody>
</table>
### Table 2-2 Optional part properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Transfer to design</th>
</tr>
</thead>
<tbody>
<tr>
<td>Availability</td>
<td>Number of the parts in stock at your company.</td>
<td>Not recommended</td>
</tr>
<tr>
<td>Data Sheet</td>
<td>The name of the detailed datasheet for this part. Select the Browsable check box in the configuration for CIS to automatically launch the appropriate browser for this property. Examples include: 74ALS374.PDF, <a href="http://www.chipmaker.com/specs/74ALS374">http://www.chipmaker.com/specs/74ALS374</a>, and RES1K1/4W.DOC. You can browse any format you want. CIS uses the application assigned to that file extension in your Windows registry. (Extension assignments are managed in the Windows Explorer. See your MS Windows documentation for more information.) For example, a .DOC entry might cause CIS to launch Microsoft Word, and a URL entry might cause it to launch your default web browser. <strong>Note:</strong> CIS uses the PATH environment variable and the current working directory to find the specified document.</td>
<td>Not recommended</td>
</tr>
<tr>
<td>Description</td>
<td>A brief description of the part.</td>
<td>Not recommended</td>
</tr>
<tr>
<td>Distributor</td>
<td>Name of part distributor.</td>
<td>Not recommended</td>
</tr>
<tr>
<td>Distributor Part Number</td>
<td>Part number used to order from the distributor.</td>
<td>Not recommended</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>Name of part manufacturer.</td>
<td>Not recommended</td>
</tr>
<tr>
<td>Manufacturer Part Number</td>
<td>Part number used to order from the manufacturer.</td>
<td>Not recommended</td>
</tr>
</tbody>
</table>
### PCB Footprint

The PCB footprint name (from the footprint library) assigned to a part.

**Note:** Unlike Schematic Part property names, you cannot use directory paths for libraries with PCB footprint names. If you use a path with a PCB footprint name, the footprint will not display in the CIS explorer’s footprint window.

You can assign multiple PCB footprints to a single part by entering them in the part’s footprint field in your part database and separating each footprint name with the multi-value delimiter.

**Tip**

The default value of the multi-value delimiter is a comma. However, when setting administrative preferences during database configuration, you can change the character CIS recognizes as the delimiter to a colon, semi-colon, question mark, or vertical bar. For information, see “Setting administrative preferences” on page 63.

Then, when you update your design’s part status, CIS can approve and make current a schematic part which has several acceptable footprint names. Also, if a database part has several different valid PCB footprints, you will be able to choose any one of them when you are placing parts from the database parts window. All the configured PCB footprints for the database part will be available from a drop-down list under the PCB Footprint property name.

### Price

Part price. Use this information when selecting parts to design for cost. Include this property in reports to get a cost roll-up of your design.

**Not recommended**

### Rating

The maximum rating for the part (for example, maximum voltage or power dissipation).

**Optional**

### Tolerance

The percent tolerance specified for the part.

**Optional**
Setting the field format

CIS can work with database text and number format fields (known as the cell format in spreadsheets). As a general rule, set each database field (that is, each table column) to text format. CIS converts other database field formats, such as float, to text format when properties are transferred to placed parts.

Note: Use only ANSI SQL-92 compliant data types for your field formats. If you use non-compliant data types, CIS may misinterpret property values.

Using more than one table

CIS can reference more than one table or worksheet in your part database. For example, you can group your parts into several tables according to type. That is, you can place resistors in one table, ICs in another, capacitors in another, and the remaining parts in a fourth table. When you're viewing database parts with CIS, each table has a unique view. You can arrange the column settings for each table independently, allowing you to view different properties for each table.

Using related tables

CIS allows you to create and use relational tables in your parts database. These tables must have a one-to-many relationship with your part information (primary) tables. For example, the database may contain a Vendor table with multiple vendor / manufacture part numbers for one company part number in your Resistor table. This structure allows you to query for data across the primary and relational tables.
Note: It is not necessary for the parts database to contain relational tables. You can create and run CIS queries for parts from a flat table structure.

Creating a part database from an existing design

You can also create a part database by extracting part properties from an existing Capture design using the CIS Bill of Materials command.

Tip

If your designs are created in another schematic capture program that creates bills of materials for part properties, you can still create a part database from an existing design. Follow the instructions supplied with the program to create the appropriate bill of materials file from your design. Then, use the bill of materials file to create a part database based on that design.

You can obtain a wizard from the Cadence web site that automates this process. The wizard also automatically derives schematic part and source library information for the placed parts in your Capture schematic. If you use the manual procedure detailed here, you will have to manually reference your placed parts to your libraries. To download the CIS wizard, visit http://www.cadence.com/orcad.
Consider the example in the following illustration. The list a typical set of properties to extract from the design.

In the Output Format list, CIS lists a number of properties that will be extracted to the bill of materials. You can add to this list by selecting properties from the Select Properties list and clicking the Add button. You can remove properties from the Output Format list by selecting them and clicking the Remove button.

When you click OK in the Standard Bill of Materials dialog box, CIS creates a file with the property information for all the parts in the design. You can directly import this file into your database.

**Note:** Your database should have a unique part number for each part and no duplicate part entries. Although some database applications will not import more than one occurrence of a keyed property, you may need to eliminate duplicate part entries manually. To do this, sort
the database by part number, then delete duplicate entries using your database or spreadsheet program.

Extracting ERP or MRP database part information

You can also extract information from an existing enterprise or manufacturing resource planning (ERP or MRP) database, to create a part database. Save the ERP or MRP database as an ASCII file, then use that file as your part database file or as a source for a true part database file (for example, an MS Access format file).

Note: If your ERP database is ODBC compliant, you may not need to extract part information. Instead, you should be able to directly connect your preferred part database (PPD) to the ERP database—you should not have to set up and run regular batch routines to update the data in your PPD. For information about connecting these databases, see the product documentation for both database applications.

You may need to enhance the information in an ERP or MRP database, since it generally will not include everything required for schematic design. However, an ERP or MRP database usually contains a complete list of your company’s parts, part numbers, part descriptions, costs, quantities in stock, lead times, manufacturers, and alternate manufacturers.

Often, the data in an ERP or MRP database exists in a format that does not lend itself to ease of use. For example, the part value may be merged with the description, such as:

```
RES 1K 5% 1/4W
```

This makes searching for parts more difficult. If you can, split this information out in the ERP or MRP database into separate database properties, such as Part Type, Value, Tolerance, and Rating.

You can also contact the Cadence Methodology Services group for assistance in converting your data into a more convenient format.

To take advantage of updated information in an ERP or MRP database, you need to set up a means of extracting data on a regular basis and using it to update your part database. That way, your part database will include information that changes frequently, such as quantity in stock and lead time.
Setting up the ODBC data source

Before you can set the CIS configuration, you must define the open database connectivity (ODBC) data source for your database. CIS interfaces to your part database using a defined ODBC data source name. A data source consists of a database filename and an associated ODBC driver with which to access it. If you are setting up a client-server database, the data source also references the database server. You define the data source name, assign the database file name, and specify the ODBC driver using the 32-bit ODBC Windows control panel.

Tip

You must define the data source on each user’s system. When you do so, use the same data source name. This allows users to share the same configuration file.

Note: If your workgroup is sharing a configuration file, make sure to write-protect the file.

To set the data source for the local database, do the following:

1. From the Windows Start Menu, choose Control Panel.

   Note: If you are using the 64-bit Windows machine, run the odbcad32.exe application from the C:\windows\syswow64 directory path, and follow the steps from Step 3.

2. Choose System and Security – Administrative Tools – Data Source (ODBC), if you have selected View by drop-down list box as Category.

   Or

   Choose Administrative Tools – Data Source (ODBC), if you have selected View by drop-down list box as Large icons or Small icons.

   Note: If you are using the Windows XP operating system, choose Performance and Maintenance – Administrative Tools – Data Sources (ODBC).

3. Click the ODBC Drivers tab and make sure the driver appropriate to your database or spreadsheet is installed on your system.
Note: If the driver for your application is not present, you must install it. Check the CIS installation disk or contact the database or spreadsheet program supplier.

4. Click the User DSN tab, and then choose the Add button. Windows displays the Create New Data Source dialog box.

Note: If you are using Windows NT, you should click the System DSN tab to create new data sources. If you do not use the System DSN tab, users with different logins will not be able to
use the ODBC source.

5. Choose the appropriate driver for your program (Microsoft Access, in this example), then click the Finish button.

6. Assign a name for the data source. If desired, enter a description for the data source name.

   **Note:** Step 7 may be different depending on the type of program you used to create your database.

7. Under Database, click the Select button, and locate the database.

8. Click the Options button, and clear the Read Only check box. By deselecting the Read Only check box, you can create new parts and add them to the database using CIS.

9. Click OK to set the data source.

**Creating a configuration file**

CIS requires a configuration (.DBC) file to make use of your part database. The configuration file:
Identifies the ODBC data source to use as the part database and specifies the tables to use within that database.

Identifies the part properties that are transferred to your design when you place or link a database part.

Sets the visibility for each of the transferred properties.

Contains the part type associations.

**Note:** Keep the configuration (.DBC) file in a read-only directory that is accessible to all CIS users. You should make the directory read-only to prevent users from inadvertently changing the configuration.

**Note:** If you use a CIS version 9.2.3 or earlier version configuration file with CIS 10.0, the file will be updated to the CIS 10.0 format. After CIS updates the file, you cannot use it again with CIS 9.2.3 or earlier versions.

When CIS 10.0 updates the configuration file to the new format, it creates a backup of the old configuration file with the extension .DBCBAK. You can use this file with CIS 9.2.3 or earlier versions.

**Note:** If you are using a configuration file from before CIS version 7.2, you must recreate the file because the configuration file format was changed in CIS version 7.2.

**Note:** If you use a CIS version 16.0 or earlier version configuration file with CIS 16.2, the file will be updated to the CIS 16.2 XML format. After CIS updates the file, you cannot use it again with CIS 16.0 or earlier versions.

When CIS 16.2 updates the configuration file to the new format, it creates a backup of the old configuration file with the extension .DBCBAK. You can use this file with CIS 16.0 or earlier versions.

When creating a configuration file, you should use the database configuration wizard. Completing the wizard guarantees that your part database can be used with most CIS features. For information about using the wizard, see “Using the database configuration wizard” on page 45.

However, if you need to use the manual method of creating a configuration file, you can reference “Creating a configuration file manually” on page 50.
Using the database configuration wizard

You can use the database configuration wizard each time you want to create a new database configuration file. The wizard is designed to make sure that you set at least the minimum table and property configuration that is required for CIS to work with your part database.

However, the wizard does not include all the options available to you, including options to optimize the performance of CIS and customize your CIS work environment. For this reason, when you have finished running the wizard, you should read through the last two parts of this section, “Setting other part database options” on page 47 and “Setting other configuration options” on page 49.

Note: You must set up a new ODBC data source before you can create a new configuration file. If you haven’t set up a new ODBC data source for your database, see “Setting up the ODBC data source” on page 41.

Starting the database configuration wizard

You can start the database configuration wizard anytime you want to create a new database configuration file.

To start the database configuration wizard

1. From the Capture’s Options menu, choose CIS Configuration. CIS displays the CIS Configuration File dialog box.
2. Click the New button. CIS displays the Database Configuration Wizard.

3. Follow the instructions in the wizard to create your database configuration file. If you need more information about any of the wizard steps, click the Help button.

4. Click the Finish button. CIS displays the Configure Database dialog box and the wizard is complete.
5. If you want to set other part database options, complete the next section, “Setting other part database options” on page 47.

6. If you do not want to set any other part database or configuration options, click OK to save the new database configuration file.

Setting other part database options

You can set other part database options that are not available in the database configuration wizard, including:

- The part properties to be checked against the part database when you update the part status of a design. CIS sets which properties are checked by default but, if you have a special situation that requires different properties to be checked, you are allowed to change the defaults.

- The part tables that CIS will search when you are linking placed parts to database parts. This is useful when your database consists of several part tables that are organized by device type (for example, capacitors in one table, resistors in another, and so on). When you are linking database parts to placed parts, CIS uses allowed part reference prefixes to limit your search to the appropriate tables. The result is that your search takes less time.

The procedure below describes how to set these options.
To set other part database options

1. In the Configure Database dialog box, select the Part Database tab.

2. In the Tables list, select the database table for which you want to set options.

3. In Update Property column of the Configuration area, select the check box for each property that you want to be checked when you update the part status of your designs.

4. In the Allowed Part Reference Prefixes text box, type the part reference prefixes you want CIS to use to limit searches on the database table. For example, if a table contains only capacitors, you could enter C as the allowed part reference prefix. Then, when you choose the Link Database Part command, CIS searches that table only when the placed part you are linking has a part reference prefix of C.

Note: If a part reference prefix is specified in the Allowed Part Reference Prefixes text box for all the tables, the following message is prompted on the screen after you click OK:

INFO(ORCIS-6235): All parts might not be accounted for. Do you want to continue?
**Note:** Leave this box blank if you want the table to be searched regardless of the part reference prefix.

**Note:** If you have defined part reference prefixes and you link a placed part in your design to a database part with the Preserve Reference Designator check box checked in the CIS Extended Linking dialog box, the reference designator of the placed part is retained and all the transferable properties of the database part are transferred to the placed part. Now, when you update the part status from the part manager (using Update All Part Status command), the part status column displays: Approved: Part not found. This is because CIS is unable to find the part (with matching part reference prefix and properties) in the database table. You may avoid this situation by changing the reference designator of the placed part to the one you defined in the Allowed Part Reference Prefix text box or delete the part reference prefix from the Allowed Part Reference Prefix text box.

5. Repeat this procedure on each database table for which you want to set these options.

6. If you do not want to set any other part database or configuration options, click OK to save the new database configuration file.

7. If you want to set other configuration options, go to the next section, “Setting other part database options” on page 47.

### Setting other configuration options

You can set other options in the database configuration that customize how CIS interacts with your part database and how you use CIS in your work environment. These options include:

- Defining part reference associations to improve the speed and accuracy of the search for database parts to link to placed parts. For more information, see “Defining part reference associations” on page 59.

- Setting administrative preferences to customize some CIS features for your work environment. For more information, see “Setting administrative preferences” on page 63.

- Setting relational database to set up the relational associations between the primary (part) tables and the relational table.
Creating a configuration file manually

You can create a configuration file using the manual procedure below. When you are finished creating the file, you will need to set the options for the file so that CIS knows how to handle your database table part properties. For information about setting or editing configuration file options, see “Editing a configuration file” on page 52.

To create a configuration file manually

1. Open a new or existing schematic design in Capture CIS.

2. From the project manager's Options menu, choose CIS Configuration. CIS displays the CIS Configuration File dialog box.

![CIS Configuration File dialog box]

**Note:** You must set up a new ODBC data source before you can create a new configuration file. If you haven't set up a new ODBC data source for your database, see “Setting up the ODBC data source” on page 41.
3. Click the Setup button. CIS displays the Configure Database dialog box.

4. Click the Browse button. CIS displays the Browse Data Source dialog box.
5. Select the data source name you defined for your ODBC driver, then click OK. The Configure Database dialog box lists the tables found in your data source.

![Configure Database dialog box](image)

6. Set the configuration file options as desired. For information about setting configuration file options, see “Editing a configuration file” on page 52.

**Editing a configuration file**

As you set up and work with CIS, you may discover performance issues or elements of the CIS work environment that are not optimal for your work group. This section describes in detail all the configuration options that are available and how to set them optimally for your situation. The five categories for these options include:

- “Setting database table property options” on page 53
- “Defining part reference associations” on page 59
- “Setting administrative preferences” on page 63
- “Setting Relational Database preferences” on page 67
- “Saving the configuration file” on page 69
Note: For information about creating a configuration file, see “Creating a configuration file” on page 43.

Setting database table property options

Once you have created a database configuration file, you need to set the options for the file so that CIS knows how to handle your database table part properties.

To set database table property options

1. Open a new or existing schematic design in Capture.

2. From the project manager’s Options menu, choose CIS Configuration. CIS displays the CIS Configuration File dialog box.

3. Choose a configuration file to edit by doing one of the following:
   - To edit the current configuration file, click the Setup button.
   - To edit a different configuration file, click the Browse button, locate and open the file, then click the Setup button.
CIS displays the Configure Database dialog box.

4. If you want to choose a new data source for your configuration, do the following:

Caution

If you choose a new data source name, all of the settings made with the previously selected data source will be lost for the current configuration (.DBC) file. If you want to keep the settings in the current .DBC file, use the database configuration wizard to create a new configuration file instead. For more information, see “Using the database configuration wizard” on page 45.
a. Click the Browse button. CIS displays the Browse Data Source dialog box.

b. Select the data source name you defined for your ODBC driver, then click OK. The Configure Database dialog box lists the tables found in your data source.
5. If you want to configure table properties, select the table that contains the properties. In the graphic below, the Capacitor table is selected.

When you select a table, the Configuration area lists the properties it contains. Each row represents a part property, and each property has the following characteristics:

**Table Property Name**

This is the name of the property as it is defined in the part database.

**Table Property Type**

This is the data type for the property. Most properties are type Text, but there may be other data types.

**Property Type**

The Property Type determines how CIS interprets the property. Your database must include a property of type Part_Number in every table.

Set the following property types:
The Part_Type type for the database property that defines the part type. (This defines the field for folder view in CIS explorer.)

The Schematic_Part type for the database property that contains the schematic part (symbol) name.

The PCB_Footprint type for the database property that contains your Layout footprint name. If you want the database to include footprints not generated by OrCAD Layout, set the property type to Normal. This prevents the footprint viewer from trying to interpret them.

Visibility

This sets the default visibility of the property when it is copied to the placed part. There are four visibility modes:

<table>
<thead>
<tr>
<th>Visibility mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔️ Visible</td>
<td>CIS displays the property with the part on the schematic page.</td>
</tr>
<tr>
<td>❌ Invisible</td>
<td>CIS does not display the property with the part on the schematic page.</td>
</tr>
</tbody>
</table>
No Change

CIS does not modify the property visibility. If the property does not exist, it is set to invisible. You can override the default visibility for specific parts when you place or link database parts. Cells that you cannot change are shown with a light gray background in this column.

Non-adjustable

CIS does not allow this property to be set as visible on schematic pages.

For more information about placing and linking database parts, see “Placing a database part on a schematic page” on page 81 and “Linking a placed part to a database part” on page 101.

Key

This sets the property as a key during the initial part search. The key is used when you are linking a database part to a previously placed part. Normally, you set only the Value property as a key so that, when you want to link a part, CIS searches the part database for parts with a specific value. If you don’t have a Value property in your database, do not set a key.

Browsable

This sets browse capability for the property. It allows you to put references to datasheets, drawings, and documents in your part database. For example, you can reference Adobe Acrobat (.PDF) files, Microsoft Word (.DOC) files, and even worldwide web addresses (URLs). You can then view these items online in CIS when browsing the part database. They are also browsable when you are viewing standard CIS bills of materials.

You can browse any file type, such as .PDF, .DOC, or .HTML, from the CIS explorer window when you have a browser installed on your system that can read the file and can be automatically launched. CIS automatically locates and reads all viewable files that are stored in the same directory as your .DBC file.
**Note**: You can set parameters for viewing a specified document in the CAPTURE.INI file. For more information, see the CIS online help.

**Update Part Property**

Select this if you want the value of this property for placed parts to be checked against the database part’s value when you update the part status of your design.

1. (Optional) Type the part reference prefixes in the Allowed Part Reference Prefixes text box.

   This is useful when your database consists of several part tables that are organized by device type (for example, capacitors in one table, resistors in another, and so on). When you are linking database parts to placed parts, CIS uses allowed part reference prefixes to limit your search to the appropriate tables. The result is that your search takes less time. For more information about linking database parts, see “Linking a placed part to a database part” on page 101.

   For example, if a table contains only capacitors, you could enter _C_ as the allowed part reference prefix. Then, when you choose the Link Database Part command, CIS searches that table only when the placed part you are linking has a part reference prefix of _C_.

   **Note**: If a part reference prefix is specified in the Allowed Part Reference Prefixes text box for all the tables, the following message is prompted on the screen after you click OK:

   INFO(ORCIS-6235): All parts might not be accounted for. Do you want to continue?

   **Note**: Leave this box blank if you want the table to be searched regardless of the part reference prefix.

2. Repeat steps Step 4 for each table in the database.

3. When you are finished configuring table properties, click OK or choose another tab to continue configuring your database.

**Defining part reference associations**

Part reference associations are used to improve the speed and accuracy of the search for database parts to link to placed parts. You create associations between a particular part type and the prefixes in
the part database for that part type. For example, you can create a part reference association for resistors such that all resistors in the part database use the R prefix.

**Note:** Defining part reference associations only improves part search speeds for true databases (for example, Microsoft Access)—there is no speed improvement from setting up associations if you are using a spreadsheet or a text file for your database.

You must create a configuration file for your database before you can define its part reference associations. If you have not already created a configuration file for your database, see “Setting database table property options” on page 53.

Once you’ve defined part reference associations for your database, when you choose the Link Database Part command, CIS displays database parts of the appropriate type. Without defined part reference associations, CIS displays all parts in the database that match the keyed property value, regardless of the part type. By defining an appropriate reference association, you can limit the number of parts that CIS displays.

**Note:** Defining part reference associations is optional. You can define associations later if you need to improve the search performance during database part linking.

Example: If you select an inductor, L1, on the schematic page with a value of 100uH, then choose the Link Database Part command, CIS displays all parts in the database having a value of 100 x 10^-6. This may include capacitors, inductors, or other parts with a similar value.

By defining a reference association between inductors and the L prefix, you can limit the parts that CIS displays to inductors only.

When you define part reference associations for your part database, keep the following points in mind:

- Part reference associations apply to all database tables.
- The Part Type Property Contents value in the dialog box is case-sensitive.
- You can associate one prefix with several different part types.
- An association applies to its level in the part type hierarchy and all lower levels.
A part reference prefix without a defined part type association can be matched to any part type in the database.

If a particular part in the database does not have its Part Type property contents defined, that part will be matched only to part reference prefixes with no defined part type associations.

**Note:** Example: An association between the part reference prefix C and the part type Capacitor applies to part types of Capacitor, Capacitor\Electrolytic, and Capacitor\Ceramic\Fixed. Note that a part reference prefix associated with the part type Capacitor\Ceramic does not apply to part types of Capacitor or Capacitor\Electrolytic.

**To define part reference associations**

1. In your local preferred parts database, make sure that the Part Type property field is indexed.

2. If you are not already in the Configure Database dialog box, do the following:
   a. Open a new or existing schematic design in Capture.
   b. From the project manager's Options menu, choose CIS Configuration. CIS displays the CIS Configuration File dialog box.
   c. If necessary, click Browse to locate the database configuration file you want to setup.
   d. Click Setup. CIS displays the Configure Database dialog box.
Note: You can add icons for custom part references that will automatically display in the Part Reference column of the part manager window. Add your custom icons to the standard icons used for the Part Reference column located in the directory: \TOOLS\CAPTURE\VENDOR

Note: Each icon’s filename corresponds to a part reference prefix (for example, the icon for the part reference prefix R is stored in R.BMP).

Caution

You can use a bitmap editor (such as Microsoft Paint) to modify the bitmaps, but be careful not to change the image size.

3. In the Configure Database dialog box, choose the Part Reference Associations tab.

4. Enter a part type in the Part Type Property Contents column and a corresponding part reference prefix (or set of prefixes) for that part type in the Applicable Part Reference Prefixes column. Separate prefix entries with commas.

Note: Part prefixes need not be unique to a particular part type.
That is, you can make an association between one prefix and several different part types.

**Note:** Use the Delete keyboard key to delete a row containing the part type and the corresponding part reference prefix.

5. Click OK or choose another tab to continue configuring your database.

### Setting administrative preferences

Administrative preferences allow you to customize some CIS features for your work environment.

**To set administrative preferences**

1. If you are not already in the Configure Database dialog box, do the following:
   
   a. Open a new or existing schematic design in Capture.
   
   b. From the project manager’s Options menu, choose CIS Configuration. CIS displays the CIS Configuration File dialog box.

   c. If necessary, click Browse to locate the database configuration file you want to setup.

   d. Click Setup. CIS displays the Configure Database dialog box.
2. In the Configure Database dialog box, choose the Administrative Preferences tab.

3. Select the Allow Duplicate Part Numbers check box to allow the same part number to appear more than once in the database.

   **Note:** If you want a database part to work with two or more different layout footprints, you can enter multiple PCB footprint names in your part database.

4. In the Part Type Delimiter text box, type the character that indicates a hierarchical level within a path in the database. Normally, the delimiter is a backslash (\) character. For example, the database could have part types Capacitor\Electrolytic and Capacitor\Ceramic.

5. Select the Transfer Blank Properties check box to create a property on the placed part even if the database part property does not have a specific value. This is useful if all your database parts are in a single table since, in that case, you will have properties in the table which are not relevant to certain types of parts. For example: Speed Grade does not apply to resistors.

6. Select the Auto Symbol Refresh Checking check box to enable CIS to automatically detect if symbols or footprints were updated in the configured libraries. If any changes are detected, the...
Refresh Symbols from Lib command in the Update menu in CIS explorer and its corresponding icon on the toolbar are enabled. This indicates that you have to refresh the symbol or footprint information in CIS explorer.

If you do not select this check box, the Refresh Symbols from Lib command in the Update menu in CIS explorer and its corresponding icon on the toolbar will always be enabled.

7. If you want to use a character other than a comma to separate multiple field values in your database, choose another character from the Delimiters for Multi-Values list. For information about entering multiple values for part properties in your part database, see the Schematic Part (Symbol) property description in the “Required part properties” on page 31 (table).

8. Select the Assign Temporary Part Numbers Automatically check box so that CIS will create and track temporary part numbers for you. That way when you create a new part, CIS automatically assigns a temporary part number to that part and enters the part number into the part record in the database as well as in a special table named TMPPRTS.

Caution

CIS automatically creates the TMPPRTS table. Do not remove, rename, or modify the structure of this table or temporary part number tracking will not operate properly. Also, never remove temporary part records, even after you have assigned them approved part numbers. If you do, designs that have not yet been updated with the new part numbers will have to be updated manually.

Tip

To promote a temporary part to an approved part, do the following:

a. Using your database application, enter the approved part number RELPRRTNO field in the TMPPRTS table.

b. Replace the temporary part number with the approved part number in the part table.
c. Open Part Manager.

d. From the Tools menu choose Update All Part Status.

All temporary parts will be promoted to approved parts. Also, the part numbers will be updated part number values from the RELPRTNO field in the TMPPRTS table.

9. In the Temporary Part Number Prefix text box, enter the prefix to use for temporary part numbers. CIS automatically increments the temporary part number each time you create a new part. The temporary part number is then appended to this supplied prefix. Our workgroup is using a shared, read-only database configuration file, all users must use the same temporary part prefix.

10. In the Part Not Present Display Value text box, enter the text description that you want CIS to use for variant parts set to Not Present. The property is displayed in the following locations:

- Part Number and Value fields in the part manager
- Design variant columns in variant reports
- Variant parts on schematic page previews and printouts.

Note: If your workgroup is using a shared, read-only database configuration file, all users must use the same temporary part prefix.

Note: The Part Not Present Display Value does not display in Capture’s schematic page editor. This property also cannot be repositioned or edited in the schematic page editor. For this reason, you will have to print preview or print a schematic page to make sure that the value you assign the property does not overlap another part or property display.

11. In the Crystal Reports Keying Preference section, choose to sort by part reference or by part number. The default is to sort by part reference.

12. Click OK or choose another tab to continue configuring your database.
Setting Relational Database preferences

Capture CIS allows you to create and use relational databases. You can define the primary - foreign key relationship between the parts (primary) tables and related tables in the database.

In the Relational Database tab, you define the relationship between the part (primary) and relational tables in the database.

The Set Relational Data grid contains the following fields:

**Primary Table Name:**

Use this list to define the part (primary) tables in your relational database. This is the only read-only field in the grid.

**Primary Key:**

Use this list to define the primary key that you want to use to form the relationship with the relational table

**Relational Table**

Use this list to specify a relational table that has a primary - foreign key relationship with the selected primary table.

**View Name:**

Use this text Field to define a friendly name for the view that will display when a user selects the primary table to create a relational query.
To define the relational data

First, ensure you are in the Relational Database tab of the Configure Database dialog. Go to a row that contains a primary table (for example, Capacitor as displayed in the following figure).

1. Select the Primary Key field drop down list.
   This list displays all the fields in the primary key table.
   
   **Note:** If the specified ODBC driver provides support for retrieving the primary key, this will be displayed by default in this field for the corresponding primary table.

2. Select the field to use in your relation.

3. Select the Relational Table field drop-down list.
   This displays the list of tables in the database that have a primary - foreign key relationship with the corresponding primary table.

4. Select the table to form the relationship with the primary table.

5. In the View Name field, define a friendly name for the view that will display when a user selects the primary table to create a relational query.

Repeat Steps 1 through 4 for every table in Primary table list that is to be defined as a primary table in CIS and you want to create a relationship with a relational table.
6. Click OK or choose another tab to continue configuring your database.

**Saving the configuration file**

1. (Optional) In the CIS Configuration File dialog box, choose Save As to save the configuration for future use.
2. Choose OK to set the configuration for the current session and close the CIS Configuration File dialog box.

**Creating Crystal Reports templates**

Crystal Reports is a powerful, dynamic and widely-used report design software solution from SAP BusinessObjects.

You can use Crystal Reports in conjunction with CIS to make customized report templates with more advanced features than the standard CIS bill of materials, including precision formatting and formulas that total, filter, and analyze data for highly specific results. When you create customized Crystal Reports templates, you can use all of the part properties included in your preferred parts database and your individual design projects.

If you want to make a standard CIS bill of materials template, see “Creating a standard CIS bill of materials” on page 153.

**Note:** You must have Crystal Reports Designer installed on your system with CIS to create Crystal Reports templates. If you do not own a copy of Crystal Reports, visit the SAP BusinessObjects web site for reseller information.

Once you have created Crystal Reports templates, any CIS user with access to them can generate, preview, print, and export reports with their design’s database part information from within CIS. They will not need to have copies of Crystal Reports installed locally on their workstations to use these templates.

This is the process you will complete to create your Crystal Reports templates:

1. Create an SQLite database (.DB) file using a standard CIS bill of materials.
2. Create report template (.RPT) files in Crystal Reports using the SQLite database file. You only need Crystal Reports software to create templates, not to use them. For this reason, you only need to purchase one copy of the software for your entire workgroup.

3. Store the Crystal Reports template files where CIS can use them.

**Note:** By default, the 17.2-2016 Installer installs the SQLite® ODBC Driver for Win64.

To create an SQLite database (.DB) file for use by Crystal Reports

**Note:** If you want to create a new .DB file, follow the procedure from Step 1. If the existing .MDB file is available, follow step mentioned in the section To convert existing .MDB file to .DB file on page 71.

1. Open a new or existing schematic design in Capture. You should use a schematic design that has all the non-database part properties defined that you want to use when designing your Crystal Reports templates.

2. From the project manager’s Reports menu, point to CIS Bill of Materials and choose Standard. CIS displays the Standard Bill of Materials dialog box.

3. In the Template Name text box, type in a name for the report (for example, Report for Crystal Reports template).

4. In the Select Properties list on the left, double-click each of the part properties until all of them are moved to the Output Format list on the right.

**Tip**

Do not try to be selective about the part properties you include at this time. Generating this report with all the properties in your database allows you to create a single database file with all the headings you might want to use to design your templates in Crystal Reports. This way, you will not have to repeat this procedure again unless the part properties used in your database change.

5. Click OK. The report may take several minutes to generate.
6. From the File menu, choose Save As. CIS displays the Save As dialog box.

7. In the Save As Type list, select SQLite database format (*.DB).

8. Specify the file name and location and click OK

To convert existing .MDB file to .DB file

1. Convert the .MDB file to .DB file using ODBC Export method available in Microsoft Access.
To create a Crystal Reports template

Using Crystal Report Designer, create a custom report using the SQLite database (.DB) file as your data file. Note that the connection string will be the ODBC connection string for SQLite. Following is the suggested ODBC connection string for SQLite:

```
DRIVER=SQLite3 ODBC Driver;Database="SQLite DB file Name";LongNames = 0;Timeout = 1000; NoTXN = 0;SyncPragma=NORMAL;StepAPI=0;NoWCHAR=1;
```

To store a template file for use by CIS

1. Store your Crystal Reports template (.RPT) file where all users in your workgroup have access to it.

   To avoid having to browse for your template, store the file in the same directory as your database configuration (.DBC) file. The template will automatically appear in the Crystal Reports Bill of Materials dialog box.

   **Note:** You must have Crystal Reports Designer installed on your system with CIS to create Crystal Reports templates. If you do not own a copy of Crystal Reports, visit the SAP BusinessObjects web site for reseller information.

   **Note:** You only need Crystal Reports software to create templates, not to use them. For this reason, you only need to buy one copy of the software for your entire workgroup.
Working with database parts

This chapter describes the various procedures you use when working with database parts, including the following:

- “Using the CIS interface” on page 73
- “Placing a database part on a schematic page” on page 81
- “Browsing part properties” on page 91
- “Creating a new database part” on page 92
- “Linking a placed part to a database part” on page 101
- “Viewing a placed part’s database properties” on page 110
- “Copying part properties using the part manager” on page 111
- Exporting Variant List to PCB Editor using Part Manager on page 112

Using the CIS interface

The CIS user interface includes standard Windows interface functionality along with a few additional features to make your work environment easy to use. You can also customize the layout of CIS windows for each of your Capture projects. The main CIS interface is comprised of the part manager and CIS explorer windows. Additional CIS menu commands are interspersed throughout the menus in Capture.

For descriptions of the functions of the windows in the CIS interface, see “The CIS work environment” on page 17.
Tip

Right mouse button access for the most commonly used CIS commands is available in the project manager, schematic page editor, part manager, and CIS explorer windows.

Using the part manager window

The part manager window is composed of a component property view in the right pane, and a tree view in the left pane. The tree view is used for creating groups and subgroups of components for bill of materials variants. If you are not working with design variants, you can close the tree view. For more information on using the tree view, see “Defining and Using Groups and Subgroups” on page 115.

You can adjust the work environment for the part manager in the following ways:

- Sort the part manager data by any one of the data columns.
- Adjust the part manager display by changing data column width and splitting the window into panes.
- Display the toolbar.

To open the part manager window, do the following:

† From the project manager’s Tools menu, point to Part Manager and choose Open.

For information about how to use the part database management features of the part manager, see “Viewing and updating part status” on page 131.
To sort information in the part manager

Click the heading of the column you want to sort by. To reverse the sort order, click the same column heading again.

The column by which the data in the part manager is currently sorted is indicated by a triangle icon. If the triangle points upward, the data is sorted in ascending order. If it points downward, the data is sorted in descending order.

To adjust the part manager display

1. To adjust the width of a column, select the right border of the column heading and drag it to the left or right.

2. To split the part manager into panes, choose Split from the part manager's Window menu.

To display the part manager toolbar

1. Move or dock the toolbar as desired.

2. To display the name of the button command, point at the button briefly.

3. To display the toolbar, choose Toolbar from part manager's View menu.

4. To hide the toolbar, click the hide button in the top corner of the toolbar.
Using the CIS explorer window

CIS displays the CIS explorer when you choose Place Database Part or Link Database Part from a schematic page in Capture’s schematic page editor. Information about how to use the database part features of the CIS explorer is covered in the following sections of this chapter.

The CIS explorer contains a tabbed window—the Local Part Database. The window contains a non-docking part selection window that cannot be redisplayed as floating or hidden (the database parts window).

Using docking windows

Docking windows can be positioned and sized independently like standard windows. But, they allow you added control over your workspace in relation to the other windows inside the CIS explorer. Docking windows have these unique features:

- Docking to the main window
Expanding or contracting relative to other windows

Floating over other docking windows

Depending on the function of the window, you can also choose to show or hide some docking windows. CIS retains the size, position, and state of the windows between Capture sessions.

To dock a window in the CIS explorer

1. Drag the window by the double bar over another border of the CIS explorer. The other windows automatically adjust to allow the window you are moving to dock on that border.

To expand or contract a window relative to other windows

1. Click the arrow above the window’s double bar to expand or contract the window in the direction of the arrow. The bordering window automatically expands or contracts to fit the new window size. Since the expand/contract feature only functions horizontally, the arrow is dimmed if the window is not bordered by another window on the left or right.
To change a docked window to a floating window

1. Double-click in the window border. The docking window redisplays with a title bar instead of the double bar.

To dock a floating window

1. Double-click the window title bar to return the window to its previous docked location, or drag the window by the title bar to a different docking border.

To position a floating window over a dock (without docking it)

1. Press and hold down Ctrl and drag the window by the title bar.

To show or hide a window

1. To show a window, choose the window name (for example, Visibility) from the View menu.

2. To hide a window, click the hide button in the top corner of the window, or choose the window name from the View menu.

Using the database parts window

<table>
<thead>
<tr>
<th>Table</th>
<th>Part Number</th>
<th>Part Type</th>
<th>Value</th>
<th>Description</th>
<th>Voltage</th>
<th>Manufacturer</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>PCC910CQTR</td>
<td>Ceramic</td>
<td>91PF</td>
<td>CAP 91PF 50</td>
<td>50V</td>
<td>ECL</td>
</tr>
<tr>
<td>2</td>
<td>PCC820CQTR</td>
<td>Ceramic</td>
<td>82PF</td>
<td>CAP 82PF 50</td>
<td>50V</td>
<td>ECL</td>
</tr>
<tr>
<td>3</td>
<td>PCC750CQTR</td>
<td>Ceramic</td>
<td>75PF</td>
<td>CAP 75PF 50</td>
<td>50V</td>
<td>ECL</td>
</tr>
<tr>
<td>4</td>
<td>PCC680CQTR</td>
<td>Ceramic</td>
<td>68PF</td>
<td>CAP 68PF 50</td>
<td>50V</td>
<td>ECL</td>
</tr>
</tbody>
</table>
You can use the spreadsheet format of the database parts window to do the following:

- Sort rows using column values
- Adjust column widths
- Change the order of the columns
- Hide or unhide columns

Once you set up the columns, CIS saves the new settings for your next session.

⚠️ Important

In the Japanese version of CIS on a Windows 98 SE machine, text in the database parts window appears garbled. To fix this problem, you need to install ddlinkx.dll and define a section in the Capture.ini file as shown below.

```
[CIS Spreadsheet]
Font = {required Japanese font}
Size = {size of the font}
```

**Note:** The database parts window is part of the main CIS explorer window—you cannot hide or dock it. This is so that the window will be present at all times to place and link database parts.

**Note:** Roll the mouse wheel up and down to scroll through vertically in the database parts window.

**Note:** Hold down the SHIFT key and roll the mouse wheel up and down to scroll through horizontally.

**Note:** Click the mouse wheel button and drag it to the right or left in the database parts window to scroll horizontally.

**Note:** Click the mouse wheel button and drag it up or down in the database parts window to scroll vertically.

**Note:** For a description of the database parts window, see “Using the database parts window” on page 78.
**To sort rows using column values**

1. Click a column heading to select the column, then click the column heading again to sort by its values. Click the same column heading again to reverse the sort order.

   The column by which the data is currently sorted is indicated by a triangle icon. If the triangle points upward, the data is sorted in ascending order. If it points downward, the data is sorted in descending order.

<table>
<thead>
<tr>
<th>Table</th>
<th>Part Number</th>
<th>Part Type</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Capacitor</td>
<td>PC01000CT10 Ceramic</td>
<td>01PF</td>
</tr>
<tr>
<td>2</td>
<td>Capacitor</td>
<td>PC02000CT10 Ceramic</td>
<td>02PF</td>
</tr>
<tr>
<td>3</td>
<td>Capacitor</td>
<td>PC02500CT10 Ceramic</td>
<td>02PF</td>
</tr>
<tr>
<td>4</td>
<td>Capacitor</td>
<td>PC03000CT10 Ceramic</td>
<td>03PF</td>
</tr>
<tr>
<td>5</td>
<td>Capacitor</td>
<td>PC03500CT10 Ceramic</td>
<td>03PF</td>
</tr>
<tr>
<td>6</td>
<td>Capacitor</td>
<td>PC04000CT10 Ceramic</td>
<td>04PF</td>
</tr>
<tr>
<td>7</td>
<td>Capacitor</td>
<td>PC04500CT10 Ceramic</td>
<td>04PF</td>
</tr>
</tbody>
</table>

**To adjust column widths**

1. Select the right border of a column heading and drag it to the left or right.

**To change the order of the columns**

1. Click on a column heading to highlight it.

2. Drag the column heading to the left or right until the vertical red line is in the correct location.

**To hide columns**

CIS keeps a separate column display configuration for each part type folder. So, when you hide or unhide a column, CIS only hides or unhides the column for the part type folder whose parts are currently displayed in the database parts window.

1. Click on a column heading to highlight it.

2. Click the right mouse button on the column heading, and choose Hide Column.
To unhide columns

1. Click the right mouse button on any column heading, and choose Unhide Columns. CIS displays the Unhide Columns dialog box.

2. Select the names of the columns you want to unhide and click OK.

Placing a database part on a schematic page

This section describes how to do the following:

■ Locate a part in your parts database.
■ Place a database part on a schematic page.

When you place a database part, CIS includes all database part properties to be transferred.

Note: The Place Database Part command will not work unless you have entered the schematic part name in your database and have set the Schematic_Part property type in the configuration.

Using the explorer to locate a database part

You can use the explorer to locate a particular part in your database.

To locate a database part with the explorer

1. From the schematic page editor's Place menu, choose Database Part. CIS displays the explorer window.
2. In the explorer window, choose the Explore tab. The drum icon (labeled Benchacc in this example) represents the part database.

3. Choose + or double-click the drum icon, to expand the database into the configured part tables. Similarly, choose + on the table to expand the tree to display the first-level part type folders.

Tip

If you want to display the whole part tree structure, from the View menu, choose Expand Part Tree.

4. Locate the part you want to place. When you open a part type folder at any given level, the database parts at that level are displayed in the database parts window. For information about adjusting the display of part information and property columns in the database parts window, see “Using the database parts window” on page 78.

<table>
<thead>
<tr>
<th>Table</th>
<th>Part Number</th>
<th>Part type</th>
<th>Value</th>
<th>Description</th>
<th>Voltage</th>
<th>Tolerance</th>
<th>Schematic P</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Connector</td>
<td>PC012000TR Ceramic</td>
<td>20pF</td>
<td>CAP 20PF 50V</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Capacitor</td>
<td>PC022500TR Ceramic</td>
<td>50pF</td>
<td>CAP 50PF 50V</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Capacitor</td>
<td>PC032500TR Ceramic</td>
<td>75pF</td>
<td>CAP 75PF 50V</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Capacitor</td>
<td>PC042500TR Ceramic</td>
<td>100pF</td>
<td>CAP 100PF 50V</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note: CIS uses the part type property contents from your part database to determine the folder hierarchy.

Note: While placing a database part, if you get the error message “Could not read part information”, then make sure that you check the CIS configuration settings and the .INI file.

Using the query feature to locate database parts

You can also use the query feature in the CIS explorer window to locate all parts in the database that fit a set of criteria. This is useful when you want to view all the available parts that match a set of attributes. To use the query feature, you must first create the query criteria, then execute the database search. Additionally, you can:

- Save and retrieve queries, see “Saving and retrieving a non-relational query” on page 84
- Modify saved queries, see “Modifying a saved query” on page 85
- Delete saved queries, see “Deleting a saved query” on page 86
Creating and executing a non-relational query

Capture CIS allows you to create non-relational queries on a flat structure database.

1. From the schematic page editor’s Place menu, choose Database Part. CIS displays the CIS explorer window.

2. In the Explorer window, choose the Query tab.

3. In the first cell in the Property column, type in the name of a property or choose one from the cell's drop-down list.

4. In the first cell in the Compare column, type in a logical operator or choose one from the cell’s drop-down list.

5. In the first cell in the Value column, enter a value. If you’re using the equal to (=) logical operator, you can use wildcard characters for the value: an asterisk (*) matches a group of characters, and a question mark (?) matches any single character.

   Repeat steps Step 3 through Step 5 as necessary to construct subsequent rows of search criteria. You can delete a query row by selecting the row and then pressing Delete. Since a database search identifies only those parts that meet all the search criteria, you can use additional rows of criteria to pinpoint specific parts.

6. To perform the query, press Enter or choose Re-search Database from the Update menu. CIS displays the results in the database parts window.

Note: If you make changes to column width or hide a column in Query view (Query tab), the same settings will not be retained when you change to the Explore view (Explore tab) and vice-versa.

Note: You can save your query definitions. See “Saving and retrieving a non-relational query” on page 84 for more information.
Saving and retrieving a non-relational query

OrCAD Capture CIS enables you to save your queries and retrieve them in subsequent Capture CIS sessions.

To save a query

1. Create a query, see “Creating and executing a non-relational query” on page 83.

   Saving a query

2. Specify a name for the query in the Select a Query combo box.

3. Click Save Query. The query is saved and the query name appears in the Select a Query combo box.

Note: Capture CIS saves the query name along with the query definitions in a file called CISQuery.txt file. This file is created only when you save your first query. The file by default is saved in your
local Windows installation directory, for example, WINNT (Windows 2000) and WINDOWS (Windows XP).

⚠️ **Caution**

*Do not change the default location of the CISQuery.txt file. Otherwise, you will not be able to retrieve your saved queries. To know how to retrieve a saved query, see “To retrieve a saved query” on page 85.*

⚠️ **Caution**

*Do not modify a query manually in the CISQuery.txt file. This may result in problems while retrieving the modified query later.*

**To retrieve a saved query**

In the Query tab of the Explorer window, select the query you want to retrieve from the Select a Query combo box. The query definitions for the selected query appear under the respective column headers in the Explorer window.

**Note:** You can also retrieve the query definitions of a saved query by entering the query name in the Select a Query combo box and pressing Enter.

**Modifying a saved query**

You can change the existing query definitions in a saved query and use it later.

⚠️ **Caution**

*It is recommended that you modify the queries from the Save Query UI and not manually in the CISQuery.txt file.*
**To modify an existing saved query**

In the Query tab of the Explorer window, select the query you want to modify from the Select a Query combo box. The query definitions appear under the respective column headers in the Explorer window.

1. Change the query definitions as desired.
2. Click Save Query. The query is updated.

**Deleting a saved query**

You can delete an existing saved query.

**To delete an existing saved query**

1. In the Query tab of the Explorer window, select the query you want to delete from the Select a Query combo box. The query definitions appear under the respective column headers in the Explorer window.
2. Click Delete Query. The query along with the query definitions are deleted from the CISQuery.txt file and the query name does not appear in the Select a Query combo box.

**Creating and executing a relational query**

Capture CIS also allows you to create non-relational queries on a flat structure database. However, the relational view will be enabled in
1. From the schematic page editor's Place menu, choose Database Part. CIS displays the CIS explorer window.

2. In the Explorer window, choose the Query tab.

3. Select the Relational Query checkbox.

4. In the Select a Table drop-down list, choose a primary table to query.

**Note:** The drop-down list will show only the tables for which relational query has been defined.

**Note:** When you select particular table for running a query, all the properties of that table are available in the property tab to formulate...
a query. If you select "All Tables" the union of the properties of all the 
relational tables is available for forming the query.

5. In the Property column, type in the name of a property or choose 
one from the cell's drop-down list.

6. In the Compare column, type in a logical operator or choose one 
from the cell's drop-down list.

7. In the Value column, enter a value. If you're using the equal to 
(=) logical operator, you can use wildcard characters for the 
value: an asterisk (*) matches a group of characters, and a 
question mark (?) matches any single character.

Repeat steps Step 3 through Step 5 as necessary to construct 
subsequent rows of search criteria. You can delete a query row 
by selecting the row and then pressing Delete. Since a database 
search identifies only those parts that meet all the search 
criteria, you can use additional rows of criteria to pinpoint 
specific parts.

8. To execute the query, press Enter or choose Re-search 
Database from the Update menu. CIS displays the results in the 
database parts window.

Placing a local database part on your schematic

After locating the database part from the local part database, you can 
place it on your schematic page.

Note: If your database contains mechanical (non-electrical) parts, 
you can place them on your design. However, if you want the 
mechanical parts to be included in a CIS bill of materials, you must 
place them on the root schematic or on a schematic that is 
referenced by a hierarchical block on the root schematic. For 
information about root schematics and hierarchical blocks, see the 
Capture User's Guide or Capture online help.

Note: You can define property place holder positions in the 
schematic library for properties which you want pre-positioned. For 
example, you can define a Tolerance property in the resistor 
schematic part and position it so that when the part is placed, the 
property position is satisfactory. See the OrCAD Capture User's 
Guide for more information.
Any properties specified during configuration as transferable are copied to the placed part and are present in the placed part properties.

CIS sets the appropriate property visibility. If the property is set to Visible and exists in the library, CIS uses the property position defined in the library; otherwise, CIS displays the property in a default position. If you change the position of a property in the part editor, any subsequent updates to the part (using the Link Database Part command) retain the new position.

You can also use the library convert feature to hold two different orientations of the part, one for the normal orientation and one for the 90-degree rotation. See the Capture User's Guide for more information.

**Setting path for custom libraries**

Before placing database components, you should make sure that path for all the libraries including custom libraries, is initialized. There are three ways to initialize a library path:

- Add a library from the custom library path in the Place Part dialog box and restart Capture. When you restart Capture, the newly modified Capture.ini file will be read.
- Manually add path of the custom libraries to the Capture.ini file before opening Capture.
- Use the OrCAD INI File Administrator utility to define the paths for custom libraries. For more information, see “OrCAD Capture CIS Starter Database Kit” on page 261.

**To place a database part on your schematic**

1. In the database parts window, select the part you want to place.

2. If the database part has multiple schematic parts associated with it and you want to select a different schematic part name,
select one from the drop-down list for the Schematic Part property name.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
<th>Schematic Part</th>
<th>PCB Footprint</th>
<th>M</th>
</tr>
</thead>
<tbody>
<tr>
<td>3P</td>
<td>High Voltage</td>
<td>NC1413</td>
<td>DIP.100/16AV/M</td>
<td></td>
</tr>
<tr>
<td>34P-5</td>
<td>Micropower</td>
<td>NC34064/TO</td>
<td>TO226AB</td>
<td>M</td>
</tr>
<tr>
<td>407P</td>
<td>RS232 5V On</td>
<td>NC145407P</td>
<td>DIP.100/20AV/M</td>
<td>M</td>
</tr>
</tbody>
</table>

3. If the database part has multiple PCB footprints associated with it and you want to select a different PCB footprint name, select one from the drop-down list for the PCB Footprint property name.

4. If you want to override the default visibility settings of one or more transferable part properties, change the settings in the visibility window. There are four possible visibility settings:

- CIS displays the property with the part on the schematic page
- CIS does not display the property with the part on the schematic page.
- CIS does not modify the property visibility. If the property does not exist, it is set to invisible.
- CIS does not allow this property to be set as visible on schematic pages.

5. Start placing the part by doing one of the following:

- In the database parts window, double-click your selected part.
- From the Right-Click Pop-Up menu, choose Place Database Part.

6. Click to place the part. Press Esc when you're finished placing instances of this part.

For more information about placing and linking database parts, see “Placing a database part on a schematic page” on page 81 and “Linking a placed part to a database part” on page 101.
Browsing part properties

Database parts may include browsable properties. These properties actually specify links to documents or web sites. CIS allows you to browse properties for which the Browsable option was set during configuration.

For information about configuring CIS, see “Creating a configuration file” on page 43.

To browse a database part property

1. In the database parts window, click the database part property you want to browse. The cursor turns into a hand when you point at a browsable property.

Since the browsing feature is generic, you can view virtually any kind of data. You can include references to your component datasheets on your company’s intranet, as Word files, Acrobat files, or any other format. For example, you may want to view package drawings, mechanical models, simulation models, and so on.

CIS launches the appropriate browser based on the value of the part property.

Example: If the part property value is a URL such as:

http://www.chipmfg.com/datasheets/74ALS138.html

CIS starts your default web browser and displays the web page for that URL.
Creating a new database part

Almost every design will use some new parts that aren’t in your part database and do not have a company part number. CIS lets you create a new part while you’re working and save it to the database. This allows you to continue working without having to stop for the part approval process. When you save a temporary part to your database, CIS can automatically assign a temporary part number and track the part for you in the part manager. Later, if the part is approved and assigned a company part number, CIS can automatically update your design with the new part information. For more information about updating part information on designs, see “Viewing and updating part status” on page 131.

You can create new database parts using one of the following methods:

■ Derive a new database part from your local part database. See Deriving a new database part from the local part database below.

■ Derive a new database part from a part placed on a schematic page. See “Deriving a new database part from a placed part” on page 97.

Deriving a new database part from the local part database

You can create new database parts using parts that are already stored in your database. Once you have selected and altered an existing database part, you can store it as a temporary part in your database and place instances of the new part on schematic pages.

To derive a new part for the part database

1. If a schematic page is not already open and active, open a schematic page.
2. From the Place menu, choose Database Part. CIS displays the CIS explorer.

3. Use the explore and query features to locate the part you want to use as the basis for creating your new database part. For more information about locating parts in your local part database, see “Placing a database part on a schematic page” on page 81.

4. Select the desired part in the database parts window.
5. From the Edit menu, choose Derive New Database Part. CIS displays the New Database Part dialog box.

6. Enter the appropriate values for the new part’s database properties in the Contents column. You cannot change the selected table in the Save Part To area. This is because you are deriving the new part from a placed part that is already in your part database, so the new part is automatically placed in the same table as the existing database part.

   **Note:** If you have selected Assign Temporary Part Numbers Automatically in the configuration, a temporary part number is already assigned which you cannot modify.

7. Modify the visibility settings for each property as desired.

8. If you want to choose alternate schematic parts or footprints for the new database part, do the following:

   a. Click the Browse button in the Schematic Part area to choose alternate schematic parts or in the Footprint area to choose alternate footprints. CIS displays the Select
Schematic Part or Select Footprint dialog box (see figure below).

b. If you want to include the library name with the selected schematic parts or footprints, select the Attach the Library Name option. You can include the library name to avoid confusing the schematic part or footprint name with an identically named one in a different library. 

c. In the Schematic Part or the Footprint list, select a part or a footprint. The part or footprint displays in the preview window.

Tip

If you know what library your footprints or schematic parts are stored in, highlight only that library in the Configured Libraries list. This will greatly reduce the number of schematic parts you have to scroll through to find part or footprint names.
d. Click the Add button to move the schematic part or footprint to the Selected Schematic Parts or Selected Footprints list. You can remove it from the list by selecting it and clicking the Remove button.

e. Repeat steps Step c and Step d until you have selected all the schematic parts or footprints that you want to be available for use with the database part.

f. If you selected more than one schematic part or footprint, use the up and down arrows to arrange the order of the parts or footprints. The top one will be the default value for the database part. The order of the whole set determines the order in which they will display in the scroll-down list of

Caution

Only select a schematic part from your own custom libraries; do not select a part from the libraries that are supplied with Capture (resource libraries). Resource libraries are often changed by upgrades to new versions of Capture. If the name or path of the schematic part you select is changed during an upgrade, it will become invalid for all your database parts.

Caution

If you are deriving a new mechanical (non-electrical) part and choosing an alternate schematic part, you must choose a schematic part with no pins. If mechanical parts with pins are placed in a design, they will invalidate netlists generated from that design.
the Schematic Part or PCB Footprint property value cells of the CIS explorer's database parts window.

<table>
<thead>
<tr>
<th>Order in the Selected Schematic Parts list</th>
<th>Order in scroll-down list of Schematic Part property value cell in CIS explorer's database parts window</th>
</tr>
</thead>
</table>

**g.** Click OK. CIS returns you to the New Database Part dialog box.

**9.** Click the Place Part button. The dialog box closes, the new part is added to the part database, and you are returned to the schematic page with the pointer in place part mode.

**Note:** After the new part is added to the database, you must have administrative privileges for the database to modify the properties that you set above.

**10.** Click to place the part. Press Esc when you are finished placing instances of the part.

**Deriving a new database part from a placed part**

You can create new database parts using parts that you have already placed on schematic pages. While you are deriving a new database part, you can change the values and visibility settings of the database part properties.

By default, CIS does not automatically copy all placed part properties to the part database. The properties that are automatically transferred have all three of the following characteristics:

- They are mapped to database part properties in the database configuration.
- They have been set to transfer to designs in the database configuration.
- They have a value for the placed part.
If you want other property values to be added to the database, you can manually add them during this procedure, but only if the property is mapped in the database configuration.

As soon as the new part is stored in the database, you can place instances of the part on schematic pages. The part will remain a temporary part, however, until your database administrator assigns a permanent part number.

**To derive a new part from a database part**

1. Open the schematic page that contains the placed part you want to use to derive a new database part.

2. Select the placed part.

3. From the Edit menu, choose Derive Database Part. CIS displays the New Database Part dialog box.

4. In the Save Part To area, choose the database table in which you want to save the new database part.

   Note: If you are deriving the new part from a placed part that is already in your part database, the new part is automatically placed in the same table as the existing database part. CIS will not allow you to select a different table.

5. If you want to change the value of a database property, enter the new value in the Contents column.
Note: If you have selected the Assign Temporary Part Numbers Automatically option in the configuration, a temporary part number is already assigned which you cannot modify.

6. Modify the visibility settings for each property as desired.

7. If you want to choose alternate schematic parts or footprints for the new database part, do the following:

   a. Click the Browse button in the Schematic Part area to choose alternate schematic parts or in the Footprint area to choose alternate footprints. CIS displays the Select Schematic Part or Select Footprint dialog box.

   ![Select Schematic Parts dialog box]

   b. If you want to include the library name with the selected schematic parts or footprints, select the Attach the Library Name option. You can include the library name to avoid confusing the schematic part or footprint name with an identically named one in a different library.

   c. In the Schematic Part or the Footprint list, select a part or a footprint. The part or footprint displays in the preview window.
Tip

If you know what library your footprints or schematic parts are stored in, highlight only that library in the Schematic Part Libraries or Configured Libraries list. This will greatly reduce the number of schematic parts you have to scroll through to find part or footprint names.

Caution

Only select a schematic part from your own custom libraries; do not select a part from the libraries that are supplied with Capture (resource libraries). Resource libraries are often changed by upgrades to new versions of Capture. If the name or path of the schematic part you select is changed during an upgrade, it will become invalid for all your database parts.

Caution

If you are deriving a new mechanical (non-electrical) part and choosing an alternate schematic part, you must choose a schematic part with no pins. If mechanical parts with pins are placed in a design, they will invalidate netlists generated from that design.

d. Click the Add button to move the schematic part or footprint to the Selected Schematic Parts or Selected Footprints list. You can remove it from the list by selecting it and clicking the Remove button.

e. Repeat steps Step c and Step d until you have selected all the schematic parts or footprints that you want to be available for use with the database part.

f. If you selected more than one schematic part or footprint, use the up and down arrows to arrange the order of the parts or footprints. The top one will be the default value for the database part. The order of the whole set determines the order in which they will display in the scroll-down list of
the Schematic Part or PCB Footprint property value cells of the CIS explorer's database parts window.

![Image of database parts window]

<table>
<thead>
<tr>
<th>Selected Schematic Parts</th>
</tr>
</thead>
<tbody>
<tr>
<td>discrete CAPTOR NON POL</td>
</tr>
<tr>
<td>discrete CAP NF</td>
</tr>
<tr>
<td>SMALL CAP</td>
</tr>
</tbody>
</table>

Order in the Selected Schematic Parts list

<table>
<thead>
<tr>
<th>Schematic Part</th>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>discrete CAPTOR NON POL</td>
<td>SMC</td>
<td></td>
</tr>
<tr>
<td>discrete CAP NF</td>
<td>SMC</td>
<td></td>
</tr>
<tr>
<td>SMALL CAP</td>
<td>SMC</td>
<td></td>
</tr>
</tbody>
</table>

Order in scroll-down list of Schematic Part property value cell in CIS explorer's database parts window

g. Click OK. CIS returns you to the New Database Part dialog box.

8. Click the Derive Part button. The part is added to the part database with the automatically assigned part number.

Linking a placed part to a database part

You can use the Link Database Part command from the part manager or the schematic page editor to assign a database part (and the associated transferable properties) to one or more placed parts. You can also specify whether you want to:

- replace the symbol, reference designator, and all the properties of the placed part with that of the database part.
- replace the symbol and all the other properties of the placed part with that of the database part, but retain the placed part reference designator.
- replace all the properties of the placed part with that of the database part, but retain the placed part symbol and the reference designator. For information on how to specify these options, see “Setting linking preferences” on page 102.

OrCAD Capture CIS allows you to link selected part occurrence(s) or a part with multiple occurrences to a database part. See “Linking part occurrence(s) to a database part” on page 108 for details.
Linking External Parts

You can link external parts using the Link Database Part command only from the Parts Manager.

Setting linking preferences

You can set preferences for linking a placed part to a database part by using the Extended Linking command.

To set link preferences

1. From the Capture CIS window, select the Options menu, point to CIS Preferences and choose the Extended CIS Linking command or press SHIFT+E shortcut keys. The Extended CIS Linking dialog box appears.

   ![Extended CIS Linking dialog box](image)

   **Note:** The Extended CIS Linking command is also accessible from the project manager and the schematic page editor.

2. Use the CIS Linking dialog box to specify the following options:

<table>
<thead>
<tr>
<th>To...</th>
<th>Select...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retain the symbol and reference designator of the placed part and replace all the properties of the placed part with that of the database part.</td>
<td>Preserve Reference Designator and Preserve Symbol check boxes.</td>
</tr>
<tr>
<td>Retain the placed part symbol, but replace all the other properties of the placed part with that of the database part.</td>
<td>Preserve Symbol check box only.</td>
</tr>
</tbody>
</table>
Working with database parts

<table>
<thead>
<tr>
<th>To...</th>
<th>Select...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong> The default behavior of OrCAD Capture CIS is to replace the symbol, reference designator, and all the properties of the selected placed part with that of the database part.</td>
<td><strong>Note:</strong> When you select the Preserve Symbol check box, the Preserve Reference Designator check box is selected automatically.</td>
</tr>
<tr>
<td>Replace the symbol and all the other properties of the placed part with that of the database part, but retain the placed part reference designator.</td>
<td>Preserve Reference Designator check box only.</td>
</tr>
</tbody>
</table>

3. Click OK to save the settings. The settings are saved in the CAPTURE.INI file. The next time you link a placed part to a database part these settings will be used.

**Note:** The link preferences can be changed any number of times during a Capture CIS session using the Extended CIS Linking command.

**Caution**

*Do not select the Preserve Reference Designator check box, if you are linking a placed part to a database part that differ in the number of components. Otherwise, the reference designators for the placed part will not be preserved after the linking is done.*

**Tip**

It is recommended that you set the linking preferences before you use the Link Database Part command to link a placed part to a database part.

**To link a placed part to a database part using the part manager**

1. From the project manager’s Tools menu, point to Part Manager and choose Open. CIS displays the part manager window.
2. In the part manager, select a placed part or a group of placed parts. To select a group of parts, do one of the following
   - For a group of nonadjacent parts, hold down Control and click the parts.
   - For a group of adjacent parts, hold down Shift and click the first then the last part in the range.

   **Tip**
   You can group similar parts in the part manager by sorting on one of the columns (for example, the Value column). Choose a column heading to sort the list by the information in that column; choose the same heading again to reverse the sort order.

3. From the Tools menu, choose Link Database Part.
   or
   Click the Link Database Part toolbar button.

4. In the part database explorer:
   Double-click the database part you want.
   or
   Select the database part you want and, from the Update menu, choose Link Database Part.

   If the schematic part property for the placed part is different from that of the selected database part, CIS will highlight the database part's row yellow when you select it in the database parts window.

   **Note:** In the visibility window, CIS displays the values of the selected database part's properties in the Database Contents column and the values of the placed part's properties in the Schematic Contents column. If the value of placed part's property is green, then it matches the value of the property for the database part. If the value of placed part's property is red, then the value does not match that of the database part.

   **Note:** CIS displays a warning message, if you select a database part to link to a group of placed parts whose part reference
prefixes or values differ. CIS will, however, allow you to link a placed part to a database part with a different schematic part name.

CIS links the database part to the placed part, and the appropriate properties are transferred.

**Caution**

*Because the schematic part used for the placed part will change, you must check the schematic page to make sure that you have correct connectivity when you are finished linking.*

**Note:** If you have defined part reference prefixes in the Allowed Part Reference Prefix text box and you link a placed part in your design to a database part with the Preserve Reference Designator check box checked in the CIS Extended Linking dialog box, the reference designator of the placed part is retained and all the transferable properties of the database part are transferred to the placed part. Now, when you update the part status from the part manager (using Update All Part Status command), the part status column displays: Approved: Part not found. This is because CIS is unable to find the part (with matching part reference prefix and properties) in the database table. You may avoid this situation by changing the reference designator of the placed part to the one you defined in the Allowed Part Reference Prefix text box or delete the part reference prefix from the Allowed Part Reference Prefix text box.

**Note:** CIS, by default, checks only for the symbol name while linking a placed part to a database part. If you want CIS to check for the symbol name, the complete path of the library, and the date/time stamp of the symbol during the linking process, add the following entry under [Symbol Libraries] section in CAPTURE.INI file:

```
[Symbol Libraries]
Strict Cache Check=1
```

**Note:** While linking, if a database part is a package alias of placed part, then the schematic part property of the database part will not transferred to the placed part on schematic. This is because the tool does not differentiate between a package and its alias.
To link a placed part to a database part using the schematic page editor

1. Select one or more parts on a schematic page.

2. From the Edit menu, choose Link Database Part. CIS performs a database query, using the keyed properties for the database, then displays the results of the query in the database parts window.

   Keyed properties are defined in the database configuration. Generally, though, the Value property is the primary keyed property. The initial query searches for parts with a value matching that of the placed part. If you select several parts, CIS uses the keyed properties and part reference prefix of the first part in the group (from top left to bottom right) for the initial query.

   CIS also uses the configuration settings for Allowed Part Reference Prefixes and Part Reference Associations to filter the database for only those parts that apply to the reference prefix of the selected parts.

3. Select the database part you want to apply to the selected placed parts. You can also create a new query if the initial query did not locate the part of interest.

4. In the part database explorer, do one of the following:

   Double-click the database part you want.

   or

   Select the database part you want and, from the Update menu, choose Link Database Part.

   If the schematic part property for the placed part is different from that of the selected database part, CIS will highlight the
database part's row yellow when you select it in the database parts window.

**Note:** In the visibility window, CIS displays the values of the selected database part's properties in the Database Contents column and the values of the placed part's properties in the Schematic Contents column. If the value of placed part's property is green, then it matches the value of the property for the database part. If the value of placed part's property is red, then the value does not match that of the database part.

The database part is linked to the placed parts, which also receive the transferable properties, including the part value. If any of the selected placed parts are multiple-part packages and have defined part references, CIS updates all other parts in the package at the same time. For example, if the selected placed part is U33B, CIS will update U33A, U33C, and any other parts in the package as well. If the selected placed part reference is undefined, only the selected part is updated.

**Caution**

*Because the schematic part used for the placed part will change, you must check the schematic page to make sure that you have correct connectivity when you are finished linking.*

**Note:** CIS, by default, checks only for the symbol name while linking a placed part to a database part. If you want CIS to check for the symbol name, the complete path of the library, and the date/time stamp of the symbol during the linking process, add the following entry under [Symbol Libraries] section in CAPTURE.INI file:

```
[Symbol Libraries]
Strict Cache Check=1
```

**Note:** While linking, if a database part is a package alias of placed part, then the schematic part property of the database part will not transferred to the placed part on schematic. This is because the tool does not differentiate between a package and its alias.
Linking part occurrence(s) to a database part

You can select whether you want to link all the occurrences of a selected part(s) or only the selected occurrence(s) of a part to a database part.

To link part occurrence(s) to a database part

1. Select one or more parts on a schematic page or the part manager.

2. Right-click on the selection and choose Link Database Part from the pop-up menu.

3. If the selected part(s) has:
   - only a single occurrence in the design, then the part database explorer appears where you can select the database part to be linked to the selected part(s).
   - more than one occurrence in the design, then the Occurrence Level Settings dialog box appears.

   ![Occurrence Level Settings dialog box]

   **Note:** The Occurrence Level Settings dialog box is not displayed in the following situations, where the selected part(s) has only a single occurrence in design or the Do not show this dialog again check box is selected.

4. Select Link to Selected Occurrences Only check box to link the database part to the part(s) you have selected on the schematic page or the part manager.

   or
Select Link all Occurrences check box to link the database part to all the occurrences of the selected part(s) on a schematic page.

**Note:** CIS does not allow you to link a database part to part(s) in a group, which have multiple occurrences.

**Note:** If you want to view all the occurrences for the selected part(s) in a design, click the List button. This is a view-only list.

5. Click OK. The part database explorer appears where you can select the database part to be linked to the selected part(s). The settings are saved in the CAPTURE.INI file.

If you select the Do not show this dialog again check box, the Occurrence Level Settings dialog box will not be displayed the next time you link a part(s), which has multiple occurrences in a design. To display this dialog box again, you must change the following entry under the [Link Settings] section in the CAPTURE.INI file:

```
[Link Settings]
Show Occurrence Link Dialog=FALSE
```

**Note:** Show Occurrence Link Dialog=TRUECIS, by default, checks only for the symbol name while linking a placed part to a database part. If you want CIS to check for the symbol name, the complete path of the library, and the date/time stamp of the symbol during the linking process, add the following entry under [Symbol Libraries] section in CAPTURE.INI file:

```
(Symbol Libraries)
Strict Cache Check=1
```
**Note:** While linking, if a database part is a package alias of placed part, then the schematic part property of the database part will not transferred to the placed part on schematic. This is because the tool does not differentiate between a package and its alias.

**Caution**

*If you choose to link the database part to the selected occurrence without preserving the symbols, then all the occurrences in the design will be updated with the database part symbol.*

**Viewing a placed part’s database properties**

You can view a placed part's local and Internet database properties right from the schematic page or the part manager, if the part has been added to the local part database. When you choose to view the part properties, CIS displays a read-only version of the CIS explorer with a comparison of the placed part's properties to those of its linked database part. You can also use this part viewing capability to check the latest data sheet, stocking, and pricing information from the Internet.

**To view a placed part’s database properties**

1. From the schematic page or the part manager, select the part for which you want to view database properties.

   **Note:** On the schematic page, the selected part must be in your local part database for CIS to display part properties. If you attempt to view the database properties of a part not stored in your local part database, CIS will display the Local Part Database tab of the CIS explorer window with no part information.

2. From the View menu, choose Database Part. CIS displays the CIS explorer window in View Database Part mode.

   **Note:** The View Database Part mode is a read-only mode. For this reason, you cannot use the search or query functions of the explorer window to search for, place, or link a database part.
CIS displays the database part property contents in the database parts window. In the visibility window, CIS displays both the contents of the database parts properties and of the properties that have been transferred to the schematic. If the content of a schematic property is green, then it matches the content of the part database. If the content of a schematic property is red, then the contents do not match the part database.

**Copying part properties using the part manager**

You can also use the part manager to copy properties from one part to another (or to several others) in the design. CIS copies only those properties defined in the database configuration file as transferable.

*To copy properties from one part to another*

1. Open the schematic design that contains the part properties you want to copy.

2. From the project manager’s Tools menu, point to Part Manager and choose Open. CIS displays the part manager, showing all parts in the design, sorted by part reference.

3. Select the part with the properties to be copied. You can use the Split command (from the part manager’s Window menu) to display two areas of the part manager. This can make copying properties from one part to another much easier (by dragging the part across split panes) if the two parts are widely separated in the part manager.

4. Drag the selected part onto the part on the schematic page that is to receive the copied properties.
To copy properties from one part to a group of parts

1. Open the schematic design that contains the part properties you want to copy.

2. From the project manager’s Tools menu, point to Part Manager and choose Open. CIS displays the part manager, showing all parts in the design, sorted by part reference.

3. In the part manager, select the part with the properties you want to copy.

4. From the Edit menu, choose Copy.

5. Select the destination parts by holding down the Ctrl key while you select individual parts to add to the selected group, or by holding down the Shift key and selecting a contiguous group of parts.

6. From the Edit menu, choose Paste. CIS copies the properties from the first part to all the selected destination parts.

Exporting Variant List to PCB Editor using Part Manager

In Allegro PCB Editor, you cannot view the assembly drawings for the variants of a design created in Capture CIS. The information about the variants, the part changes for the variants of the design, can be exported to the variants.lst file. Allegro PCB Editor can use this file to import information about the variants. As a result, the variants.lst file serves as a mechanism for passing variant information to Allegro PCB Editor.

Once you are done with creating variants for a design, you can create the variants.lst file in CIS. You can create this file using the Export
Variants List dialog box. The variants.lst file can then be imported in the board in PCB Editor.

To create the variants.lst file, CIS needs two inputs:

1. Information about the variants of the design. This is obtained from the CIS database.

2. Information about the mappings between properties in Capture and those in Allegro PCB Editor. This is given by you in the variant.cfg file.

The Variant.cfg File

The mappings between CIS property names and Allegro PCB Editor injected property names are specified in the variant.cfg file. A sample variant.cfg file is located in the same folder as the Capture.exe file. The variant.cfg file contains entries of the following types:

_ <CIS property name> = YES

This means that <CIS property name> has significance in Allegro PCB Editor. It needs to be written into the variants.lst file. A space in the property name is replaced by an underscore. For example, Part Number = YES is written as Part_Number in the variants.lst file.

_ <CIS property name> = NO

This means that <CIS property name> does not have any significance in Allegro PCB Editor. It does not have to be written into the variants.lst file.

_ <CIS property name> = <PCB Editor Property Name>

This means that the equivalent of <CIS property name> in Allegro PCB Editor is <PCB Editor Property Name>. So, the entry in the variants.lst file is made as <PCB Editor Property Name>. For example, PCB Footprint = JEDEC_TYPE is written as JEDEC_TYPE in the variants.lst file.

To create the Variants.lst File

1. From the Tools menu of Part Manager, choose Export Variant List. The Export Variants List dialog box appears.
2. The *Output File (Variants.lst) Path* field specifies the default location for the Variants.lst file.

   The default location is the Allegro folder in the design directory. You can change this path.

3. The *Config File (Variant.cfg) Path* field specifies the default path for the Variant.cfg file.

   The default path is the same as that of the Capture.exe file. You can change this path also.

4. Click *Export*.

   CIS creates a Variants.lst file containing information about all the variants of the design.

   The properties listed are the ones specified in the Variant.cfg file.
Defining and Using Groups and Subgroups

In CIS, you can organize components with various properties into groups and subgroups used to create bill of materials (BOM) variants. In the part manager window, you can sort components into groups and subgroups to create bill of materials (BOM) variants for a core design. These groups and subgroups, which are collections of parts used together, provide greater convenience for assembling bills of materials for design variants.

This chapter covers the following:

- Using the part manager window tree view on page 115
- The tree view structure on page 115
- The Part Manager Window on page 119

Using the part manager window tree view

The part manager's tree view provides a graphical interface for easily creating groups, subgroups, and BOM variants. Within the tree view, you can link a database part or update a part's status. You can link and view a part or update its status from within a group, but you cannot update a database part from within a BOM variant folder.

The tree view structure

At the top level of the tree view, there is the root folder that displays the path to the core design. When selected, the right side pane displays all of the components in the core design. Any modifications made to components at this level results in a change in the core design.

Under the tree view, there is a folder called Groups. You create all your groups and subgroups under this folder. The Groups folder
contains all the groups that have been created on the current design. When the Groups folder is selected, the right side pane displays all groups that are available.

### The folders

Under the root folder, there are Groups, subgroups, and the BOM Variants folders.

### Groups

In a design, multiple components are used to support a particular functionality or module. For example, power module, memory, or resolution. Whenever the module needs to be changed, all the individual components of that module also change. Groups make variant creation easier and closer to the way it is done in real life. Groups are subsets of components that can be used when creating variants.

### Subgroups

Groups can be further divided into subgroups. A subgroup contains components that are required for different versions of the groups. For example, if you have a group called Power, the components in that group may differ depending on whether you wish that module to be used in the UK or the US. You cannot drag components to a subgroup. Instead, you must drag the components into the group, which will then populate all subgroups.
The Common folder

The Groups folder also contains a folder called Common. This folder stands out in the tree view structure because of its green color. Also, it is always the first folder under the Groups folder. Initially, the Common folder contains all of the components in a design. As components are placed into groups or subgroups, they are removed from the Common folder.

From the Common folder under the Groups folder, you can use three commands: View Database Part, Update Selected Part Status, and Update All Part Status. The View Database Part and Update Selected Part Status commands are only available when a component is selected in the right side pane. The Update All Part Status command is always available.

You can drag the Common folder into the BOM Variant folders. These folders will contain the same content as the Common folder under Groups.

The BOM Variants folder

You can modify components to use with BOM variants, and store the variations in folders in the part manager tree view. Under the BOM Variants folder, you create design variants from the groups and subgroups that you created. The BOM Variants folder contains all the BOM variants that you create on the current design. When the BOM Variants folder is selected, the right side pane displays all BOM variants that you have created.

You can create a new BOM variant by selecting the New BOM Variant command from the Edit menu keeping the BOM Variants folder selected. This command displays a dialog box, which prompts you to enter a name for the new BOM variant. A folder is added to the tree with the name that you specify. By default, the new BOM variant contains all of the components in the core design.

You can populate a BOM Variant with components by dragging them from the folders under the Groups folder. The Common folder is dragged in with the same name. If you drag a group, the folder remains the same. If you drag a subgroup, the name of the group is added as prefix to the subgroup name (groupName_subgroupName). You cannot update a component from
the BOM variant, although the variant mark column will always be displayed from this level.

The commands

From the root folder, you can use the Link Database Part command, the View Database Part command, the Update Selected Part Status command, and the Update All Part Status command. These commands are available only when a component is selected in the right side pane. The Update Part Status command is always available and is performed on the core design.

**Link Database Part command**

Link Database Part is available when a component is selected in the right side pane in the root folder or in any of the groups or subgroups. If you use the Link Database Part command from the root folder, the core design is updated. As a result, the components on the schematic page are replaced by the components that you choose from the database. Similarly, if the command is used from a group or a subgroup, the component will be updated in all occurrences of that group or subgroup. For example, If you link a part in the Power US subgroup which has also been dragged into the BOM Variants folder called US, the change will also be reflected in the BOM variant. Further, if the Link operation is performed from a group or a subgroup and the new component has a footprint different from the part in the core design, you will get a warning message stating that the footprint differs from the core design.

The Link Database Part command is available when a single component or multiple components have been selected. Each selected component is linked to the new part selected in the database. The Link Database Part command invokes the CIS Explorer window. The CIS Explorer will by default query for parts in the database that have the same value. See “Linking a placed part to a database part” on page 101 for information on how to use the Link Database Part command.

**View Database Part command**

When you choose the View Database Part command, the CIS Explorer window is invoked and the selected part is displayed. The
View Database Part command is available only if one component is selected in the list view. The CIS Explorer will, by default, query for parts in the database that have the same Part Number. If the selected part does not exist in the database, a blank CIS Explorer window is displayed.

**Update Selected Part Status command**

The Update Selected Part Status command is used to ensure that the selected part in the design exists in the part database. Furthermore, it resolves any differences between part property values and their corresponding database property values.

**Update All Part Status command**

The Update All Part Status command is used to ensure that all the parts in your design exist in the part database and resolve any differences between part property values and their corresponding database part property values. This command works exactly like the Update Selected Part Status command, difference being this command works on all the parts in the design.

**The Part Manager Window**

The part manager contains two separate panes: a tree view on the left, and a list view on the right. You can adjust the work environment for the part manager by:

- Displaying the part manager toolbar
- Showing or hiding the tree view

Use the part manager tree view to perform the following tasks on various folders:

- Expanding or collapsing the folder hierarchy in the tree view
- Creating BOM variants for your core design
- Adding folders to create new groups, subgroups, and BOM variants
- Populating groups and subgroups with components
Defining and Using Groups and Subgroups

- Copying groups, subgroups, and BOM variants to quickly create new variants
- Renaming groups, subgroups, and BOM variants
- Deleting groups, subgroups, and BOM variants
- Changing groups of components from the schematic page editor

Displaying the part manager toolbar

The part manager toolbar offers a quick and easy way to perform common tasks, such as linking database parts, updating part status, expanding or collapsing the tree structure, etc. A gray tool button indicates that you cannot perform that task in the current situation.

To display the toolbar

1. From part manager’s View menu, choose Toolbar.
2. To hide the toolbar, do one of the following:
   - If the toolbar is floating (not docked), click the hide button in the top corner of the toolbar.
   - From part manager’s View menu, choose Toolbar.
3. Move or dock the toolbar as desired.
4. To display the name of a toolbar button command, point at the button briefly.

Showing or hiding the tree view

You can choose to display or hide the tree view.

To show or hide the tree view

† From the View menu in Part Manager, select the Show/Hide Tree View command.
Expanding or collapsing the folder hierarchy in the tree view

You can also expand or collapse an entire branch of folders in the tree view hierarchy, removing the need to expand or collapse each subfolder individually.

To expand or collapse the folder hierarchy in the tree view

From the View menu in Part Manager, select the Show/Hide Tree View command

This command toggles between expanded and collapsed display of folders in the part manager tree view.

Creating BOM variants for your core design

BOM variants are the versions of the design that are eventually manufactured. A BOM variant folder contains groups, subgroups, and common components for a particular design variant.

You create BOM variants in the BOM Variants folder in the tree view from groups and subgroups that you have defined. When you create a new BOM variant using the New BOM Variant command, the folder appears to contain all parts in the core design. However, all parts are undefined, indicated by a yellow question mark. Components become defined as you drag them in from the Groups folder. You click and drag the Common folder from the Groups folder to the design variant folder to define remaining components.

When you drag a group or subgroup folder into the BOM variant folder to populate it, the part status of each component in that group or subgroup changes in the BOM variant from a yellow question mark to whatever the part status is in the original group or subgroup.

You can create a new BOM variant using the following two methods:

- New BOM Variant command.
- Copy command (copy a BOM variant). Use this command to create a BOM variant that is similar to an existing BOM variant. When you copy the information contained in a BOM variant, the new BOM variant contains all the BOM variant groups,
subgroups, and component information contained in the source BOM variant.

![Part Manager - DEMO DESIGN.DSN:1](image)

**To create a BOM variant**

1. In the part manager tree view, select the BOM Variants folder.

2. From the Edit menu, choose New. The New BOM Variant dialog box appears. *Or* right-click on the BOM Variants folder and choose New BOM Variant from the pop-up menu.

3. Type the new BOM variant name in the text box and click OK. The new BOM variant folder appears in the list view and the tree view of the part manager window.

**Adding folders to create new groups, subgroups, and BOM variants**

In the part manager window, you can sort components into groups and subgroups to create bill of materials (BOM) variants for a core design. These groups and subgroups provide greater convenience for assembling bills of materials for design variants.
Creating groups and subgroups

You create groups and subgroups in the Groups folder to make building BOM variants easier. A newly created group is empty and does not contain any components or subgroups. A group can have any number of subgroups. Each subgroup within a group contains the same set of components as the parent group, although the components may have different component properties in each subgroup.

When you create a subgroup in a group that already contains components, all of the components move to the subgroup. When you create a subgroup in a group that contains another subgroup, the new subgroup contains the same components as the existing group.

The part manager's tree view provides a graphical interface for easily creating groups, subgroups, and BOM variants. Within the tree view, you can link a database part or update a part's status.

**Note**: You can link and view a part or update its status from within a group, but you cannot update a database part from within a BOM variant folder.

**To create a group**

1. In the part manager's tree view, select the Groups folder.

2. From the Edit menu, choose New Group *Or* right-click and choose New Group from the pop-up menu. The New Group dialog box appears.

3. Type the new group name in the text box.

   **Caution**

   *Do not use the reserved words “groups”, “common”, or “BOM variant”.*

4. Click OK. The new group folder appears in the tree view of the part manager window.
To create a subgroup

1. Select the group folder that you want to contain the new subgroup.

2. From the Edit menu, choose New Subgroup. The New Subgroup dialog box appears.

3. Type the new subgroup name in the text box and click OK. The new subgroup folder appears in the list view of the part manager window.

To create a subgroup in a group that is part of a BOM variant

1. Remove the group from the BOM variant.

2. Follow the procedure above to create the new subgroup.

3. Add the subgroup back to the BOM variant.

Populating groups and subgroups with components

After establishing groups and subgroups, you can begin to populate them with design components. A group can contain components or subgroups, but not both. When you create one or more subgroups, the components that were in the group folder move into each of its subgroup folders.

You can populate a group with components using the following two methods:

- Select components in the list view while you drag and drop them into a group folder.

**Important**

You cannot add components directly into a subgroup.

- Copy a group or subgroup folder to create a new group or subgroup with components from the source group. When you copy a component, you copy its part status and properties.
Important

Whenever you change information in a group that is participating in a BOM variant, the BOM variant is affected. For example, if you remove any component from a group participating in a BOM variant, the component is also removed from all BOM variants containing that group.

To populate groups and subgroups

1. In the part manager tree view, select the group folder that contains the component or components you want to copy.

2. In the list view, select the component or components you want to copy.

3. From the Edit menu, choose Copy Or right-click and choose Copy from the pop-up menu.

4. Select the target folder in the tree view.

5. From the Edit menu, choose Paste Or right-click on the target folder and choose Paste from the pop-up menu.

Or

After selecting the components you want to copy, hold the Ctrl key while you drag and drop the component set into the target folder.

Note: If you select a component from a group or subgroup and drag it to another folder without holding the Ctrl key, the component will be moved, not copied.

Note: Copying a component from one group to another, making the same component exist in more than one group, may cause a design to contain ambiguous parts.

Copying groups, subgroups, and BOM variants to quickly create new variants

Often several groups or subgroups differ by only a few component variations. You can easily create groups and subgroups using the Copy command. The new group contains all the components and
subgroups from the source group. Copying a group or subgroup copies the component variations, like part status and property differences, into the new group or subgroup.

To copy groups and subgroups

1. In the part manager window tree view, select a group or subgroup whose contents you want to copy.

2. From the Edit menu, choose Copy. Or right-click on the selected folder and choose Copy from the pop-up menu. Depending on which folder you are copying, the Copy Group or Copy Subgroup dialog box appears.

3. Type the name of the new group or subgroup in the text box and click OK. The new folder appears in the tree view of the part manager at the same hierarchical level as the source.

Renaming groups, subgroups, and BOM variants

You can change the name of an existing group or subgroup using the Rename command. When you rename a group or subgroup that was dragged into a BOM variant folder, the folders in that BOM variant folder are also renamed.

To rename groups and subgroups

1. In the part manager tree view, select the group or subgroup you want to rename.

2. From the Edit menu, choose Rename. Or right-click on the selected group or subgroup and choose Rename from the pop-up menu. The Rename Group or Rename Subgroup dialog box appears, depending on whether you have selected a group or subgroup.

3. Type the new group or subgroup name in the text box and click OK.

4. Click Yes to dismiss the confirmation message window and complete the operation. The renamed group or subgroup appears in the part manager tree view. If the group is
participating in any BOM variants, the name of the group or subgroup within the BOM variant automatically changes.

Deleting groups, subgroups, and BOM variants

When you delete a group, its subgroups are also deleted. If the folder has been dragged into a BOM variant folder, the folder and its contents are no longer part of the BOM variant.

When you delete a group or subgroup, any of its components that do not still belong to another group move to the Common folder. If you delete all of the subgroups in a group, the components stay in the group folder.

To delete groups, subgroups, and BOM variants

1. In the part manager window tree view, look in the Groups folder and select the group or subgroup you want to delete.

2. From the Edit menu, choose Delete Or right-click on the selected group or subgroup and choose Delete from the pop-up menu.

   Or

   Press the Delete key.

3. Click Yes to dismiss the confirmation message window and complete the operation.

Removing components from groups and subgroups

Removing a component or components from a group or subgroup that is used in a bill of materials (BOM) variant changes the component's properties and status in the BOM variant to the same as those of the component in the core design. When you remove a part from a group or subgroup, it moves into the common folder unless it is still in use by another group or subgroup.

To remove components from groups and subgroups

1. In the part manager tree view, find the group or subgroup that contains the part or parts you want to remove.
2. Click the group or subgroup folder to show the parts in the list view and select the part or parts you want to remove.

3. Select the part or parts you want to remove from the group or subgroup.

4. From the Edit menu, choose Remove. Or right-click on the selected component or components and choose Remove from the pop-up menu.

5. Click OK in the message box to remove the part or parts from the group or subgroup.

Note: Removing a component from a subgroup removes it from all subgroups in the parent group.

Changing groups of components from the schematic page editor

Once you have defined design variant groups and subgroups in the part manager, you can add or remove components from groups while you are working in the schematic page editor. When you add a part to any group that contains subgroups, all subgroups are populated with the part. Similarly, when you remove a part from a group, it is also removed from all of the group’s subgroups.

You can add components to existing groups or subgroups, or remove components from existing groups or subgroups without switching the view from the schematic page editor to the part manager window.

Adding parts to groups from the schematic page

After you have defined design variant groups in the part manager, you can add components to groups while you are working in the schematic page editor. When you remove a part from any group that contains subgroups, the part is removed from the subgroups.

To add parts to groups from the schematic page

1. In the schematic page editor window, select the component or components you want to add to the group.
2. From the Edit menu, choose Add Part(s) To Group. Or right-click on the selected component and choose Add Part(s) To Group from the pop-up menu. The Add Part(s) dialog box appears.

3. Select the group or groups to which you want to add the components and click the Add button.

4. Click OK to dismiss the confirmation message window.

Removing parts from groups from the schematic page

Once you have defined design variant groups in the part manager, you can remove components from groups while you are working in the schematic page editor. When you remove a part from any group that contains subgroups, the part is removed from the subgroups.

To remove parts to groups from the schematic page

1. From the schematic page editor window, select the component you want to remove from the group.

2. From the Edit menu, choose Remove Part(s) From Group. Or click the right mouse button and choose Remove Part(s) From Group from the pop-up menu. The Remove Part(s) dialog box appears.

3. Select the group from which you want to remove the components and click the Remove button.

4. Click OK to dismiss the confirmation message window.
Finalizing and documenting designs

This chapter describes the various procedures you use when working with the OrCAD Component Information System (CIS), including the following:

- “Viewing and updating part status” on page 131
- “Creating bill of materials variants” on page 137
- “Viewing design variants on a schematic page” on page 145
- “Creating reports” on page 152

Viewing and updating part status

Use the CIS part manager to view and update the database status of placed parts in your design.

Note: You should always update part status prior to creating a report. By making sure that all part status indicators are green before creating your bill of materials and netlist, you ensure that your report is complete.

Note: If you have defined part reference prefixes in the Allowed Part Reference Prefix text box and you link a placed part in your design to a database part with the Preserve Reference Designator check box checked in the CIS Extended Linking dialog box, the reference designator of the placed part is retained and all the transferable properties of the database part are transferred to the placed part. Now, when you update the part status from the part manager (using Update All Part Status command), the part status column displays: Approved: Part not found. This is because CIS is unable to find the part (with matching part reference prefix and properties) in the database table. You may avoid this situation by changing the reference designator of the placed part to the one you defined in the
Allowed Part Reference Prefix text box or delete the part reference prefix from the Allowed Part Reference Prefix text box.

You can also set up how CIS sorts and displays the information in the part manager. For more information, see “Using the part manager window” on page 74.

Opening the part manager

When you open the part manager, CIS generates a report describing the status of your design’s placed parts the last time they were checked against the database parts. If you have changed part properties on any placed parts or placed any non-database parts since the last time you updated part status, the report generated when you open the part manager will not reflect the current status of your design with respect to the database.

To open the part manager

1. Open a new or existing schematic design.

2. From the project manager’s Tools menu, point to Part Manager and choose Open. CIS displays the part manager, showing all parts in the design, sorted by part status.

Note: If no configuration (.DBC) file has been specified for use with the part manager, no information will be displayed in these columns when you open the part manager for the first time. For information on setting up a part database and configuration file, see “Setting up OrCAD Capture CIS” on page 25.
Updating the part status for your design

You can update the part status for your design using the part manager. When you update your part status in the part manager, CIS checks all the placed parts in your design against the part database, and updates part properties where necessary.

Any properties that you have assigned to part instances are retained when you update part status for your design, even if they differ from the values in the database.

For example, assume that an AND gate part in your database has a Part Number value of 456. Suppose that you assign a Part Number value of 123 to an instance of an AND gate in your design. That Part Number value applies only to that particular instance of the AND gate. When you update part status, CIS assigns the Part Number value 456 to all instances of the AND gate except that instance, which retains the value 123.

**Note:** You can also view an individual part's local and Internet database properties. For instructions, see “Viewing a placed part’s database properties” on page 110.

**To update part status for your design**

1. Open a new or existing schematic design.

2. Update the part status for specific parts or for your entire design.

   To update the part status for specific parts, select the parts in the project manager window and from the part manager’s Tools menu, choose Update Selected Part Status

   To update the part status for your entire design, do one of the following:

   - From the project manager’s Tools menu, point to Part Manager and choose Update.
   - From the part manager’s Tools menu, choose Update Part Status.

   CIS checks each placed part against the database part to which it is linked. The part database is searched for the Part Number property that matches the placed part, then transferred properties that are configured to be updated are compared.
If you want to make sure that none of your parts have been modified since they were placed from their original libraries, from the Options menu in part manager, point to Update Part Status and choose Verify Parts Against Libraries (.OLB). Then, when you update part status, any placed part with a different timestamp than its library part will be flagged yellow.

**Note:** If you turn on the Verify Parts Against Libraries (.OLB) option when you have placed parts in the design using a previous version of CIS (Release 9.0 or earlier), all parts placed from the previous Capture libraries will have mismatched timestamps and be flagged yellow. If you get an undesirable result, turn off the Verify Parts Against Libraries (.OLB) option and update part status again.

For each placed part that is not current, you are prompted with the Update Part dialog box. This dialog box lets you decide whether or not you want to update the placed part properties with the transferred properties from the database part.

The first row lists the database part and its properties, and the second row lists the placed part and its properties. The differences between the database part and placed part are highlighted in red.

3. Click one of the following buttons:

<table>
<thead>
<tr>
<th>Click this button...</th>
<th>To do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>Update the placed part.</td>
</tr>
<tr>
<td>Yes All</td>
<td>Update all placed parts whose properties don’t match the database part properties.</td>
</tr>
</tbody>
</table>
Click this button...  To do this...

No      Not update the placed part.
No all   Not update any of the placed parts whose properties don’t match the database part properties.

Note: In some cases, CIS cannot automatically determine the correct database part with which to refresh the placed part. In these cases, you must wait until the update is complete and link the placed part to a database part. (See “Linking a placed part to a database part” on page 101.

Note: If you get the error message: "Schematic Parts "X" and "X" are not the same" while updating the part status, then make sure that you compare the source library entry in the Source Library column of the Property Editor with the source library of the database that is being referenced by the Schematic Part column of the CIS database.

When complete, a list of updated parts and discrepancies with the database is written to the session log. Then, the part manager window displays the updated part status. The Part Status column contains both text and color-coded icons that indicate whether your placed part is linked to a part in a part database. The following table lists all the possible status conditions and what the each status condition means.

<table>
<thead>
<tr>
<th>This status...</th>
<th>Means the part...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green icon</td>
<td>Is approved and current</td>
</tr>
<tr>
<td>Yellow icon</td>
<td>Is in the approval process</td>
</tr>
<tr>
<td>Red icon</td>
<td>Would be incorrect if you generated a BOM</td>
</tr>
<tr>
<td>Approved</td>
<td>Has a defined part number property type</td>
</tr>
<tr>
<td>Temporary</td>
<td>Has a temporary part number</td>
</tr>
<tr>
<td>Undefined</td>
<td>Has no part number property</td>
</tr>
<tr>
<td>Current</td>
<td>Has transferable properties matching those of the database part</td>
</tr>
<tr>
<td>Defined</td>
<td>Has a part number property</td>
</tr>
</tbody>
</table>
If your configuration specifies that CIS assign temporary part numbers automatically, each status is preceded by either Temporary Part (if the placed part number prefix is the temporary part number prefix) or Approved Part.

When the status of all the parts in your design is Current, you are ready to generate a report such as a bill of materials.

Once you have updated part status, the part manager also includes tips for parts with a red icon status. The tips give more detail about the part's status and about placed part properties that do not match the database part properties. To display a tip, point briefly over the status column.

**Note:** The part status is based only on the part properties you have specified to be transferred from the part database. Other properties that may reside in the part are not checked.

### To remove variant properties from a linked component

1. In the part manager tree view, select the group or subgroup folder that contains the part you want to change.

2. In the part manager list view, select the component from which you want to remove linked properties.

3. From the part manager window's Edit menu, choose Revert to Common. The check mark no longer appears next to the component, indicating that the linked properties have been removed.
Saving the status report

You can save the contents of the part manager window to a text (.PRP) file. The report file is saved (in the current sort order) in tab-delimited format which can be edited with a spreadsheet program or word processor.

To save a status report

1. Choose one of the following options:

To do this... | Select this option...
---|---
Save the report file using the name of your design file. | From the File menu, select Save. Example: If your design’s filename is MYDESIGN.DSN, CIS automatically names your report MYDESIGN.PR when you choose the Save command.

Save the report file using the name of your choice | From the File menu, select Save As.

Creating bill of materials variants

Design variants are different assembly configurations of your basic or core design.

Examples of product variation requirements include:

- Use in geographical regions with different performance requirements for component attributes such as power level, emissions standards, etc.
- Minor differences between product models such as the number and type of resistors.

When manufacturing design variants, the fabricated board will match the core design while the variants define how the board should be populated with parts. You can create and maintain all of your design variants within a single Capture project.
Because your design variations are captured within a single project, you can view variant information on a schematic page, preview and print variant schematic sheets, and create variant bills of materials without having to maintain separate designs. Design variations include different property values for common components and different or not present components for identical footprints.

You can use BOM variants to generate bill of materials reports and variant reports. For information on generating these reports, see “Creating reports” on page 152.

Creating a new BOM variant

The BOM Variants folder in the tree view is where you create BOM variants and define them using groups and subgroups that you have created.

When you create a new BOM variant, the folder appears to contain all parts in the core design, but they are all undefined, indicated by a yellow question mark. Components become defined as you drag in the Common folder and groups and subgroups from the Groups folder. For more information, see “To populate a BOM variant” on page 140.

You can create a new BOM variant using these methods:

- Use the New BOM Variant command.
- Copy a BOM variant.

To create a BOM variant using the New BOM Variant command

1. In the part manager tree view, select the BOM Variants folder.

2. From the Edit menu, choose New. The New BOM Variant dialog box appears.

Tip

The New BOM Variant command is available from the pop-up menu when you right-click on the BOM Variants folder.
3. Type the new BOM variant name in the text box and click OK. The new BOM variant folder appears in the list view and the tree view of the part manager window.

You can easily create a BOM variant that is similar to an existing BOM variant using the Copy command. When you copy the information contained in a BOM variant, the new BOM variant contains all the BOM variant groups, subgroups, and component information contained in the source BOM variant.

**To copy a BOM variant**

1. From the part manager tree view, select the BOM variant group you want to copy.

2. From the Edit menu, choose Copy. The Copy BOM Variant dialog box appears.

3. Type the name of the new BOM variant in the text box and click OK. The copied folder appears in the BOM Variants folder at the same hierarchical level as the source folder.

**Tip**

The Copy, Rename, and Delete commands are available from the pop-up menu when you right-click on a BOM variant.

**Populating BOM variants**

Before you can populate a BOM variant, you must establish groups as described in “Creating groups and subgroups” on page 123. The groups and subgroups of components that you create in the Groups folder are used to populate BOM variants.

Before you drag the Common folder and group folders into the BOM variant folder, the variant mark column contains a yellow question mark (?) next to each part. A yellow question mark indicates that the components have not yet been defined for use in the BOM variant. If you were to create a BOM variant report without defining the components, the report would be invalid.
When you drag a group or subgroup folder into the BOM variant folder to populate it, the yellow question mark disappears. The part status of each component in that folder is updated to the same as the status of the part in the original group or subgroup.

**To populate a BOM variant**

1. In the part manager window tree view, select the group folders or subgroup folders containing parts you want to include in your BOM variant.

2. Drag and drop the selected groups or subgroups into the BOM variant you have created.

3. In the part manager tree view, select and drag the Common folder into the BOM variant folder you have created.

Capture CIS maintains the name of the Common folder and the group folders that are dragged into a BOM variant. Subfolders are renamed as a combination of the group name and the subgroup name.

For example, if the subgroup Assembly #1 is dragged and dropped from the group Coupling to the BOM variant folder Variation #1, the name of the new BOM variant group is Coupling_Assembly #1.

**Note:** The View Database Part command is available when you select a BOM variant component in the part manager list view.

**Note:** To use the Link Database Part command, you must have selected a component from the root folder or a group or subgroup. If you link a database part from a group or subgroup, the change is reflected in the BOM variant.

**Modifying BOM variants**

You can rename or delete BOM variants from within the BOM variant. You can also indicate that a part or parts in a group or subgroup are to be used or not used in a BOM variant. Setting parts as present or not present in a design is done at the group or subgroup level, and cannot be done from within the BOM variant itself.
Before you create any reports using BOM variants, all part ambiguities must be resolved. For information, see “To resolve ambiguous parts” on page 144.

Renaming a BOM variant

You can change the name of a BOM variant, but not its groups or subgroups. Renaming a BOM variant will not change any of its groups or subgroups.

To rename a BOM variant

1. In the part manager tree view, select the BOM variant folder you want to rename.
2. From the Edit menu, choose Rename. The Rename dialog box appears.
3. Type the new name of the BOM variant in the text box and click OK. The renamed BOM variant appears in the part manager window.

Deleting BOM variants

When you delete a BOM variant, its subgroups are also deleted. The groups and subgroups in the Groups folder are not affected when you delete a BOM variant.

To delete a BOM variant

1. In the part manager tree view, select the BOM variant you want to delete.
2. From the Edit menu, choose Delete. A confirmation window appears.
3. Click Yes to continue and delete the selected BOM variant.
   or
   Click No to abort the delete operation.
Note: You can also delete a BOM variant by selecting the BOM Variant folder and pressing the Delete key.

Setting parts as present or not present in a design

If a BOM variant group contains a part or parts that should not be installed in the design variant, you can set the part as not present to indicate that it is no longer included, although it is still part of the design.

Conversely, if you want to include a part or parts in the design variant and that have been set to not present, you can use the Set Part As Present command to include them again.

To set a part as not present

1. In the part manager tree view, look in the Groups folder and select the group or subgroup that contains the part or parts you want to exclude from the BOM variant.

2. In the part manager list view, select the part or parts you want to set as not present.

3. From the Edit menu, choose Set Part As Not Present. This command is also available when you right-click on a part or parts that you want to set as not present.
A red X appears in the variant status column next to each part you have set as not present.

To set a part as present

1. In the part manager tree view, look in the Groups folder and select the group or subgroup that contains the part or parts you want to include in the design variant.

2. In the part manager list view, select the part or parts you want to set as present. Parts that are not present are indicated with a red X.

3. From the Edit menu, choose Set Part As Present. This command is also available when you right-click on the part or parts you want to reset.

The red X disappears from the part status column, indicating that the part is present in the design variant.
If you had already updated the component by linking it, the linked value returns when you set the part as present.

**Resolving part ambiguity**

Part ambiguity occurs when two parts with the same part reference but different statuses, such as present and not present, are used in the same BOM variant. Because groups and subgroups may contain the same components, you may have dragged two different groups with the same part into a BOM variant folder. This creates ambiguity as to which part’s properties are used in the BOM variant. You may choose the one that is set as not present.

Part ambiguities must be resolved before you create a bill of materials report. A blue question mark in the Part Status column of the part manager window indicates part ambiguity.

**To resolve ambiguous parts**

1. Select the BOM variant folder that contains the part ambiguity.

2. From the Edit menu, choose Resolve Ambiguity. The Resolve Ambiguity dialog box appears.

   **Tip**
   
   You can also resolve a part ambiguity using the Resolve Ambiguity button ( ).

3. View the properties of each part occurrence listed in the Resolve Ambiguity dialog box. The property or properties that differ are highlighted.

4. Select one of the occurrences and click OK. The part status of the selected occurrence updates, and a green question mark appears next to all other occurrences of the part in the status column of the part manager window. The green question mark indicates that the parts are not used in the BOM variant, and that the part ambiguity has been resolved.

**Note:** If the same component is part of multiple groups and subgroups that are part of the same BOM variant but the properties of these components are identical, no ambiguity exists.
Viewing design variants on a schematic page

OrCAD Capture CIS allows you to view variant information for all the design variants defined in your project. The variant information includes different property values for common components or different or not present components for identical footprints on a schematic page. You can use the Variant View Mode command to display the variant information on a schematic page. You can also search for a specific design variant component on a schematic page. For more information, see “Searching for variant information on a schematic page” on page 147.

Note: The Variant View Mode command is available for selection only when a design variant is created in your project's part manager. For information on how to create a design variant, see “Creating bill of materials variants” on page 137.

To view design variants on a schematic page

1. From the schematic page editor or the project manager, select the View menu and choose the Variant View Mode command.

   The Select a Design Variant dialog box appears.

   ![Select a Design Variant dialog box]

   Note: You can also access the Select a Design Variant dialog box using the SHIFT+M shortcut key.
2. Select the design variant for which you want to display the variant information from the Core Design and Variants list and click OK. For example, Variant 1.

**Note:** You can select only one design variant at a time from the Core Design and Variants list.

A message box appears asking you whether you want to save your core design at this stage. This message box appears only when the core design has changed from last time.

3. Click OK in the message box.

The core design is saved and the currently open core design schematic page(s) in the project changes to the design variant schematic page you selected in step 2. The title bar of the design variant schematic page displays the name of the selected design variant. In this case, **Variant 1**.

The design variant schematic page; Variant 1 displays the components that are not present in the design or the common components having alternate properties in a different color than the other core design components. This helps you to identify the variants from the core design components. For information on customizing the display of variant information on a schematic page, see “Customizing variant information display on a schematic page” on page 149.

**Note:** From the design variant schematic page, you can view the properties for a part, but cannot edit it.

**Note:** The automatic backup and save functionality for the project is not available when the design variant schematic page is open.

**Note:** You can switch to another design variant schematic page from your current variant schematic page using the Variant View Mode command.
Note: The Accessories menu is not available for selection, when the design variant schematic page is open.

Note: From design variant schematic page, you cannot open the part manager. To do this, you must switch to the core design.

To switch back to core design schematic page

1. From the design variant schematic page, select the View menu and choose the Variant View Mode command. The Select a Design Variant dialog box appears.

2. Select <Core Design> from the list.

3. The design variant schematic page(s) revert back to core design schematic page.

Note: You can also use the F6 Function key to switch to core design schematic page from your current design variant schematic page.

Searching for variant information on a schematic page

You can use the Find or the Browse command to search for variant parts that are not present in a design or parts having different property values for common components on a design variant schematic page.
To search using the Find command

1. From the design variant schematic page or project manager, select the Edit menu and choose the Find command. The Find textbox on the Find toolbar is selected.

2. Enter the property value string for the variant part you seek. You can use wildcard characters (standard "*" or "?") with a truncated search. For example, to search for resistors, enter "R*" in the Find what text box.

3. Verify that the Match Case check box is set as you want it.

4. Select Variant Parts from the object types in the Scope section of the dialog box.

Note: The Variant Parts option will not be available from the design variant schematic page or the core design, if your project does not have design variants.

5. Click OK to start the search. Parts that have a property value matching the property value string in step 3 are selected on the schematic.

Note: You can have part occurrences in a variant with different properties.
Customizing variant information display on a schematic page

You can customize how you want to display the design variant information on a design variant schematic page. Thus, making it easier for you to identify a variant part on a design variant schematic page.

You can choose from different color combinations to display the variant information. For example, you can display parts that are not present in a design in a different color than the parts having different properties for the common components.

To customize variant information display

1. From the Capture CIS opening window or project manager, or a schematic page, select Options and then select Preferences. The Preferences dialog box displays.

2. Click the color button adjacent to Variant Part or Part Not Present options. The Variant Part Color or Part Not Present Color dialog box appears.
3. Select the check boxes, if you want variant information to appear when you print or plot the schematic page.

4. Select a color of your choice and click OK. The color you chose is set as the default color. From next time, the variant information will be displayed in the chosen color.

Viewing variant properties

You can use the variant property viewer window to view properties for a specific variant.

Note: The variant property viewer is view-only. You cannot change the variant properties using this window.

To open variant property viewer

1. Switch to the design variant schematic page using the Variant View Mode command.

2. Select some combination of parts, nets, pins, title blocks, or aliases in the design variant schematic page editor and then choose Properties from the Edit menu or choose Edit Properties from the pop-up menu.

   OR

   From the project manager, choose Object Properties from the Edit menu or choose Edit Object Properties from the pop-up menu.

   The variant property viewer window appears displaying the variant information in pink color. For more information on property editor, refer the OrCAD Capture User's Guide.

Viewing variant name in Title Block

When switching from core design to a design variant schematic page, the design variant name will appear in the Title Block of the design variant schematic page only when you have specified the Variant Name property in the property editor window.
To add the Variant Name property

1. From the core design schematic page, select the title block and choose Properties from the Edit menu or choose Edit Properties from the pop-up menu. The property editor window appears displaying the properties defined for the title block object.

2. Click New Column/Row. The Add New Column/Row dialog box appears.

3. Enter the property name as Variant Name (case-sensitive) in the Name text box and click OK. The Variant Name property appears in the property editor window.

Note: The Variant Name property is case-sensitive.

4. Select the Variant Name property in the property editor window and click Display in the property editor window. The Display Properties dialog box appears.

5. Select the Name and Value option from the Display Format group and click OK in the Display Properties dialog box.

6. Click Apply in the property editor window to save the settings. Now, the next time you switch from the core design to a design variant schematic page, the Title Block of the design variant schematic page will display the design variant name.

Previewing or printing design variant schematic pages

You can use the Print Preview command to verify whether the variant information appearing on a design variant schematic page is what you want before you commit it to paper. Use the Print command (CTRL+P) to print the design variant schematic page. For more information on how to use the Print and Print Preview commands, refer the OrCAD Capture User's Guide.

To preview print output of the design variant schematic page

1. From the design variant schematic page or project manager, select the File menu and choose the Print Preview command. The Print Preview dialog box appears.
2. Specify the preview settings as per your requirement. For description of the Print Preview dialog box options, see the OrCAD Capture User's Guide.

3. Click OK. The currently active design variant schematic page is previewed.

**Tip**

You can print the variant information on a design variant schematic page only when the Variant Parts and Parts Not Present check boxes are selected in the Colors/Print tab on the Preferences dialog box.

To print a design variant schematic page

1. From the design variant schematic page or project manager, select the File menu and choose the Print command. The Print dialog box appears.

2. Specify the print settings as per your requirement. For description of the Print dialog box options, see the OrCAD Capture User's Guide.

3. Click OK. The currently active design variant schematic page is printed.

Creating reports

A report contains relevant information about the parts in your design. You can customize the report to include both database and placed part properties.

**Caution**

*Part ambiguities must be resolved before you create a bill of materials report.*

**Note:** If you want mechanical (non-electrical) parts to be included in CIS reports, you must place these parts on the root schematic of the design or on a schematic that is referenced by a hierarchical block on the root schematic. For information about root schematics and
hierarchical blocks, see the OrCAD Capture User's Guide or Capture online help.

CIS supports the following two types of reports:

■ Standard bills of materials that you create completely within CIS. See “Creating a standard CIS bill of materials” below.

■ Advanced reports that you generate from within CIS using templates created in Crystal Reports. See “Creating a report using a Crystal Reports template” on page 171.

Crystal Reports is a powerful, dynamic and widely-used report design software solution from SAP BusinessObjects. You can use Crystal Reports in conjunction with Capture CIS to make customized report templates with more advanced features than the standard CIS bill of materials, including precision formatting and formulas that total, filter, and analyze data for highly specific results. You must have Crystal Reports installed on your system with CIS to create Crystal Reports templates beyond what is supplied with Capture CIS. If you do not own a copy of Crystal Reports, visit the SAP BusinessObjects web site for reseller information. If you want to make a Crystal Reports template, see “Creating Crystal Reports templates” on page 69.

■ Variant reports that list differences between the core design and selected BOM variants. See “Creating a BOM variant report” on page 176.

Creating a standard CIS bill of materials

A bill of materials lists all the parts in your design. You can use the standard CIS bill of materials feature to create multiple, named report templates so that you can generate separate bills of materials for the different requirements of engineering, purchasing, and manufacturing. The report can be generated for an entire design or some selected sections of the design.

Also, you can generate BOMs that lists all the mechanical parts (heatsinks, fans, screws, ect.) and assemblies (cables, transformers, jumpers, LED sockets, ect.) associated with an electrical part in a design. For example, a TO-220 package MOSFET would have an associated heatsink and drain screw for mounting. For more
information, see “Including mechanical parts and assemblies in standard CIS BOM” on page 162.

**To create a standard CIS bill of materials**

**Note:** Do not use the Bill of Materials command from the project manager's Tools menu to create your reports. This command does not use your part database information to produce the bill of materials. Only the CIS Bill of Materials commands from the Reports menu uses your part database information.


   ![Image of Standard Bill of Materials dialog box]

   **Note:** You can also access the CIS Bill of Materials commands from the project manager using the BOM button.
2. In the Template Name text box, type in a name for the template, or select one from the drop-down list.

   **Note:** You can create multiple, named templates and define a different format for each. However, since a bill of materials file is, by default, saved using the design name and a .BOM extension, you’ll have to save each report under a unique filename using the part manager’s Save As command (from the File menu).

3. Select a part property you want in the bill of materials and click the Add button. The part property moves to the Output Format list. You can also double-click a property to move it from one side to the other.

   **Tip**
   
   The Select Properties list only includes schematic properties that you have configured to be transferred from the database. If you want to include a schematic property in your bill of materials that is not in your part database, you must type in its exact name and then choose the Add button. If you want to delete an added schematic property from the Select Properties list, select the property and click the Delete User Property button.

   **Note:** The property types that appear in the Select Properties list box include the following:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="#" alt="Default CIS property names" /></td>
<td>Default CIS property names</td>
</tr>
<tr>
<td><img src="#" alt="Properties transferred from placed parts on schematics" /></td>
<td>Properties transferred from placed parts on schematics</td>
</tr>
<tr>
<td><img src="#" alt="Properties transferred from database parts" /></td>
<td>Properties transferred from database parts</td>
</tr>
<tr>
<td><img src="#" alt="Title block property names" /></td>
<td>Title block property names</td>
</tr>
</tbody>
</table>

   **Note:** Title block property information is read from the first schematic page in the design and displayed in the report.
**Note:** You specify the properties that are transferred from the database to your placed parts when you configure CIS.

4. Repeat step Step 3 until all the properties you want in the bill of materials appear in the Output Format list box. The order of the items in the Output Format list box determines the order in which they appear in the report. To change the order of an item, select it and move it using the up or down arrow buttons to the right of the Output Format list box.

5. Select at least one property in the Output Format list box then select the Keyed option. You must do this to specify how CIS matches and groups records in the report. Normally, you should set Part Number to Keyed, so that parts with the same part number will be grouped in the report.

**Note:** Keyed properties that are missing from the placed part or have blank contents are not grouped, but remain as distinct items in the report. This is so that undefined parts display as separate line items.

6. Select the Allow Saving Title Block Properties option if you want to save the title block property information along with the BOM information when you save the BOM report as a .BOM, .CSV, or .FWC file.

7. Select the List Relational Data Fields option to view the all relational fields defined in the relational database.

When you select this option, the relational fields in your database are populated in the Select Properties list.

**Note:** Each relation field in the Select Properties list is fully qualified with the table name and field name as TableName : FieldName. This display prevents any conflict if two relational tables have the same field name.

**Note:** This option is only available if you have configured your CIS parts database as a relational database. For details on how to configure a relation CIS database, see “Setting Relational Database preferences” on page 67.
8. Select one of the Part Reference Options from the following table:

<table>
<thead>
<tr>
<th>To do this...</th>
<th>Select this option...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group parts with matching keyed properties on a single line</td>
<td>Standard</td>
</tr>
<tr>
<td>Put each part on a separate line¹</td>
<td>Standard – Separate Line Per Part</td>
</tr>
<tr>
<td>Allow part ranges (such as R1–R14)</td>
<td>Compressed</td>
</tr>
</tbody>
</table>

¹ Item Number and Quantity are only listed in the first line of each grouping.

9. In the List Separator drop-down list, choose:

- Space, if you want the part references in the report to be separated by spaces.
- Comma, if you want the part references in the report to be separated by commas.

10. In the Exclude Prefixes field, specify part reference prefixes for parts you do not want to include in the report. Typically, you use this to omit parts that are not purchased for manufacture. To exclude more than one prefix, enter the prefixes separated by spaces.
11. Select one of the Relational Data Displayed options from the following table:

<table>
<thead>
<tr>
<th>To do this...</th>
<th>Select this option...</th>
</tr>
</thead>
<tbody>
<tr>
<td>To display the relation data horizontally (in the same row)</td>
<td>Select Horizontal Output option</td>
</tr>
<tr>
<td>To display the relation data vertically (one line item per related data)</td>
<td>Unselect Horizontal Output option</td>
</tr>
<tr>
<td>Maximum number of related child items to output</td>
<td>Max Rows</td>
</tr>
</tbody>
</table>

12. You have the option of creating the report for the entire design or for a selected portion of the design. In the Scope group, select the Process Entire Design option (default selection) to create a report of the entire design.

Alternatively, select certain sub-parts of the design, at page or folder level, and then open the Standard Bill of Materials dialog box. Now in the Scope group if you select the Process Selection option, the report is generated for only the selected sub-parts of the design.

13. If you want to export your report to spreadsheet format and open it automatically in MS Excel, select the Export BOM Report to Excel checkbox.

**Note:** If your design has design variants, you will have the option of selecting the variants whose part information CIS will use to generate the bill of materials. See the CIS online help for more information about creating bills of materials for design variants.

14. If you want your report to include any variant “parts not present”, choose Variant “Not Stuffed” Qty 0 Displayed option. These parts will be displayed in the report with zero quantity.

15. In the Variants list, select one or more BOM variants. If you select more than one BOM variant, the Merge BOM Reports check box is selected by default. If you do not want to merge BOM variants in the report, clear the check box.
16. Click the OK button. CIS automatically adds the template name for the bill of materials you have designed to the Template Name list so that you can use the template again the next time you want to generate a bill of materials.

CIS checks for parts that are grouped (by having the same part number, for example), but that have different properties or packaging or have duplicate part references between instances of the parts.

CIS creates a report of the entire physical design regardless of the schematics and pages selected in the project manager.

If any design errors are encountered during report creation, a dialog box prompts you to view the errors in the session log.

If no design errors are encountered during report creation, the bill of materials report appears in a window.

You can choose a column heading to sort the rows by the values in that column, and choose the same column heading again to reverse the sort order. You can adjust the column widths by dragging the vertical lines between the column heading names to the left or right. If you save the bill of materials, it is saved with the current sort order.

**Note:** If you have included properties in your report that are configured as browsable, CIS will hyperlink (blue underline) the part values for those properties. You can click on the hyperlinks to display the latest version of the source file.
If you add relational fields to your report and choose the Relational Data Displayed option, you can view the relational data either vertically (default) or horizontally.

**Vertical View**

![Vertical View](image)

**Horizontal View**

![Horizontal View](image)

17. To save the report, select one of the save options from the following table:

<table>
<thead>
<tr>
<th>To do this...</th>
<th>Select this option...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save the report into the design folder using the default file name¹. Note that you will overwrite any report previously saved using this default file name.</td>
<td>From the File menu, choose Save.</td>
</tr>
<tr>
<td>Save the report using a new file name into the directory of your choice.</td>
<td>From the File menu, choose Save As.</td>
</tr>
</tbody>
</table>
1. CIS creates the default file name by concatenating the design name and the name of the bill of materials template used to generate the report. For example, if the design is named BENCH.DSN and the template is named ENG BILL OF MATERIALS, the bill of materials file will be named BENCH_ENG BILL OF MATERIALS.BOM by default.

**Note:** You can use a spreadsheet application to sort the exported output by multiple keys.

**Note:** While saving the report, do not use these wild card characters * and ?.

18. Specify a filename, save location, and format type. By default, CIS saves the report in tab-delimited format, but you can choose any of the following formats:

- TAB - Tab Separated Format
- (Excel) CSV - Comma Separated Format
- Access - Compatible with Microsoft Access as well as Crystal Reports.
- Formatted comma delimited file (*.FWC)

Currently in Capture CIS, it is very difficult to find out the quantity of mechanical parts (heatsinks, fans, screws, etc.) and assemblies (cables, transformers, jumpers, LED sockets, etc.) associated with an electrical part in a design. By including this information in your Standard CIS BOM it will help in better costing and an error-free production cycle.

Now, you can use the Standard CIS Bill of Materials dialog box to generate a BOM that lists all the mechanical parts and assemblies associated with an electrical part in your design. However, you have to complete the steps mentioned in the following sections to use this functionality.
Including mechanical parts and assemblies in standard CIS BOM

The following illustration and the table description below explain the use model of this feature:

**Electrical Parts Table**

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Part100</td>
<td>A100</td>
</tr>
<tr>
<td>Part101</td>
<td>A101</td>
</tr>
</tbody>
</table>

**Mechanical Parts Table**

<table>
<thead>
<tr>
<th>Part Number (MechPartID)</th>
<th>Part Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mechpart_1</td>
<td>Mechanical Part</td>
<td>Fan</td>
</tr>
<tr>
<td>Mechpart_2</td>
<td>Mechanical Part</td>
<td>Screws</td>
</tr>
</tbody>
</table>
# OrCAD CIS User Guide

## Finalizing and documenting designs

### Important

In addition to the above columns, the Mechanical Parts table must also contain the Schematic Part and Value columns.

### Mapping Table

<table>
<thead>
<tr>
<th>Part Number (MechPartID)</th>
<th>Part Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assembly_1</td>
<td>Mechanical Assembly</td>
<td>Assembly</td>
</tr>
</tbody>
</table>

### Important

In addition to the above columns, the Mapping table must also contain the Schematic Part and Value columns.

Based on the above table descriptions, Capture CIS will interpret the above table information as follows:

1. The electrical part (Part100), which has the Value of A100 has two mechanical parts with the following MechPartQuantity associated with it:
   - 3 x Mechpart_1 (fan)
   - 1 x Mechpart_2 (screws)

2. The electrical part (Part101), which has the Value of A101 has one assembly associated with it with the following MechPartQuantity:
   - Assembly_1, which in turn has two mechanical parts:
The sections that follow describes this feature in detail.

Before you can start creating BOMs with information about mechanical parts and assemblies, you must:

- Add in your part database (.DBA) description about all the mechanical parts and assemblies used in your design. See “Adding mechanical part and assembly details in your part database” on page 164.
- Create a new table in your part database (.DB) that maps all the electrical parts in your design with their associated mechanical parts and assemblies. See “Mapping electrical parts with their associated mechanical parts and assemblies” on page 165.
- Create a new or modify an existing database configuration file (.DBC) so that CIS works properly with your updated part database. “Setting up the configuration file” on page 166.

Adding mechanical part and assembly details in your part database

First, you need to add information about all the mechanical parts and assemblies used in your design. The information comprises of mechanical part number, part type, and description (see table below). You can store these details either in a separate table or add it to an existing part table. You must ensure that you specify the Part Type for a mechanical part as Mechanical Part and an assembly as Mechanical Assembly.

A sample table containing the mechanical part and assembly details is shown below.

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Part Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CADEMECH1236</td>
<td>Mechanical Part</td>
<td>Fan</td>
</tr>
<tr>
<td>CADEMECH1237</td>
<td>Mechanical Part</td>
<td>Screw</td>
</tr>
<tr>
<td>ASEM1</td>
<td>Mechanical Assembly</td>
<td>Assembly</td>
</tr>
<tr>
<td>ASEM2</td>
<td>Mechanical Assembly</td>
<td>Assembly</td>
</tr>
</tbody>
</table>
Note: In addition to the above columns, the table must also contain the Schematic Part and Value columns.

Note: If you are creating a new table for storing the mechanical part details then you can specify a table name as per your choice.

Mapping electrical parts with their associated mechanical parts and assemblies

After you have added description about all the mechanical parts and assemblies in your design, you must create a new table in your part database (.DB) that maps all the electrical parts in your design with their associated mechanical parts and assemblies. For example, If your design has a TO-220 package MOSFET electrical part, which has a heatsink and drain screws associated with it. Then, in the table, the Part Number of the electrical part (TO-220 MOSFET) will be mapped to the Part Number of the mechanical parts associated with this electrical part along with the mechanical part quantity.

Note: You can specify a table name as per your choice.

The table must have the following property columns in addition to the other required columns like, Schematic Part and Value:

- **Part Number**: is the electrical part number.
- **Part Type**: can be Mechanical Part or Mechanical Assembly.

Note: Make sure that you specify the Part Type for a mechanical part as Mechanical Part and assembly as Mechanical Assembly.

- **MechPartID**: is the mechanical part number.
- **MechPartQuantity**: is the mechanical part and assembly quantity.

You can specify a name of your choice for the property columns, MechPartID and MechPartQuantity.

A sample table showing the mapping between a electrical part and mechanical parts/ assemblies is shown below.

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Part Type</th>
<th>MechPartID</th>
<th>MechPartQuantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>A100J15C0GHVVWA</td>
<td>Mechanical Assembly</td>
<td>ASEMM1</td>
<td>2</td>
</tr>
</tbody>
</table>
In the above table, the electrical part Capacitor (A100J15C0GHVVWA) is mapped to two mechanical parts (CADMECH1234 and CADMECH1236) and an assembly (ASEMM1) using the key property Part Number and MechPartID. The table also contains details about the mechanical parts within the assembly (ASEMM1).

### Setting up the configuration file

You can create a new or modify an existing database configuration file (.DBC) so that CIS works properly with your updated part database. For instructions on how to create a configuration file, see “Creating a configuration file manually” on page 50. However, make sure that you specify the following in the CIS Configuration dialog box:

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Part Type</th>
<th>MechPartID</th>
<th>MechPartQuantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>A100J15C0GHVVWA</td>
<td>Mechanical Part</td>
<td>CADMECH1234</td>
<td>4</td>
</tr>
<tr>
<td>A100J15C0GHVVWA</td>
<td>Mechanical Part</td>
<td>CADMECH1236</td>
<td>2</td>
</tr>
<tr>
<td>ASEMM1</td>
<td>Mechanical Part</td>
<td>CADMECH1236</td>
<td>3</td>
</tr>
<tr>
<td>ASEMM1</td>
<td>Mechanical Part</td>
<td>CADMECH1238</td>
<td>2</td>
</tr>
</tbody>
</table>
Assign an OrCAD property to the newly created property columns, which in this case are, MechPartID and MechPartQuantity (see figure below).

Capture CIS has added support for the following two properties: Mechanical_partno and Mechpart_quantity.

For the MechPartId Table Property Name, select the Mechanical_partno OrCAD property from the OrCAD Property Name drop-down list.

For the MechPartQuantity Table Property Name, select the Mechpart_quantity OrCAD property from the OrCAD Property Name drop-down list.

Configure Capture CIS to use the mapping table that you created. In the CIS Database Configuration dialog box, select
the mapping table from the Select Mapping Table list box as shown in figure below.

After you have set up the configuration file, you can now create standard CIS bill of materials with information about mechanical parts and assemblies associated with the electrical parts.

To create a standard BOM with information about mechanical parts and assemblies

1. From the part manager’s Reports menu, point to CIS Bill of Materials and choose Standard. CIS displays the Standard Bill of Materials dialog box.

2. In the Template Name text box, type in a name for the template, or select one from the drop-down list.

3. Select or type in the following part properties: Mechpart_quantity, Mechanical_partno, and Description and click the Add button. The selected part properties move to the Output Format list (see figure below).
**Note:** You can also double-click a property to move it from one side to the other.

**Note:** The order of the items in the Output Format list box determines the order in which they appear in the report. To change the order of an item, select it and move it using the up or down arrow buttons to the right of the Output Format list box.

4. Select Include Mechanical Part Data check box to enable the corresponding options.

5. Select the *Mechanical parts only* option (see figure below), if you want the BOM to display the quantity all the mechanical parts including the ones that are in assemblies.

Or

Select the *Both Mechanical parts and assemblies* option, if you want the BOM to display only those mechanical parts and assemblies that are available at the root level of your design. In
this case, mechanical parts within the assemblies will not be displayed.

Note: You can also export your report to spreadsheet format and open it automatically in MS Excel, select the Export BOM Report to Excel checkbox.

Note: You can also create BOM variant reports with information about mechanical parts and assemblies in the design variants.

6. Click OK. CIS automatically adds the template name for the bill of materials you have designed to the Template Name list so that you can use the template again the next time you want to generate a bill of materials.

If any design errors are encountered during report creation, a dialog box prompts you to view the errors in the session log.
If no design errors are encountered during report creation, the bill of materials report appears in a window as shown below.

![Bill of Materials Report](image)

### Creating a report using a Crystal Reports template

In addition to the standard CIS bill of materials, the print preview, print, and export functions of the Crystal Reports software have been integrated into CIS to allow you to use Crystal Reports templates without having to install the software on your system. You only need access to the template files on your local drive or a network to generate your custom reports.

**Note:** If you want to make a Crystal Reports template, see “Creating Crystal Reports templates” on page 69.

You can distribute reports you create in Crystal Reports in many ways, including the following:

- Print and distribute by hand
- Export in Crystal Reports Designer format (.RPT)
- Attach to an e-mail message in MS Word (.DOC) or Excel (.XLS) format
- Export to HTML and publish on the Internet

**Note:** If you have Crystal Reports 11.x installed, you can also distribute the reports by posting them in an MS Exchange folder in MS Word (.DOC) or Excel (.XLS) format.

**Note:** When you export a report to a different file format, you may lose some or all of the formatting. The export function can only preserve as much formatting as the export format allows.
To select and setup a predefined Crystal Reports template

1. From the part manager’s Reports menu, point to CIS Bill of Materials and choose Crystal Reports. CIS displays the Crystal Reports Bill of Materials dialog box.

   Note: You can also access the CIS Bill of Materials commands using the project manager’s Reports menu.

   ![Crystal Reports Bill of Materials dialog box]

   Note: The Crystal Reports Bill of Materials sorts by part reference by default, but you can set it to sort by part number in the Administrative Preferences tab of the Configure Database dialog box. For more information see “To set administrative preferences” on page 63.

2. In the Crystal Report Template list, select a report name, or click the Browse button and locate another template. Sample Crystal Reports templates (.RPT files) are provided in `<install directory>	ools\capture\samples`. These templates are designed to be used only with the BENCH.DB sample part database. You must create your own Crystal Reports templates to work with your preferred parts database.
3. Select one of the Part Reference Options from the following table:

<table>
<thead>
<tr>
<th>To do this...</th>
<th>Select this option...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group parts with matching keyed properties on a single line</td>
<td>Standard</td>
</tr>
<tr>
<td>Put each part on a separate line</td>
<td>Standard – Separate Line Per Part</td>
</tr>
<tr>
<td>Allow part ranges (such as R1–R14)</td>
<td>Compressed</td>
</tr>
</tbody>
</table>

4. In the Exclude Part Reference Prefixes field, specify part reference prefixes for parts you do not want to include in the report. Typically, you use this to omit parts that are not purchased for manufacture. To exclude more than one prefix, enter the prefixes separated with space characters.

**Note:** If your design has design variants, you will have the option of selecting the variants whose part information CIS will use to generate the report. See the CIS online help for more information about creating reports for design variants.

5. In the Variant list, select a variant or the core design. The report output includes the set of bill of materials data for the selected design.

6. Select an option from the following table:

<table>
<thead>
<tr>
<th>To do this...</th>
<th>Click this button...</th>
<th>Then proceed to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print your report</td>
<td>Print</td>
<td>To print a Crystal Reports report below</td>
</tr>
<tr>
<td>Preview your report before printing or exporting</td>
<td>Print Preview</td>
<td>To preview a Crystal Reports report below</td>
</tr>
<tr>
<td>Export your report to a file, an MS Exchange folder, a Lotus Notes database, or MS Mail.</td>
<td>Export</td>
<td>To export a Crystal Reports report</td>
</tr>
</tbody>
</table>
After you select one of the above options, CIS generates the report. This can take several minutes, depending on the number of parts in your design and the complexity of the Crystal Reports template. CIS checks for parts that are grouped (by having the same part number, for example), but that have different properties or packaging or have duplicate part references between instances of the parts.

CIS creates a report of the entire physical design regardless of the schematics and pages selected in the project manager.

To customize your Crystal Report

If your Crystal Reports template contains user-defined variables, you can use the Enter Parameter Values dialog box to specify their values for the Crystal Reports Bill of Materials report. The Enter Parameter Values dialog box appears when you click the Print Preview button in the Crystal Reports Bill of Materials dialog box.

To print a Crystal Reports report

1. If you have not done so already, complete “To select and setup a predefined Crystal Reports template” on page 172. Depending on the design of the Crystal Reports template, you might be required to input some information about your design (for example, part number or revision level) before you print.
2. When CIS displays Crystal Report’s Print dialog box, select the print options you want and click OK.

To preview a Crystal Reports report

1. If you have not done so already, complete “To select and setup a predefined Crystal Reports template” on page 172.

Note: If you have user-defined variables in your Crystal Reports template, the Enter Parameter Values dialog box appears after you click the Print Preview button in the Crystal Reports Bill of Materials dialog box.

2. When CIS displays the Crystal Report Viewer window, you can use the toolbar buttons to browse, zoom, print and export your report.

3. When you are ready to print or export your report, select one of the toolbar options from the following table:

<table>
<thead>
<tr>
<th>To do this...</th>
<th>Click this button...</th>
<th>Then proceed to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print your report</td>
<td></td>
<td>To print a Crystal Reports report</td>
</tr>
<tr>
<td>Export your report to a file, an MS Exchange folder, a Lotus Notes database, or MS Mail.</td>
<td><img src="image" alt="Folder Icon" /> <img src="image" alt="Print Icon" /></td>
<td>To export a Crystal Reports report</td>
</tr>
</tbody>
</table>

To export a Crystal Reports report

1. If you have not done so already, complete “To select and setup a predefined Crystal Reports template” on page 172.

2. When CIS displays Export Crystal Reports As dialog box, select the format in which you want to export the report. For example, if
you want to convert the report to Microsoft Excel format, choose Excel from the Format list.

3. In the Destination text box type the name (including destination directory) of the file to which you want to export the Report. You can also use the Browse button to navigate to the directory and enter the name in the File Name text box.

   **Note:** While the program assigns the native extension to all files you export in a specific word processor, or spreadsheet format, it automatically assigns the .TXT extension for all files you export in one of the common data interchange formats. However, the program you use to open the exported file may require a file extension other than TXT. In this case, you may need to consult the manual for that program to determine the correct file extension, and assign the appropriate extension when specifying the file name in the File Name text box.

   **Note:** In Crystal Reports 11.x, when you export files in a database format, the program assigns the native database extension.

4. Click OK. The export process begins.

### Creating a BOM variant report

You can generate BOM variant reports to see how the part properties of your design variants differ from the properties of the core design.

You can create two types of BOM variant reports:

- A BOM variant report that shows only the differences in the part numbers of the design variants and the core design. For more information, see “To create a variant report for part numbers only” on page 177.
A detailed customizable BOM variant report that shows the differences in the part properties you specify. For more information, see “To create a detailed variant report” on page 179.

To create a variant report for part numbers only

1. Open the core schematic design’s project (.OPJ) file in Capture.

2. From the project manager’s or part manager’s Reports menu, choose Variant Report. CIS displays the Variant Report dialog box. BOM variants are listed in the Variants list box.

3. In the Template Name text box, type in a name for the template, or select one from the drop-down list.

   Note: You can create multiple, named templates and define a different format for each. However, since a variant report file is, by default, saved using the design name and .VRT extension, you'll have to save each report under a unique filename using the part manager’s Save As command (from the File menu).
4. Select the Variant Comparison on Part Number check box.

5. In the Variants list, select one or more BOM variants. If you select more than one BOM variant, the Merge VARIANT Reports check box is selected by default. If you do not want to merge BOM variants in the report, clear the check box.

6. Click OK. CIS automatically adds the template name for the variant report you have designed to the Template Name list so that you can use the template again the next time you want to generate a variant report.

   If any design errors are encountered during report creation, a dialog box prompts you to view the errors in the session log.

   If no design errors are encountered during report creation, the variant report appears in a window.

   ![Variant Report Screenshot]

   **Note:** You can click a column heading to sort the rows by the values in that column, and click the same column heading again to reverse the sort order.

   **Note:** You can adjust the column widths by dragging the vertical lines between the column heading names to the left or right. If you save the variant report, it is saved with the current sort order.
7. To save the report, select one of the save options described in the following table:

<table>
<thead>
<tr>
<th>To do this...</th>
<th>Select this option...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save the report into the design folder using the default file name. Note that you will overwrite any report previously saved using this default file name.</td>
<td>From the File menu, choose Save.</td>
</tr>
<tr>
<td>Save the report using a new file name into the directory of your choice.</td>
<td>From the File menu, choose Save As.</td>
</tr>
</tbody>
</table>

**Note:** CIS creates the default file name using the design name. For example, if the design is named BENCH_ENG.DSN, the variant report file will be named BENCH_ENG.VRT by default.

8. Specify a filename, save location, and format type. By default, CIS saves the report in tab-delimited format, but you can choose any of the following formats:

- Text - Tab delimited format (*.VRT)
- Excel delimited format (*.CSV) - comma separated format
- Formatted comma delimited file (*.FWC)

**To create a detailed variant report**

1. Open the core schematic design’s project (.OPJ) file in Capture.
2. From the project manager's or part manager's Reports menu, choose Variant Report. CIS displays the Variant Report dialog box. BOM variants are listed in the Variants list box.

3. In the Template Name text box, type in a name for the template, or select one from the drop-down list.

   **Note:** You can create multiple, named templates and define a different format for each. However, since a variant report file is, by default, saved using the design name and .VRT extension, you'll have to save each report under a unique filename using the part manager's Save As command (from the File menu).

4. Select or type in a part property you want in the variant report and click the Add button. The part property moves to the Output Format list. You can also double-click a property to move it from one side to the other.

   **Tip**
   The Select Properties list only includes schematic properties that you have configured to be transferred from the database. If you want to include a schematic property in your variant report that is not in your part database, you must type in its exact name and then choose the Add
button. If you want to delete an added schematic property from the Select Properties list, select the property and click the Delete User Property button.

**Note:** The property types and icons that appear in the Select Properties list box include the following:

- ![Default CIS property names](default_cis_property.png)
- ![Properties transferred from placed parts on schematics](properties_placed.png)

**Note:** You specify the properties that are transferred from the database to your placed parts when you configure CIS.

- ![Properties transferred from database parts](database_properties.png)
- ![Title block property names](title_block_properties.png)

**Note:** Title block property information is read from the first schematic page in the design and displayed in the report.

5. Repeat Step 3 until all the properties you want in the variant report appear in the Output Format list box.

**Note:** The order of the items in the Output Format list box determines the order in which they appear in the report. To change the order of an item, select it and move it using the up or down arrow buttons to the right of the Output Format list box.

6. Select the Allow Saving Title Block Properties option if you want to save the title block property information along with the BOM variant information when you save the variant report as a .CSV, .FWC, or .VRTX file.

7. Select the Display Core Design Properties option to display the value of a property on a part in the core design next to its variant property value. The core design property value is displayed in square brackets. For example, if the property value on a part in the core design is 91PF and property value on its variant is 82PF, the Value field in the variant report displays:

   82PF [91PF]
8. In the Variants list, select one or more BOM variants. If you select more than one BOM variant, the Merge VARIANT Reports check box is selected by default. If you do not want to merge BOM variants in the report, clear the check box.

9. Click OK. CIS automatically adds the template name for the variant report you have designed to the Template Name list so that you can use the template again the next time you want to generate a variant report.

If any design errors are encountered during report creation, a dialog box prompts you to view the errors in the session log.

If no design errors are encountered during report creation, the variant report appears in a window.

Note: You can click a column heading to sort the rows by the values in that column, and click the same column heading again to reverse the sort order.

Note: You can adjust the column widths by dragging the vertical lines between the column heading names to the left or right. If you save the variant report, it is saved with the current sort order.

Note: If you have included properties in your report that are configured as browsable, CIS will hyperlink (blue underline) the part values for those properties. You can click on the hyperlinks to display the latest version of the source file.

Note: You can use a spreadsheet application to sort the exported output by multiple keys.
10. To save the report, select one of the save options described in the following table:

<table>
<thead>
<tr>
<th>To do this...</th>
<th>Select this option...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save the report into the design folder using the default file name. Note that you will overwrite any report previously saved using this default file name.</td>
<td>From the File menu, choose Save.</td>
</tr>
<tr>
<td>Save the report using a new file name into the directory of your choice.</td>
<td>From the File menu, choose Save As.</td>
</tr>
</tbody>
</table>

**Note:** CIS creates the default file name using the design name. For example, if the design is named BENCH_ENG.DSN, the variant report file will be named BENCH_ENG.VRT by default.

11. Specify a filename, save location, and format type. By default, CIS saves the report in tab-delimited format, but you can choose any of the following formats:

- Text - Tab delimited format (*.VRT)
- Excel delimited format (*.CSV) - comma separated format
- Formatted comma delimited file (*.FWC)
Menu commands

This chapter covers:

- "Edit menu" on page 185
- "Help menu" on page 191
- "Options menu" on page 193
- "Place menu" on page 195
- "Reports menu" on page 195
- "Tools menu" on page 196
- "Update menu" on page 201
- "View menu" on page 202

Edit menu

CIS commands are integrated into the Edit menus of Capture's project manager and schematic page editor, as well as comprising the Edit menus of the CIS part manager and CIS explorer windows. The following alphabetical list contains all the CIS commands from each of these Edit menus. For a description of a command, click on the command name.

- Copy command
- Delete command
- Derive Database Part command
- Derive New Database Part command
- Link Database Part command
- New BOM variant command
- New Group command
Menu commands

- Paste command
- Remove command
- Remove Part(s) from Group command
- Rename command
- Resolve Ambiguity command
- Revert to Common command
- Set Part As Not Present command
- Set Part As Present command

Add Part(s) To Group command

In the schematic page editor, from the Edit menu.

**Location:**
Shortcut: Right mouse button: In the schematic page editor with a part or parts selected, right-click and choose Add Part(s) To Group.

**Function:**
Use this command to add parts to a group from the schematic page editor.

**Shortcuts:**
Keyboard: In the schematic page editor with a part or parts selected, press Ctrl + Shift + A.

Copy command

In the part manager, from the Edit menu.

**Location:**

**Function:**
Use this command to create a copy of an existing component, group, subgroup, or BOM variant. Copying a group, subgroup, or BOM variant copies the component variations into the new group.
Delete command

Location: In the part manager, from the Edit menu.

Function: Use this command to delete any group, subgroup, or BOM variant folder that you have created.

Keyboard: In the part manager window tree view, select the group, subgroup, or BOM variant folder you want to delete and press the Delete key.

Shortcuts: Right Mouse Button: In the part manager window tree view, right-click the group, subgroup, or BOM variant folder you want to delete and select Delete.

Note: To delete a component from a group or subgroup, use the Remove command.

Derive Database Part command

Location: In the schematic page editor, from the Edit menu.

Function: Use this command to create a new database part that is based on a part that already exists on a schematic page. For more information about deriving new database parts, see “Deriving a new database part from a placed part” on page 97.
Derive New Database Part command

Location: In the Local Part Database tab of the CIS explorer window, from the Edit menu.

Function: Use this command to create a new database part that is based on a part that already exists in your part database. For more information about deriving new database parts, see “Deriving a new database part from the local part database” on page 92.

Shortcuts: Keyboard: In the Local Part Database tab of the CIS explorer window, press SHIFT+D keys

Link Database Part command

Location: In the schematic page editor, from the Edit menu. In the part manager window, from the Tools menu.

Function: Use this command to replace a placed parts and its properties with a database part and its transferable properties by linking the placed part to the database part. For more information about linking database parts, see “Linking a placed part to a database part” on page 101.

Keyboard: In the schematic page editor or part manager window, select the part or parts you want to link and type CTRL + L

Shortcuts: Right Mouse Button: In the schematic page editor or part manager window, select the part or parts you want to link, right-click a selected part, then choose Link Database Part.

New BOM variant command

Location: In the part manager window, from the Edit menu.

Function: Use this command to create a name for a new BOM variant.

Keyboard: In the part manager window, select the BOM Variants folder and type CTRL + N

Shortcuts: Right Mouse Button: In the part manager window, right-click on the BOM Variants folder, then choose New BOM Variant.
New Group command

Location: In the part manager, from the Edit menu.
Function: Use this command to create a new group in the Groups folder.

Keyboard: In the part manager window tree view, select the Groups folder and press CTRL + N.
Shortcuts: Right Mouse Button: In the part manager window tree view, right-click on the Groups folder and choose New Group.

New Subgroup command

Location: In the part manager, from the Edit menu.
Function: Use this command to create a new subgroup within a group in the Groups folder.

Keyboard: In the part manager window tree view, select the group folder in which you want to create a new subgroup and press CTRL + N.
Shortcuts: Right Mouse Button: In the part manager window tree view, right-click on the group folder in which you want to create a new subgroup and choose New Subgroup.

Paste command

Location: In the part manager, from the Edit menu.
Function: Use this command with the Copy command to copy a component from one group or subgroup to another group. You cannot copy components into subgroups.

Remove command

Location: In the part manager, from the Edit menu.
Function: Use this command to remove a component from a group or subgroup.
OrCAD CIS User Guide
Menu commands

**Remove Part(s) from Group command**

**Location:** In the schematic page editor, from the Edit menu.

**Function:** Use this command to remove parts from a group from the schematic page editor.

**Keyboard:** In the schematic page editor with a part or parts selected, press Ctrl + Shift + R.

**Shortcuts:** Right Mouse Button: In the schematic page editor with a part or parts selected, right-click and choose Remove Part(s) From Group.

**Rename command**

**Location:** In the part manager, from the Edit menu.

**Function:** Use this command to rename any group, subgroup, or BOM variant folder that you have created.

**Right Mouse Button:** In the part manager window, select a group or subgroup you want to rename, then right-click and choose Rename.

**Resolve Ambiguity command**

**Location:** In the part manager, from the Edit menu.

**Function:** Use this command to select one of multiple similar parts to be used in a BOM variant.

**Keyboard:** In the part manager window, select a component you want to remove and press the Delete key.

**Shortcuts:** Right Mouse Button: In the part manager window, select a component you want to remove, then right-click and choose Remove.
**Revert to Common command**

**Location:** In the part manager, from the Edit menu.

**Function:** Use this command to select one of multiple similar parts to be used in a BOM variant.

**Set Part As Not Present command**

**Location:** In the part manager, from the Edit menu.

**Function:** Use this command to set a part as not present in a design.

**Right Mouse Button:** In the part manager window, select the group or subgroup that contains the component whose status you want to change, right-click on the component and choose Set Part As Not Present.

**Set Part As Present command**

**Location:** In the part manager, from the Edit menu.

**Function:** Use this command to set a part or groups of parts as present in a design.

**Right Mouse Button:** In the part manager window, select the group or subgroup that contains the component whose status you want to change, right-click on the component and choose Set Part As Present.

**Help menu**

CIS commands are integrated into the Help menus of all Capture CIS windows. The following list contains all the CIS commands from each of these Help menus. For a description of a command, click on the command name.

- **About OrCAD Capture CIS command**
- **Known Problems and Solutions command**
What's New command

Learning OrCAD Capture CIS command

Documentation command

About OrCAD Capture CIS command

Location:
In all Capture CIS windows, from the Help menu choose the About Capture CIS command.

Function:
Use this command to get the software version number, copyright information, registration number, and license information.

Known Problems and Solutions command

Location:
In all Capture CIS windows, from the Help menu point to the Known Problems and Solutions command and choose CIS.

Function:
Use this command to display a document listing the known problems in the release of OrCAD Capture CIS and tells you how to solve or work around these problems.

What’s New command

Location:
In all Capture CIS windows, from the Help menu point to the What's New command and choose CIS.

Function:
Use this command to display a document describing the new features and enhancements in this release of OrCAD Capture CIS.

Learning OrCAD Capture CIS command

Location:
In all Capture CIS windows, from the Help menu choose the Learning OrCAD Capture CIS command.

Function:
Use this command to launch the OrCAD Capture CIS tutorial.
Documentation command

Location: In all Capture CIS windows, from the Help menu choose the Documentation command.

Function: Use this command to launch the HTML page, which contains links to all the documentation types (manuals and online help), product tutorial, and multimedia demonstrations shipped with this product release.

Options menu

CIS commands are integrated into the Options menu of Capture's project manager, as well as comprising the Options menu of the CIS part manager. The following list contains all the CIS commands from each of these Options menus. For a description of a command, click on the command name.

- CIS Configuration command
- Verify Part Against (OLB) Libraries command
- Extended CIS Linking command

CIS Configuration command

Location: In the project manager or part manager window, from the Options menu.

Function: Use this command to create and setup the database configuration (.DBC) file that CIS requires to make use of the data in your part database. For more information about creating and setting up the .DBC file, see “Setting database table property options” on page 53.

Verify Part Against (OLB) Libraries command

Location: In the part manager window, from the Options menu point to Update Part Status.
Use this command to either turn on or off the Verify Parts Against Libraries (.OLB) option. When you turn on the option, CIS places a check mark next to the command. At that point, choosing the command again will remove the check mark and turn off the option.

When you turn on the Verify Parts Against Libraries (.OLB) option then choose the Update Part Status command, CIS will check to see if any of the parts in your design have been modified since they were placed from their original libraries. When CIS is finished updating part status, any placed part with a different timestamp than its library part will be flagged yellow. For more information about updating part status in a design, see “Updating the part status for your design” on page 133.

**Note:** If you turn on the Verify Parts Against Libraries (.OLB) option and you placed parts in the design using a previous version of CIS (Release 9.0 or earlier), all parts placed from the previous Capture libraries will have mismatched timestamps and be flagged yellow. If you do not want this result, turn off the Verify Parts Against Libraries (.OLB) option and update part status again.

**Extended CIS Linking command**

**Location:** In the Capture CIS window or project manager or schematic page editor, from the CIS Preferences menu.

Use this command to set preferences for linking a placed part to a database part. You can specify the following link preferences:

- replace the symbol, reference designator, and all the properties of the placed part with that of the database part.

- replace the symbol and all the other properties of the placed part with that of the database part, but retain the placed part reference designator.

- replace all the properties of the placed part with that of the database part, but retain the placed part symbol and the reference designator.

For information on how to set these options, see “Setting linking preferences” on page 102.

**Shortcuts:** **Keyboard:** In the Capture CIS window or project manager or schematic page editor, press SHIFT + E.
OrCAD CIS User Guide
Menu commands

Place menu

CIS commands are integrated into the Place menu of Capture's schematic page editor. The following alphabetical list contains all the CIS commands from this menu. For a description of a command, click on the command name.

- **Database Part command**

Database Part command

**Location:** In the schematic page editor, from the Place menu.

**Function:** Use this command to locate and place database part from your local preferred parts database (PPD). For more information about placing database parts, see “Placing a database part on a schematic page” on page 81.

**Keyboard:** In the schematic editor window, type Z

**Shortcuts:** Right Mouse Button: In the schematic editor window with no parts selected, right-click and choose Place Database Part.

Reports menu

CIS commands are integrated into the Reports menu of Capture's project manager, as well as comprising the Reports menu of the CIS part manager. The following list contains all the CIS commands from each of these Reports menus. For a description of a command, click on the command name.

- **Crystal Reports command**
- **Standard command**
- **Variant Report command**

Crystal Reports command

**Location:** In the project manager or part manager window, from the Reports menu point to CIS Bill of Materials.
Menu commands

Standard command

Function: Use this command to generate a report based on a template created using the advanced reporting capabilities of Crystal Reports. For more information about generating Crystal Reports reports in CIS, see “Creating a report using a Crystal Reports template” on page 171.

Location: In the project manager or part manager window, from the Reports menu point to CIS Bill of Materials.

Variant Report command

Function: Use this command to check how the part properties of your design variants differ from the properties of the core design.

Location: In the project manager or part manager window, from the Reports menu.

Tools menu

CIS commands are integrated into the Tools menu of Capture's project manager, as well as comprising the Tools menu of the CIS part manager. The following list contains all the CIS commands from each of these Tools menus. For a description of a command, click on the command name.

- Link Database command
- View Database Part Command
- Open command (Part Manager)
- Update command (Part Manager)
- Update All Part Status command
**Link Database command**

**Location:** In the schematic page editor, from the Edit menu. In the part manager window, from the Tools menu.

**Function:** Use this command to replace placed parts and its properties with a database part and its transferable properties by linking the placed part to the database part. For more information about linking database parts, see "Linking a placed part to a database part" on page 101.

**Keyboard:** In the schematic page editor or part manager window, select the part or parts you want to link and type CTRL + L

**Shortcuts:** Right Mouse Button: In the schematic page editor or part manager window, select the part or parts you want to link, right-click a selected part, then choose Link Database Part.

**View Database Part Command**

**Location:** In the schematic page editor and part manager, from the View menu.

**Function:** Use this command to view placed parts and its properties with a database part and its transferable properties.

**Keyboard:** In the schematic page editor or part manager window, select the part or parts you want to link and type CTRL + D

**Shortcuts:** Right Mouse Button: In the schematic page editor or part manager window, select the part or parts you want to link, right-click a selected part, then choose View Database Part.

**Open command (Part Manager)**

**Location:** In the project manager, from the Tools menu point to Part Manager.

**Function:** Use this command to open the part manager window.
Update command (Part Manager)

Location: In the project manager, from the Tools menu point to Part Manager.

Function: Use this command to make sure that the parts in your design exist in the part database and resolve any differences between part property values and their corresponding database part property values. For more information about updating part status in a design, see “Updating the part status for your design” on page 133.

Shortcut: Right Mouse Button: In the project manager window, right-click any project folder and choose Part Manager.

Keyboard: In the part manager window, type CTRL + U.

Shortcut: Right Mouse Button: In the part manager window, right-click any part and choose Update Part Manager.

Update All Part Status command

Location: In the part manager window, from the Tools menu.

Function: Use this command to make sure that the parts in your design exist in the part database and resolve any differences between part property values and their corresponding database part property values. For more information about updating part status in a design, see Updating the part status for your design.

Note: If any warnings are generated during the update operation, a message box appears asking you whether you want to view the warnings such as warnings for Mismatched properties. If you want to view the warnings, click Yes. The Session Log displays showing the warnings messages. If you select No, the parts are updated as is.

Shortcut: Right Mouse Button: In the part manager window, right-click any part and choose Update All Part Status.
Update Selected Part Status command

Location: In the part manager window, from the Tools menu.

Function: Use this command to make sure that the parts you select in the part manager window exist in the part database and resolve any differences between part property values and their corresponding database part property values.

Keyboard: Select parts in the part manager window and press SHIFT + U.

Shortcuts: Right Mouse Button: Select parts in the part manager window, right-click and choose Update Selected Part Status.

Test Bench commands

The following list contains the CIS commands available from the Tools – Test Bench menu. For a description of a command, click on the command name.

- Create Test Bench
- Compare Test Bench
- Edit TestBench
- Remove TestBench
- Make Active
- Part Manager

Create Test Bench

Location: In the project manager window, choose Tools – Test Bench.

Function: Use this command to create a new test bench for partial design simulation.

Shortcuts: Keyboard: Select the master design in the project manager window and press SHIFT + B.
Compare Test Bench

Location: In the project manager window, choose Tools – Test Bench.

Function: Use this command to compare an active test bench with the master design.

Shortcuts: Keyboard: Select master design in the project manager window and press SHIFT + D.

Edit TestBench

Location: In the project manager window, select the test bench and right-click.

Function: Use this command to open the test bench for editing.

Remove TestBench

Location: In the project manager window, select the test bench and right-click.

Function: Use this command to delete the test bench.

Make Active

Location: In the project manager window, select the test bench and right-click.

Function: Use this command to make the test bench active.

Part Manager

Location: In the project manager window, select the test bench and right-click.

Function: Use this command to open the part manager for the test bench.
Update menu

The following list contains all the CIS commands available from the Updates menu in the CIS explorer. For a description of a command, click on the command name.

- Place Database Part command
- Re-search Database command
- Refresh Part Types command
- Refresh Symbols from Libs command

Place Database Part command

Location: In the Local Part Database tab of the CIS explorer, from the Update menu.

Function: Use this command to place database parts from your local preferred parts database (PPD) using the CIS explorer.

Keyboard: In the schematic editor window, type Z.

Shortcuts: Right Mouse Button: In the schematic editor window with no parts selected, right-click and choose Place Database Part.

Re-search Database command

Location: In the Local Part Database tab of the CIS explorer, from the Update menu.

Function: Use this command to perform a query on the preferred parts database (PPD) using the criteria that you have entered in the Query tab of the explorer window. For more information about querying your local part database, see “Using the query feature to locate database parts” on page 82.

Refresh Part Types command

Location: In the Local Part Database tab of the CIS explorer, from the Update menu.
Menu commands

Refresh Symbols from Libs command

Function: Use this command to perform a query on the preferred parts database (PPD) using the criteria that you have entered in the Query tab of the explorer window. For more information about querying your local part database, see “Using the query feature to locate database parts” on page 82.

Location: In the Local Part Database tab of the CIS explorer, from the Update menu.

Use this command to refresh the symbol or footprint information in CIS explorer.

Note: If a symbol used in Capture and CIS is from a common library, then symbol updates made using Reload Library Parts command in Place Part dialog of Capture are also reflected in CIS.

View menu

CIS commands are integrated into the View menu of Capture's schematic page editor, as well as comprising the View menus of the CIS part manager and CIS explorer windows. The following alphabetical list contains all the CIS commands from each of these View menus. For a description of a command, click on the command name.

- Configure Part Properties command
- Database Part command (View menu)
- Expand / Collapse Tree Item command
- Footprint command
- Part command
- Show / Hide Tree View command
- Toolbar command (CIS explorer)
- Toolbar command (Part Manager)
- Visibility command
Variant View Mode command

Configure Part Properties command

Location: In the part manager, from the View menu.

Function: Use this command to change which part properties are displayed, as well as the order in which they are displayed, in the part manager.

Database Part command (View menu)

Location: In the schematic page editor or part manager window, from the View menu.

Note: You cannot view the properties of more than one part simultaneously. So, if you have multiple parts selected, the menu command and right mouse button shortcut are not available and the keyboard shortcut does not initiate the command function.

Function: Use this command to view a placed part's local and Internet database properties from an instance on the schematic page.

Keyboard: In the schematic page editor or part manager window, select the part whose properties you want to view and type CTRL + D.

Right Mouse Button: In the schematic page editor or part manager window, select the part you want to view, right-click the selected part, then choose View Database Part.

Expand / Collapse Tree Item command

Location: In the part manager window, from the View menu.

Function: Use this command to expand or collapse an entire branch of folders in the tree view hierarchy, removing the need to expand or collapse each subfolder individually.

This command toggles between expanded and collapsed display of folders in the part manager tree view.
**Footprint command**

In the CIS explorer window, from the View menu.

**Note:** The Footprint command is available only:

- If you chose to view PCB footprints during installation
- If you modified the CAPTURE.INI file to contain statements that specify a footprint viewer (either Allegro or Layout) and valid path names for libraries that correspond to the selected viewer.

**Location:**

- In the CIS explorer window, from the View menu.

**Function:**

Use this command to either display or hide the footprint window in the CIS explorer. When the window is displayed, CIS places a check mark next to the command. At that point, choosing the Footprint command removes the check mark and hides the window.

**Part command**

**Location:**

- In the CIS explorer window, from the View menu.

**Function:**

Use this command to either display or hide the part window in the CIS explorer. When the window is displayed, CIS places a check mark next to the command. At that point, choosing the Part command removes the check mark and hides the window.

**Show / Hide Tree View command**

**Location:**

- In the part manager, from the View menu.

**Function:**

Use this command to display or not display the tree view.

**Toolbar command (CIS explorer)**

**Location:**

- In the CIS explorer window, from the View menu.

**Function:**

Use this command to either display or hide the CIS explorer toolbar. When the toolbar is displayed, CIS places a check mark next to the command. At that point, choosing the Toolbar command will remove the check mark and hide the toolbar.
Menu commands

Toolbar command (Part Manager)

Location: In the part manager window, from the View menu.

Function: Use this command to either display or hide the part manager toolbar. When the toolbar is displayed, CIS places a check mark next to the command. At that point, choosing the Toolbar command will remove the check mark and hide the toolbar.

Visibility command

Location: In the CIS explorer window, from the View menu.

Function: Use this command to either display or hide the visibility window in the CIS explorer. When the window is displayed, CIS places a check mark next to the command. At that point, choosing the Visibility command will remove the check mark and hide the window. For information about the visibility window, see “The visibility window” on page 19.

Variant View Mode command

Location: In the schematic page editor or the project manager, from the View menu.

Function: Use this command to view variant information for all the design variants defined in your project. The variant information includes different property values for common components or different or not present components for identical footprints on a schematic page. For information on how to use this command, see “Viewing design variants on a schematic page” on page 145.

Shortcuts

Keyboard: SHIFT+M

Relational Table View command

Location: In the database parts window of the CIS explorer, from the View menu.
Function: Use this command to view the relational table in the CIS query. Note: this command will only execute if the CIS database is a relational database.

Hide Column command

Location: In the database parts window of the CIS explorer, right-click over any column heading (for example, Part Type, Part Number, Value), and then select the command from the shortcut menu.

Function: Use this command to hide any of the columns in the database parts window of the CIS explorer.

Unhide Column command

Location: In the database parts window of the CIS explorer, right-click over any column heading (for example, Part Type, Part Number, Value), and then select the command from the shortcut menu.

Function: Use this command to display any of the columns that you have previously hidden in the database parts window of the CIS explorer.
Dialog box descriptions

The following is an exhaustive set of descriptions for the dialog boxes you may encounter while using Capture CIS. Each description is listed alphabetically, using the dialog box title.

**Browse Data Source dialog box**

CIS displays this dialog box when you choose the Browse button in the Part Database tab of the Configure Database dialog box. The Browse Data Source dialog box lists part databases configured using the 32-bit ODBC Windows control panel.

<table>
<thead>
<tr>
<th>Use this control...</th>
<th>To do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Sources</td>
<td>Select a data source from the list.</td>
</tr>
<tr>
<td>OK</td>
<td>Accept your selection and close the dialog box.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Close this dialog box without taking any action.</td>
</tr>
<tr>
<td>Help</td>
<td>Display this help topic.</td>
</tr>
</tbody>
</table>

**CIS Configuration File dialog box**

CIS displays this dialog box when you choose CIS Configuration from the project manager or part manager Options menu.

<table>
<thead>
<tr>
<th>Use this control...</th>
<th>To do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration File</td>
<td>Shows the current configuration file.</td>
</tr>
<tr>
<td>Setup</td>
<td>Change the configuration file.</td>
</tr>
<tr>
<td>Browse</td>
<td>Select a configuration file.</td>
</tr>
<tr>
<td>New</td>
<td>Create a new configuration file.</td>
</tr>
</tbody>
</table>
Configure Database dialog box

CIS displays the Configure Database dialog box when you choose the Setup button in the CIS Configuration File dialog box. The following table describes the tabs available in this dialog box.

<table>
<thead>
<tr>
<th>Use this tab...</th>
<th>To do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Part Database</td>
<td>Create an interface between CIS and your part database using your defined ODBC data source name. You need to set the options for the file so that CIS knows how to handle your database table part properties. For more information, see Configure Database dialog box (Part Database tab).</td>
</tr>
<tr>
<td>Part Reference Associations</td>
<td>Set part reference association to improve the speed and accuracy of the search when you are linking placed parts to database parts. For more information, see Configure Database dialog box (Part Reference Associations tab).</td>
</tr>
<tr>
<td>Administrative Preferences</td>
<td>Customize some CIS features for your work environment. For more information, see Configure Database dialog box (Administrative Preferences tab).</td>
</tr>
<tr>
<td>Relational Database</td>
<td>Set up the primary - foreign key relationship between the parts (primary) tables and related tables in the database.</td>
</tr>
</tbody>
</table>
Configure Database dialog box (Part Database tab)

You can access the part database options by clicking the Part Database tab in the Configure Database Dialog box.

When you create a database configuration (.DBC) file, you are creating an interface between CIS and your part database using your defined ODBC data source name. You need to set the options for the file so that CIS knows how to handle your database table part properties. The options in the following table can be set for each table in your database.

<table>
<thead>
<tr>
<th>Use this control...</th>
<th>To do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Source</td>
<td>Show the database name.</td>
</tr>
<tr>
<td>Browse</td>
<td>Select the database from the listed sources to display its properties.</td>
</tr>
<tr>
<td>Tables</td>
<td>Select a part table in the database. CIS automatically creates the TMPPRTS table to hold temporary parts.</td>
</tr>
<tr>
<td>Configuration</td>
<td>Shows the selected table's properties. Each row represents a part property. Each column is a characteristic of the property.</td>
</tr>
<tr>
<td>Table Property Name</td>
<td>View the property name as defined in the part database.</td>
</tr>
</tbody>
</table>
### Property Type

One of five types indicating how Capture CIS interprets the property. Except for Normal, as you assign a type, it is removed from the list of choices.

- **Part_Number**: One property in the table must have this type. This is used by the part manager to identify the part in the database.
- **Part_Type**: Set this type for the property that defines the part's type.
- **Schematic_Part**: Set this type for the property that indicates the schematic part name.
- **PCB_Footprint**: Set this type for the property that indicates the PCB footprint name.
- **PSpice_Model**: Set this type for the property that contains PSpice models. When you set this property type, CIS activates PSpice functionality for placed parts with a value for the database property.
- **Normal**: Use this for all other properties in the table.

### Transfer to Design

Check to have Capture CIS copy this property to the placed part when you place or link the part.

### OrCAD Property Name

The name of the property as it appears on the placed part. This characteristic is only available when you check Transfer to Design. Select a property name from the drop-down list or type the property name. If you do not enter a value, the name of the property as it appears in the database is transferred to the placed part.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visibility</td>
<td>Sets the visibility of the property on the schematic design. You can change the visibility settings only for properties that are transferred to the design. These appear with a white background in the Visible column. Properties you cannot change are shown with a light gray background in the Visible column.</td>
</tr>
<tr>
<td>Key</td>
<td>Check to use the property as a key during the initial part search when linking a database part. If you don't have a Value property, don't set any key. You can specify any number of keys. Typically, you only set the key for the Value property. When you link a part, Capture CIS searches for parts with that specific value in the database.</td>
</tr>
<tr>
<td>Browsable</td>
<td>Check to indicate that this property in the database contains references to data sheets, drawings, or other documents. When you browse your local part database, click on hyperlinked (blue, underlined) values to view the referenced documents online. Capture CIS launches the appropriate browser or application based on the contents of the database property and the filename extension. In addition, when you generate a CIS standard bill of materials, you can click on the link for a browsable property value in the report to view a document, such as the latest data sheet from its source on the Internet.</td>
</tr>
<tr>
<td>Update Part Property</td>
<td>Check to have CIS check the value of the property for placed parts against the database part’s value when you update the part status of your designs.</td>
</tr>
</tbody>
</table>
Configure Database dialog box (Administrative Preferences tab)

You can access administrative preferences by clicking the Administrative Preferences tab in the Configure Database Dialog box.

Administrative preferences allow you to customize some CIS features for your work environment.

<table>
<thead>
<tr>
<th>Use this control...</th>
<th>To do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow Duplicate Part Numbers</td>
<td>Check to allow more than one part to use the same number in the database. This is most useful when a part has more than one PCB footprint associated with it. You can enter the part twice in the database, each one using a different PCB footprint.</td>
</tr>
<tr>
<td>Part Type Delimiter</td>
<td>Indicates the folder hierarchy delimiter used in the database. The default delimiter is the backslash. For example, if you use Capacitor\Ceramic in the database, Capture CIS displays Ceramic as a folder in the Capacitor folder.</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Transfer Blank Properties</td>
<td>Check to create a property on the placed part even if there isn't a value for the property in the database.</td>
</tr>
<tr>
<td>Auto Symbol Refresh Checking</td>
<td>Check to enable CIS to automatically detect if symbols or footprints were updated in the configured libraries. If any changes are detected, the Refresh Symbols from Lib command in the Update menu in CIS explorer and its corresponding icon on the toolbar are enabled. This indicates that you have to refresh the symbol or footprint information in CIS explorer. If you do not select this check box, the Refresh Symbols from Lib command in the Update menu in CIS explorer and its corresponding icon on the toolbar will always be enabled.</td>
</tr>
<tr>
<td>Delimiter for Multi-Values</td>
<td>Select the character you want to use to separate multiple values in the schematic part and PCB footprint table property cells of your part database.</td>
</tr>
<tr>
<td>Assign Temporary Part Numbers Automatically</td>
<td>Check to have Capture CIS create and track temporary part numbers. Temporary parts are tracked in the TMPPRTS table.</td>
</tr>
<tr>
<td>Temporary Part Number Prefix</td>
<td>Type the prefix you want to use for temporary parts. TMP- is the default. Capture CIS appends the temporary part number to this prefix. You can set up a different prefix (such as the user's initials) for each user's temporary parts.</td>
</tr>
</tbody>
</table>
Part Not Present Display Value

Enter the text description that you want CIS to use for variant parts set to Not Present. The property is displayed in the following locations:

- Part Number and Value fields in the part manager
- Design variant columns in variant reports
- Variant parts on schematic page previews and printouts.

The Part Not Present Display Value does not display in Capture’s schematic page editor. This property also cannot be repositioned or edited in the schematic page editor. For this reason, you have to print preview or print a schematic page to make sure that the value assigned to the property does not overlap another part or property display. A long value is more likely to overlap a display, therefore, try to use a fairly short text equivalent for the default Not Present value.

By Part Reference (Default)

Select this option to group and sort parts in bills of materials reports created using Crystal Reports grouped by part reference. Each part will have a unique item number.

By Part Number

Select this option to sort parts in bills of materials reports created using Crystal Reports by part number. Since part numbers are unique, the resulting report assigns one item number to all parts with the same part number.

Configure Database dialog box (Part Reference Associations tab)

You can access part reference associations by clicking the Part Reference Associations tab in the Configure Database Dialog box.

CIS uses part reference association during the Link Database Part command operation to improve the speed and accuracy of the search. When you choose Link Database Part, Capture CIS
searches only the associated **database table** and displays the parts of the appropriate type.

**Note:** Defining part reference associations only improves part search speeds for true databases (for example, Microsoft Access)—there is no speed improvement from setting up associations if you are using a spreadsheet or a text file for your database.

<table>
<thead>
<tr>
<th>Use this control...</th>
<th>To do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Part Type Property Contents</td>
<td>Type the <strong>part type</strong> as defined in your database's part type property (such as ceramic or electrolytic).</td>
</tr>
<tr>
<td><strong>Note:</strong> The part type is case sensitive.</td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong> Use the Delete keyboard key to delete a row containing the part type and the corresponding part reference prefix.</td>
<td></td>
</tr>
<tr>
<td>Applicable Part Reference Prefixes</td>
<td>Type the part reference associated with the part type. A part reference prefix is the initial characters in the part reference text for the placed part. For example, a placed part named U29B has a part reference prefix of U.</td>
</tr>
</tbody>
</table>

**Configure Database dialog box (Relational Database tab)**

You can view the relations in the CIS Relational database (if they are set) by clicking the Relational Database tab in the Configure Database Dialog box.

These relations are used by the CIS place database part command to search for part. You can query for parts on the basis of their relationship between the primary and secondary tables in the CIS database.

<table>
<thead>
<tr>
<th>Use this control...</th>
<th>To do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary Key drop down list</td>
<td>Select the primary key to use for the corresponding CIS primary table. For example, part number may be the primary key for the Resistor table.</td>
</tr>
</tbody>
</table>
Configure Part Property Display dialog box

CIS displays this dialog box when, from the View menu of the part manager, you select Configure Part Properties.

Using this dialog box, you can change which part properties are displayed, as well as the order in which they are displayed, in the part manager.

**Use this control...**  **To do this...**

Available Part Properties  
Double-click on a property name to add it to the Selected Part Properties list. You can also type or select a property name, and then choose the Add button.

The property types that appear in the Available Part Properties list box include the following:

- Default CIS property names
- Properties transferred from placed parts on schematics

Add  
Display the selected property in the part manager.

Remove  
Remove the selected property from the part manager display.
### Crystal Reports Bill of Materials dialog box

CIS displays this dialog box when you point to CIS Bill of Materials on the Reports menu in either the project manager or the part manager, and choose Crystal Reports.

<table>
<thead>
<tr>
<th>Use this control...</th>
<th>To do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Browse</td>
<td>Select a template to use that is not in the Crystal Reports Template list. You can also type a template name in the text box to the left of this button, or select a template from the list box below the text box.</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete the selected template from the Crystal Reports Template list.</td>
</tr>
</tbody>
</table>
Database Configuration Wizard

CIS displays this wizard when you click the New button in the CIS Configuration File dialog box.

Database Configuration Wizard (Welcome Page)

<table>
<thead>
<tr>
<th>Use this control...</th>
<th>To do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Back</td>
<td>Go back to the CIS Configuration dialog box.</td>
</tr>
<tr>
<td>Next</td>
<td>Move to the next step in the wizard.</td>
</tr>
<tr>
<td>Finish</td>
<td>Skip additional wizard steps, accept your entries, and go to the Configure Database dialog box, in which you can set additional options for your configuration.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Close the wizard without taking any action, and go to the CIS Configuration File dialog box.</td>
</tr>
</tbody>
</table>
# Database Configuration Wizard (Select Data Source)

<table>
<thead>
<tr>
<th>Use this control...</th>
<th>To do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Sources</td>
<td>Select the data source to use for the new configuration file.</td>
</tr>
<tr>
<td>Back</td>
<td>Go back to the CIS Configuration dialog box.</td>
</tr>
<tr>
<td>Next</td>
<td>Move to the next step in the wizard.</td>
</tr>
<tr>
<td>Finish</td>
<td>Skip additional wizard steps, accept your entries, and go to the Configure Database dialog box, in which you can set additional options for your configuration.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Close the wizard without taking any action, and go to the CIS Configuration File dialog box.</td>
</tr>
</tbody>
</table>

# Database Configuration Wizard (Configuring Tables)

<table>
<thead>
<tr>
<th>Use this control...</th>
<th>To do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Source</td>
<td>View the data source in use for the new configuration file.</td>
</tr>
<tr>
<td>Tables</td>
<td>Select the database tables that you want to configure.</td>
</tr>
<tr>
<td>Temp Part Number Table</td>
<td>Verify that your database has TMPPRTS table configured to store temporary part numbers.</td>
</tr>
<tr>
<td>TMPPRTS Exists</td>
<td>Go back to the CIS Configuration dialog box.</td>
</tr>
<tr>
<td>Back</td>
<td>Move to the next step in the wizard.</td>
</tr>
<tr>
<td>Finish</td>
<td>Skip additional wizard steps, accept your entries, and go to the Configure Database dialog box, in which you can set additional options for your configuration.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Close the wizard without taking any action, and go to the CIS Configuration File dialog box.</td>
</tr>
</tbody>
</table>
### Database Configuration Wizard (Property Types to Table Properties)

<table>
<thead>
<tr>
<th>Use this control...</th>
<th>To do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>View the database table that you are currently configuring.</td>
</tr>
<tr>
<td>(Part Number) Select Table Property Name</td>
<td>Select a table property name for the Part_Number property type.</td>
</tr>
<tr>
<td>(Value) Select Table Property Name</td>
<td>Select a table property name for the Value property type.</td>
</tr>
<tr>
<td>Back</td>
<td>Go back to the CIS Configuration dialog box.</td>
</tr>
<tr>
<td>Next</td>
<td>Move to the next step in the wizard.</td>
</tr>
<tr>
<td>Finish</td>
<td>Skip additional wizard steps, accept your entries, and go to the Configure Database dialog box, in which you can set additional options for your configuration.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Close the wizard without taking any action, and go to the CIS Configuration File dialog box.</td>
</tr>
</tbody>
</table>

### Database Configuration Wizard (Assigning Property Types)

<table>
<thead>
<tr>
<th>Use this control...</th>
<th>To do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>View the database table that you are currently configuring.</td>
</tr>
<tr>
<td>Select Table Property Name (Part_Type)</td>
<td>Select a table property name for the Part_Type property type.</td>
</tr>
<tr>
<td>Select Table Property Name (Schematic_Part)</td>
<td>Select a table property name for the Schematic_Part property type.</td>
</tr>
<tr>
<td>Back</td>
<td>Go back to the CIS Configuration dialog box.</td>
</tr>
<tr>
<td>Next</td>
<td>Move to the next step in the wizard.</td>
</tr>
</tbody>
</table>
## Database Configuration Wizard (Assigning Property Tables)

<table>
<thead>
<tr>
<th>Use this control...</th>
<th>To do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>View the database table that you are currently configuring.</td>
</tr>
<tr>
<td>Select Table Property Name (PCB_Footprint)</td>
<td>Select a table property name for the PCB_Footprint property type.</td>
</tr>
<tr>
<td>Select Table Property Name (PSpice_Model)</td>
<td>Select a table property name for the PSpice_Model property type.</td>
</tr>
<tr>
<td>Back</td>
<td>Go back to the CIS Configuration dialog box.</td>
</tr>
<tr>
<td>Next</td>
<td>Move to the next step in the wizard.</td>
</tr>
<tr>
<td>Finish</td>
<td>Skip additional wizard steps, accept your entries, and go to the Configure Database dialog box, in which you can set additional options for your configuration.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Close the wizard without taking any action, and go to the CIS Configuration File dialog box.</td>
</tr>
</tbody>
</table>

## Database Configuration Wizard (Property Transfer)

<table>
<thead>
<tr>
<th>Use this control...</th>
<th>To do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table Property Name</td>
<td>View the table property name.</td>
</tr>
<tr>
<td>Transfer to Design</td>
<td>Select to have CIS copy this property to parts placed on schematics when you place or link database parts.</td>
</tr>
</tbody>
</table>
OrCAD Property Name  Set the name of the property as it appears on the placed part. This characteristic is only available when you select Transfer to Design. You can select a property name from the drop-down list or type the property name. If you do not enter a value, the name of the property as it appears in the database is transferred to the placed part.

Back  Go back to the CIS Configuration dialog box.

Next  Move to the next step in the wizard.

Finish  Skip additional wizard steps, accept your entries, and go to the Configure Database dialog box, in which you can set additional options for your configuration.

Cancel  Close the wizard without taking any action, and go to the CIS Configuration File dialog box.

Database Configuration Wizard (Selecting Browsable Properties)

Use this control...  To do this...

Browsable Properties  In the list of database table properties below, select the check box of each property that you want to be browsable.

Back  Go back to the CIS Configuration dialog box.

Next  Move to the next step in the wizard.

Finish  Skip additional wizard steps, accept your entries, and go to the Configure Database dialog box, in which you can set additional options for your configuration.

Cancel  Close the wizard without taking any action, and go to the CIS Configuration File dialog box.
Database Configuration Wizard (Setting Property Visibility)

<table>
<thead>
<tr>
<th>Use this control...</th>
<th>To do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties Transferred to Design</td>
<td>View the database table properties you have selected to be transferred to designs.</td>
</tr>
<tr>
<td>Visibility</td>
<td>Sets the visibility of the property on the schematic design. You only need to set visibility for properties that are transferred to the design. These appear with a white background in the Visible column. Properties you cannot change are shown with a light gray background in the Visible column.</td>
</tr>
<tr>
<td>Back</td>
<td>Go back to the CIS Configuration dialog box.</td>
</tr>
<tr>
<td>Next</td>
<td>Move to the next step in the wizard.</td>
</tr>
<tr>
<td>Finish</td>
<td>Skip additional wizard steps, accept your entries, and go to the Configure Database dialog box, in which you can set additional options for your configuration.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Close the wizard without taking any action, and go to the CIS Configuration File dialog box.</td>
</tr>
</tbody>
</table>

Database Configuration Wizard (Selecting Keyed Properties)

<table>
<thead>
<tr>
<th>Use this control...</th>
<th>To do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keyed Properties</td>
<td>Select a check box for each property you want to set as a key during the initial part search when linking a database part. If you don't have a Value property, don't set any key.</td>
</tr>
<tr>
<td>Back</td>
<td>Go back to the CIS Configuration dialog box.</td>
</tr>
<tr>
<td>Next</td>
<td>Move to the next step in the wizard.</td>
</tr>
<tr>
<td>Finish</td>
<td>Skip additional wizard steps, accept your entries, and go to the Configure Database dialog box, in which you can set additional options for your configuration.</td>
</tr>
</tbody>
</table>
Database Configuration Wizard (Assigning Activeparts Property Type)

**Use this control...** | **To do this...**
--- | ---
Table | View the database table that you are currently configuring.
Select Table Property Name (Activepart_ID) | Select a table property name for the Activepart_ID property type.
Back | Go back to the CIS Configuration dialog box.
Next | Move to the next step in the wizard.
Finish | Skip additional wizard steps, accept your entries, and go to the Configure Database dialog box, in which you can set additional options for your configuration.
Cancel | Close the wizard without taking any action, and go to the CIS Configuration File dialog box.

Enter Parameter Values dialog box

CIS displays this dialog box when you click the Print, Print Preview, or Export button in the Crystal Reports Bill of Materials dialog box.

**Use this control...** | **To do this...**
--- | ---
Parameter Fields | Choose the primary output parameter for your report.
Discrete Value | Enter a specific value for the parameter you selected in the Parameter Fields list.
OK | Save the parameters and continue with Print, Print Preview, or Export.
Cancel | Close this dialog box without taking any action.
New Database Part dialog box

CIS displays this dialog box when you do the following in the CIS Explorer window:

- Find a part on the explorer window’s Explore or Query tab, and choose Derive New Database Part from the Edit menu.

<table>
<thead>
<tr>
<th>Use this control…</th>
<th>To do this…</th>
</tr>
</thead>
</table>
| Save Part To Table | Explore or Query tab  
If accessed this dialog box from here... Then the new part will be saved here... |
| Database Property | See the name of the property in the database. |
| Orcad Property | See the name of the property as it appears on the placed part. Type the value for each property. |
| Contents | Note: You cannot change the contents of the Part Number property. |
| Visible | Sets the visibility of the property on the schematic design. You can change the visibility settings only for properties that are transferred to the design. These appear with a white background in the Visible column. Properties you cannot change are shown with a light gray background in the Visible column. |
| Schematic Part — Browse | Choose an alternate schematic part for this database part. |
| Footprint — Browse | Choose an alternate Layout footprint for this part. |
| Place Part or Link Part | Close the dialog box, enter the new part in the database, and return to the schematic page with the cursor in the place part mode. |
Select Footprints dialog box

CIS displays the Select Footprint dialog box when you click the Browse button in the Footprint area of the New Database Part dialog box.

<table>
<thead>
<tr>
<th>Use this control...</th>
<th>To do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Footprint</td>
<td>Select a footprint from the list box below, type the footprint name, or select a footprint from the drop-down list. The drop-down list includes footprints that you have previously selected.</td>
</tr>
<tr>
<td>Configured Libraries</td>
<td>Select one or more libraries to reduce the footprints in the list.</td>
</tr>
<tr>
<td>Add</td>
<td>Add the selected footprint to the Selected Footprints list.</td>
</tr>
<tr>
<td>Remove</td>
<td>Remove the selected footprint from the Selected Footprints list. The removed footprint is added to the Footprint drop-down list.</td>
</tr>
<tr>
<td>Selected Footprints</td>
<td>View the footprints that you have selected for the database part.</td>
</tr>
<tr>
<td>Move Up and Down buttons</td>
<td>Rearrange the footprints in the Selected Footprints list. The order of the footprints determines the order in which they will display in the scroll-down list of the PCB Footprint property value cells of the CIS explorer’s database parts window. The footprint at the top will be the default footprint for the database part.</td>
</tr>
<tr>
<td>Attach the Library Name</td>
<td>Include the library name with the selected footprints. You can include the library name to avoid confusing the footprint name with an identically named one in a different library.</td>
</tr>
</tbody>
</table>
**Select Schematic Part dialog box**

CIS displays the Select Schematic Part dialog box when you click the Browse button in the Schematic Part area of the New Database Part dialog box.

<table>
<thead>
<tr>
<th>Use this control...</th>
<th>To do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Schematic Part</td>
<td>Select a schematic part from the list box below, type the schematic part name, or select a schematic part from the drop-down list. The drop-down list includes schematic parts that you have previously selected.</td>
</tr>
<tr>
<td>Configured Libraries</td>
<td>Select one or more libraries to reduce the schematic parts in the list.</td>
</tr>
<tr>
<td>Add</td>
<td>Add the selected schematic part to the Selected Schematic Parts list.</td>
</tr>
<tr>
<td>Remove</td>
<td>Remove the selected schematic part from the Selected Schematic Parts list. The removed schematic part is added to the Schematic Part drop-down list.</td>
</tr>
<tr>
<td>Selected Schematic Parts</td>
<td>View the schematic parts that you have selected for the database part.</td>
</tr>
<tr>
<td>Move Up and Down buttons</td>
<td>Rearrange the schematic parts in the Selected Schematic Parts list. The order of the schematic parts determines the order in which they will display in the scroll-down list of the Schematic Part property value cell of the CIS explorer’s database parts window. The schematic part at the top will be the default schematic part for the database part.</td>
</tr>
<tr>
<td>Attach the Library Name</td>
<td>Include the library name with the selected schematic parts. You can include the library name to avoid confusing the schematic part name with an identically named one in a different library.</td>
</tr>
</tbody>
</table>
Standard Bill of Materials dialog box

CIS displays this dialog box when you point to CIS Bill of Materials on the Reports menu in either the project manager or the part manager, and choose Standard.

The bill of materials includes all the parts in a core design. All the properties for the part from the schematic and the part database are available. The report uses the contents of the schematic's property, if the property is defined, otherwise it uses the contents of the database property. The report can also display relational data provided CIS parts database has been configured as a relational database.

<table>
<thead>
<tr>
<th>Use this control...</th>
<th>To do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Template Name</td>
<td>Select a name from the drop-down list, or type a new template name in the text box. You must choose the OK button to save the template name and format.</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete the selected template from the drop-down list.</td>
</tr>
</tbody>
</table>
### OrCAD CIS User Guide
#### Dialog box descriptions

| Select Properties | Double-click on a property name to add it to the Output Format list. You can also type or select a property name, and then choose the Add button.  
**Note:** The Select Properties list only includes schematic properties that are configured to be transferred from the database. To include a schematic property in a bill of materials that is not in the part database, you must type in its exact name and then choose the Add button.  
**Default CIS property names**  
Properties transferred from placed parts on schematics  
Properties transferred from database parts  
**Title block property names**  
Title block property information is read from the first schematic page in the design and displayed in the report.  
**Note:** To view the list of relational properties, you need to select the List Relational Data Fields option.  
**Add** | Include the selected property in the report.  
**Remove** | Exclude the selected property from the report.  
**Output Format** | The properties in this list appear as successive columns in the report. The default template contains six columns: Item Number, Quantity, Value, Description, Part Number, and Part Reference.  
**Move Up and Down buttons** | Move the selected property within the Output Format list.  
**Delete User Property** | If you add a property name by typing it in the Select Properties text box, you can delete it later using this button. |
### Keyed

Check to key the selected property in the Output Format list. Keyed properties are grouped as a single item in the report.

**Note:** At least one property must be keyed. Typically, you key only the Part Number property.

### Allow Saving Title Block Properties

Check if you want to save the title block property information along with the BOM information when you save the BOM report as a .BOM, .CSV, or .FWC file.

### List Relational Data Fields

Check this option to list the relational fields available in your parts database in the Select Properties list.

**Note:** This option is enabled only if you have configured a relational parts database.

### Part Reference Options

- **Standard:** Group parts with matching keyed properties on a single line.

- **Standard - separate line per part:** List each part on its own line.

- **Compressed:** Group the same parts on a single line and compress the part references into a range whenever possible.

### List Separator

Choose:

- Space, if you want the part references in the report to be separated by spaces.

- Comma, if you want the part references in the report to be separated by commas.

### Exclude Prefixes

Type the part reference prefixes which you want to exclude from the report. To exclude more than one prefix, enter the prefixes separated with space characters.
Output Mechanical Part Data

- Mechanical parts only - Displays the quantity all the mechanical parts including the ones that are in assemblies.

- Both mechanical parts and assemblies - Displays only those mechanical parts and assemblies that are available at the root level of your design. In this case, mechanical parts within the assemblies will not be displayed.

For more information, see section Including mechanical parts and assemblies in standard CIS BOM.

Relational Data Displayed

Select this option to display relational data for the relational fields that you select in the Output Format list.

- Horizontal Output - Displays the related child item data horizontally (in the same row).

  To display the related child item data vertically (one row for each child item data), uncheck the Horizontal Output option.

- Max Rows - Defines the maximum number of related child items to display.

Export BOM Report to Excel

Select this option to export a report in spreadsheet format and open it automatically in MS Excel, when you generate a bill of materials.

Scope

Select the scope of the bill of materials. The scope can cover the entire design, or the selected schematic folders and pages.

Merge BOM Reports

If you select more than one variant in the Variant list box and select this option, the bill of materials report contains all BOM variant data, separated by variant, in the same report.

You cannot sort the report when you merge BOM reports into one report.
Unhide Columns dialog box

CIS displays the Unhide Columns dialog box when, in the database parts window of the CIS explorer, you right-click over any column heading (for example, Part Type, Part Number, Value), and then you select Unhide Columns.

Use this control... To do this...
Select Columns to Unhide Select the columns that you want to redisplay in database parts window.

Update Part dialog box

This dialog box appears if you are updating part status and CIS finds a discrepancy between the parts in the database and the parts on the schematic design.

Use this control... To do this...
DB Props Shows the database properties for the part. The discrepancy with the placed part is highlighted in red.
Sch Props Shows the placed part's properties. The discrepancy with the database part is highlighted in red.
Yes Update this placed part to match the database, then continue updating part status.
Yes All  
Update this placed part and continue updating part status, automatically updating all other placed parts that don't match the database.

No  
Don't update this placed part to match the database, and continue updating part status.

No All  
Don't update this placed part, or any other placed part with discrepancies, to match the database; continue updating part status.

**Variant Report dialog box**

CIS displays this dialog box when, from the Reports menu in either the project manager or the part manager, you choose Variant Report.

<table>
<thead>
<tr>
<th>Use this control...</th>
<th>To do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Template Name</td>
<td>Select a name from the drop-down list, or type a new template name in the text box. You must choose the OK button to save the template name and format.</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete the selected template from the drop-down list.</td>
</tr>
<tr>
<td>Variant Comparison on Part Number</td>
<td>Check if you want to create a variant report that shows only the differences in the part numbers of the design variants and the core design.</td>
</tr>
<tr>
<td>Select Properties</td>
<td>Double-click on a property name to add it to the Output Format list. You can also type or select a property name, and then choose the Add button.</td>
</tr>
</tbody>
</table>

**Note:** The Select Properties list only includes schematic properties that are configured to be transferred from the database. To include a schematic property in your variant report that is not in the part database, you must type in its exact name and then choose the Add button.

Title block property information is read from the first schematic page in the design and displayed in the report.
Add
Include the selected property in the report.

Remove
Exclude the selected property from the report.

Output Format
The properties in this list appear as successive columns in the report. The default template contains six columns: Item Number, Quantity, Value, Description, Part Number, and Part Reference.

Move Up
Move the selected property within the Output Format list.

Move Down

Delete User Property
If you add a property name by typing it in the Select Properties text box, you can delete it later using this button.

Allow Saving Title Block Properties
Check if you want to save the title block property information along with the BOM variant information when you save the variant report as a .CSV, .FWC, or .VRT file.

Display Core Design Properties
Check to display the value of a property on a part in the core design next to its variant property value. The core design property value is displayed in square brackets. For example, if the property value on a part in the core design is 91PF and property value on its variant is 82PF, the Value field in the variant report displays:

82PF [91PF]

Merge Variant Reports
If you select more than one variant in the Variants list box and select this option, the variant report contains all BOM variant data, separated by variant, in the same report.

Variants
Select one or more of the design variants for which you want to generate the variant report.
## Occurrence Level Settings dialog box

CIS displays this dialog box only when you select the Link Database Part command and the part(s) you selected on a schematic page or the part manager has more than one occurrence in the design.

<table>
<thead>
<tr>
<th>Use this control...</th>
<th>To do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link to Selected Occurrences Only</td>
<td>Link the database part to the part(s) you have selected on the schematic page or the part manager.</td>
</tr>
<tr>
<td>Link all Occurrences</td>
<td>Link the database part to all the occurrences of the selected part(s) on a schematic page.</td>
</tr>
<tr>
<td>List</td>
<td>View all the occurrences for the selected part(s) in a design. This is a view-only list.</td>
</tr>
<tr>
<td>Do not show this dialog again</td>
<td>This dialog box will not be displayed the next time you link a part(s), which has multiple occurrences in a design.</td>
</tr>
</tbody>
</table>

## Extended CIS Linking dialog box

CIS displays this dialog box when you select the Options menu, point to CIS Preferences and choose the Extended CIS Linking command from the Capture CIS window or use the SHIFT + E shortcut keys.

**Note:** This dialog box can also be accessed from the project manager or the schematic page editor.

<table>
<thead>
<tr>
<th>Use this control...</th>
<th>To do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preserve Reference Designator</td>
<td>Retain the placed part reference designator.</td>
</tr>
<tr>
<td>Preserve Symbol</td>
<td>Retain the placed part symbol.</td>
</tr>
<tr>
<td>List</td>
<td>View all the occurrences for the selected part(s) in a design. This is a view-only list.</td>
</tr>
</tbody>
</table>
Select a Design Variant dialog box

CIS displays the Select a Design Variant dialog box when you choose Variant View Mode from the schematic page editor's or the project manager's View menu.

<table>
<thead>
<tr>
<th>Use this control...</th>
<th>To do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Core Design and Variants</td>
<td>Select a design variant for which you want to display the variant information or select &lt;Core Design&gt; to display the core design.</td>
</tr>
</tbody>
</table>

Export Variant List dialog box

CIS displays this dialog box when you choose the Export Variant List command from the Tools menu.

<table>
<thead>
<tr>
<th>Use this control...</th>
<th>To do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output File (Variants.lst) Path</td>
<td>Specifies the default location for the Variants.lst file. The default location is the Allegro folder in the design directory. You can change this path also.</td>
</tr>
<tr>
<td>Config File (Variant.cfg) Path</td>
<td>Specifies the default path for the Variant.cfg file. The default path is the same as that of the Capture.exe file. You can change this path also.</td>
</tr>
<tr>
<td>Export</td>
<td>Creates a Variants.lst file containing information about all the variants of the design.</td>
</tr>
</tbody>
</table>

Note: The properties listed are the ones specified in the Variant.cfg file.
Window descriptions

The following is an exhaustive set of descriptions for the window types you may encounter using Capture CIS. Each description is listed alphabetically, using the window title.

The CIS work environment includes two specialized windows that allow you to manage your local part database and explore sources of part data—the part manager and the CIS explorer. All the CIS functionality for these windows is integrated into Capture.

CIS explorer window

The CIS explorer window allows you to search for and retrieve a variety of part information. The main window contains the following window: the local part database. The following table lists the windows available for each tabbed window. Click on any window name for more information about that window.

The CIS explorer window displays in one of two modes, depending on whether you are placing or linking a database part. The mode is displayed as part of the window title bar.

<table>
<thead>
<tr>
<th>The...</th>
<th>Is available in this tabbed window...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Footprint window</td>
<td>Local Part Database</td>
</tr>
<tr>
<td>Part window</td>
<td>Local Part Database</td>
</tr>
<tr>
<td>Visibility window</td>
<td>Local Part Database</td>
</tr>
<tr>
<td>Explorer window</td>
<td>Local Part Database</td>
</tr>
<tr>
<td>Database parts window</td>
<td>Local Part Database</td>
</tr>
</tbody>
</table>

Footprint window

The footprint window displays the PCB footprint associated with the currently selected database part.
Note: The footprint window is only available if you chose to view footprint libraries during installation.

Part window

The part window displays the Capture library part associated with the currently selected database part. If the part has a convert (such as a DeMorgan equivalent), you can select it. For a multiple-part package, you can select the specific part in the package.

The part window is contained within the CIS explorer window. To display or hide this window, select Part from the View menu in the CIS explorer.

<table>
<thead>
<tr>
<th>Use this control...</th>
<th>To do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>Select to see the primary view of the part.</td>
</tr>
<tr>
<td>Convert</td>
<td>Select to see the alternate view, such as a DeMorgan equivalent.</td>
</tr>
<tr>
<td>Parts Per Pkg</td>
<td>See how many parts are in the package.</td>
</tr>
<tr>
<td>Part</td>
<td>Select the specific part (of a multiple-part package) from the drop-down list.</td>
</tr>
</tbody>
</table>

Visibility window

The visibility window is contained within the CIS explorer window. To display or hide this window, select Visibility from the View menu in the CIS explorer.

The visibility window displays the default settings for which part properties are visible on your schematic page. You can use the visibility window to override these default settings. You can also set custom visibility settings for the current part selection.

You can also use the visibility window to display a compact summary of the part properties and their contents for the part you have selected in the database parts window. You can see more of the
properties and contents in this view because the visibility window displays them in rows rather than columns.

<table>
<thead>
<tr>
<th>Use this control...</th>
<th>To do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Property</td>
<td>See the name of the database property.</td>
</tr>
<tr>
<td>Contents</td>
<td>See the value of the property.</td>
</tr>
<tr>
<td>Visible</td>
<td>Set the visibility of the property on the schematic design. You can change the visibility settings only for properties that are transferred to the design. These appear with a white background in the Visible column. Properties you cannot change are shown with a light gray background in the Visible column.</td>
</tr>
</tbody>
</table>

- Visible CIS displays the property with the part on the schematic page.
- Invisible CIS does not display the property with the part on the schematic page.
- No change CIS does not modify the property visibility set by Capture. If the property does not exist, it is set to invisible. You can override the default visibility for specific parts when you place or link database parts. Cells that you cannot change are shown with a light gray background in this column.

**Explorer window**

The explorer window is contained in the CIS explorer. Using the explorer window, you can search for parts using local data from your preferred parts database. The window contains two tabbed sections—Explore and Query.

**Explore tab**
In the Explore tab, you can search for parts using a hierarchical tree organized by part type. At the top of the hierarchy is your database.

This icon type... Represents this... And does this when double-clicked...

- The data source name for your local database. Expands to show the tables in your database.
- A table in your local database. Expands to show the part types defined for this.
- A folder in the hierarchy Expands the hierarchy. Parts are listed in the database parts window.

**Query tab**

The Query tab allows you to further filter your selection based on parametric or field data. Use the query tab to search for a part by a property's value or a range of values. Also, you can save your queries.

**Note:** If you make changes to column width or hide a column in Explore view (Explore tab), the same settings will not be retained when you change to the Query view (Query tab) and vice-versa.

**Use this control...**  **To do this...**

- Property Select a property from the drop-down list. (The list is populated from the part database.)
- Compare Select an operator from the drop-down list.
- Value Type a value for the property type.
- Select a Query Display the query definitions for the selected query in the explorer window.
- Save Query Save the query name along with the query definitions in the CISquery.txt file.
- Delete Query Delete the query from the CISquery.txt file.
Database parts window

The database parts window is contained within the CIS explorer window.

The database parts window displays the results of your part browsing and database queries.

In the Japanese version of CIS on a Windows 98 SE machine, text in the Database parts window appears garbled. To fix this problem, you need to define a [CIS Spreadsheet] section in the Capture.ini file as shown below:

[CIS Spreadsheet]
Font=<required Japanese font>
Size=<size of font>

Tip
Roll the mouse wheel up and down to scroll through vertically in the database parts window.

Tip
Hold down the SHIFT key and roll the mouse wheel up and down to scroll through horizontally.

Tip
Click the mouse wheel button and drag it to the right or left in the database parts window to scroll horizontally.

Tip
Click the mouse wheel button and drag it up or down in the database parts window to scroll vertically.
Part manager window

CIS displays this window when, from the project manager’s Tools menu, you point to Part Manager and choose Open (right mouse button access or, in the project manager window, right-click any project folder and choose Part Manager).

The part manager tree view opens as a left pane of the part manager window. The tree view displays a hierarchy of folders containing variants of design components to be used in producing bill of materials variants.

The right side pane of the part manager window is the list view, in which you can view all the parts in the schematic design and their status. The columns listed in the following table display information about the parts:

<table>
<thead>
<tr>
<th>This column...</th>
<th>Contains this part information...</th>
</tr>
</thead>
<tbody>
<tr>
<td>#</td>
<td>The row number in the window.</td>
</tr>
<tr>
<td>Schematic Page</td>
<td>The schematic page on which the part exists.</td>
</tr>
<tr>
<td></td>
<td>The variant status of a part. CIS displays this column only if you have created design variants for the current design. Variant parts have a green check mark in their row.</td>
</tr>
<tr>
<td>Part Reference</td>
<td>The designator that uniquely identifies an instantiation of the part in the design.</td>
</tr>
<tr>
<td>Value</td>
<td>The value of the part.</td>
</tr>
<tr>
<td>Part Number</td>
<td>The number that identifies the part in the database.</td>
</tr>
<tr>
<td>Part Status</td>
<td>The current status of the part in the database. For online tips, move your cursor over the status and the tip appears.</td>
</tr>
<tr>
<td>Database Table</td>
<td>If the database has more than one table, shows the specific table name.</td>
</tr>
<tr>
<td>Source Library</td>
<td>The name and location of the schematic part library.</td>
</tr>
<tr>
<td>Source Package</td>
<td>The name and location of the schematic part package</td>
</tr>
</tbody>
</table>
Variant Property Viewer window

The variant property viewer window allows you to view properties for a variant from the design variant schematic editor.

The variant property viewer window appears when you select some combination of parts, nets, pins, title blocks, aliases and globals in the design variant schematic page editor, and then choose Properties from the Edit menu or choose Edit Properties from the pop-up menu or from the project manager, choose Object Properties from the Edit menu or choose Edit Object Properties from the pop-up menu. The variant property viewer displays all library definitions, instance properties, and occurrence properties for an object.

Note: The variant property viewer window is view-only, that is, you cannot perform any edit operation in this window.

Note: The variant property viewer window is view-only, that is, you cannot perform any edit operation in this window.

### Use this control... | To do this...
---|---
Filter by | Specify a filter by which to view the objects. You can view all the properties available on the objects in the variant property viewer by selecting the <Current properties> filter from the drop-down list.
Parts | Display the parts of the selected objects. The Parts tab includes hierarchical blocks.
Schematic Nets | Display the schematic nets of the selected objects. This tab includes constituent nets within buses.
Pins | Display the pins of the selected objects. This tab includes hierarchical pins in hierarchical blocks.
Title Blocks | Display the title blocks of the selected objects.
Globals | Display selected globals for simultaneous editing of multiple names.
Ports | Display source symbol, source library, and type of port.
<table>
<thead>
<tr>
<th><strong>Aliases</strong></th>
<th>Display color, font, name, and rotation of net aliases.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Rows and columns</strong></td>
<td>Each row displays an instance or an occurrence of an object. Instance rows appear with a white background. Occurrences appear in yellow below their associated instance row. Occurrence rows automatically appear when one or more of the occurrence property values are different from the instance property values. Each column is a placeholder that you can use to add properties. The cells in the property editor show the property values for each instance or occurrence. A cell with hash marks indicates that the property does not exist on the object that the cell represents. A property value in italics is a read only property cannot be edited.</td>
</tr>
</tbody>
</table>
Toolbar descriptions

Capture CIS has following two toolbars, to make access to CIS commands more convenient:

- CIS Explorer Toolbar
- Part Manager Toolbar

CIS Explorer Toolbar

The CIS explorer toolbar offers a quick and easy way to perform common tasks. If a tool button is gray, you can't perform that task in the current situation.

You can dock and resize the toolbar. When you put your pointer over a tool, a tip appears.

<table>
<thead>
<tr>
<th>Click this icon...</th>
<th>To do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Re-search icon" /></td>
<td>Re-searches the CIS database on the same or altered query. Equivalent to the Re-Search Database command on the Update menu.</td>
</tr>
<tr>
<td><img src="image2" alt="Database Part icon" /></td>
<td>Place Database Part. Place a database part on the schematic page. Equivalent to the Place Database Part command on the CIS explorer's Update menu.</td>
</tr>
<tr>
<td><img src="image3" alt="Expand Part Tree icon" /></td>
<td>Expand Part Tree. Display the entire part tree structure of your local part database in the explorer window. Equivalent to the Expand Part Tree command on the CIS explorer's View menu.</td>
</tr>
<tr>
<td><img src="image4" alt="Go Back icon" /></td>
<td>Go Back. Go back to the last web page that you visited. Equivalent to the Back command on the CIS explorer's Go menu.</td>
</tr>
</tbody>
</table>
Part Manager Toolbar

The part manager toolbar offers a quick and easy way to perform common tasks. If a tool button is gray, you can't perform that task in the current situation.

You can dock and resize the toolbar. When you put your pointer over a tool, a tip appears.

Click this icon...  To do this...

Link Database Part. Select a placed part and link to the database part. Equivalent to the Link Database Part command on the part manager's Tools menu and on the schematic editor's Edit menu.

Update Part Status. Update the status of each part in the part manager window. Equivalent to the Update Part Status command on the part manager's Tools menu. This command can also be invoked by pointing to Part Manager and choosing Update from the project manager's Tools menu.
Standard Bill of Materials. Create a bill of materials. Equivalent to pointing to CIS Bill of Materials and choosing Standard from the Reports menu in either the project manager or the part manager.

Crystal Reports Bill of Materials. Create a Crystal Reports report. Equivalent to pointing to CIS Bill of Materials and choosing Crystal Reports from the Reports menu in either the project manager or the part manager.

Variant Report. Generate a design variant report. Equivalent to pointing to choosing Variant Report from the Reports menu in either the project manager or the part manager.

Expand/Collapse Tree Item. In the part manager tree view, displays all items in the selected branch's hierarchy if collapsed, and compresses the hierarchy to the top level if expanded.

Show/Hide Tree View. Hide the left pane, or tree view if it is currently open. If only the list view is currently open, click this button to show the tree view.

Resolve Ambiguity. Select a BOM variant folder and click this button to choose which part to use in the BOM variant.
Additional CIS Utilities

This chapter describes the following CIS utilities:

“CIS Administration Tool” on page 249

“OrCAD - Viewlogic Translator” on page 257

“OrCAD Capture CIS Starter Database Kit” on page 257

“OrCAD CIS Wizard” on page 257

“ESP CAD Library” on page 258

CIS Administration Tool

If your OrCAD Capture® CIS designers work in a multi-user networked environment, you can leverage CIS functionality for easier management of your group’s part and footprint libraries and files you can browse. Placing libraries and files in a designated location forces all engineers to pull information from a central source. This not only promotes data integrity, since all users are getting part information from a common source, but also eases the burden of administering libraries.

The capture.ini file contains a number of switches that control how CIS finds the common libraries on a network. The database administrator can use the CIS Administration Tool to create a master capture.ini file that all network users share. This master capture.ini file then overwrites a portion of the capture.ini file on the local machine. Having all of the CIS capture.ini file switches in one location ensures that all copies of CIS are pointing to the most up-to-date location for libraries, regardless of the condition of the local capture.ini file.
Installation of the Administration Tool

1. Create an administration tools directory on a network drive that is accessible to all of the OrCAD Capture CIS network users.

   For example, you can use a subdirectory in the same location as the CIS database or libraries.

2. Unzip the components from the admintool.zip file into this location.

Components of the Administration Tool

The Administration Tool is composed of two utilities:

orcadini.exe

Is a Windows-based program used to create and edit the master capture.ini file. The capture.ini file must be formatted in a very specific way for OrCAD Capture CIS to read it. This utility provides a simple interface to limit the possibility of introducing incorrect formatting into the master capture.ini file. You can use this utility to compare the master and local capture.ini files and copy and paste information between them.

setmasterinipath.exe

Sets the registry entry HKEY_LOCAL_MACHINE\Software\Cadence Design Systems\MasterSettingsFile with the given path to the master .ini file. Run this utility on each client machine to enable it to find and utilize the master .ini file. This is a Windows console application.

Getting Started

1. Create common mapped drives on all clients to the network resource where you will store common library and configuration files (For example, configure all client O:\ drive letters to look at the same network resource.). This will speed up configuration of the client systems.
2. Create a directory structure on the network resource for Administration Tool, Submitted libraries, Approved libraries, and CIS Gold copies.

- The CIS Gold copies directory is where you will store the CIS database configuration (.dbc) file and the capture.ini file from a correctly configured client system.
- The CIS Gold copies directory is where you will store the CIS database configuration (.dbc) file and the capture.ini file from a correctly configured client system.
- The Submitted directory is where you will store all library parts that have not yet passed through the part approval process or been assigned a permanent part number.
- The Approved directory is where you will place all libraries that have been through the approval process and assigned a permanent part number.

3. In the Approved directory, create a directory for datasheets and a directory for approved OrCAD Layout® Footprints.

4. Set the following directory permissions:

<table>
<thead>
<tr>
<th>Directory</th>
<th>User</th>
<th>Permission</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administration Tools</td>
<td>All client users</td>
<td>Read Only</td>
</tr>
<tr>
<td></td>
<td>Administrator &amp; Component librarian</td>
<td>Full Control</td>
</tr>
<tr>
<td>Submitted</td>
<td>All client users</td>
<td>Change</td>
</tr>
<tr>
<td></td>
<td>Component librarian</td>
<td>Full Control</td>
</tr>
<tr>
<td>Approved</td>
<td>All client users</td>
<td>Read Only</td>
</tr>
<tr>
<td></td>
<td>Component librarian</td>
<td>Full Control</td>
</tr>
<tr>
<td>Gold copies</td>
<td>All client users</td>
<td>Read Only</td>
</tr>
<tr>
<td></td>
<td>Administrator &amp; Component librarian</td>
<td>Full Control</td>
</tr>
</tbody>
</table>
5. Place the gold copies of the CIS database configuration (.dbc) in the CIS Gold copies directory.

6. Create the master capture.ini file. The first time you run orcadini.exe, no capture.ini files are selected. Expand the CIS: (local) .ini file to select and configure each library option.

- Part Library Directories

   If you want CIS users to only place parts from libraries in a certain directory or directories, you can add entries to the Part Library Directories section in the capture.ini file. CIS Release 9.2 minimizes the library management work of CIS administrators and component librarians. Now you can set up CIS to read all the library files in a directory.

   To set this option

   - Select the Part Libraries Directories section head.
   - In the right-hand window, click on an empty box. A downward arrow icon appears in the text box.
   - Click the box to browse to the given network library location.

   In the following example, users are limited to placing parts from the Approved and Submitted directories on a network resource:

   ![Part Library Directories](image)

   When users in your workgroup place parts, CIS overrides the libraries configured in the standard OrCAD Capture Place Part dialog box and only gives users access to parts from library files in these directories. CIS loads all libraries in a specified directory into memory. If this section of the capture.ini file has no entries, CIS gives users access to the
libraries configured in the standard OrCAD Capture Place Part dialog box.

- **Temporary Part Library Directories**

  Configure CIS to save parts derived from SpinCircuit.com (ActiveParts) to libraries located in a specific directory. This makes it easier for component librarians because all new schematic symbols that need verification can be located in a common directory.

  To set this option
  - Select the Temporary Part Libraries Directories section head.
  - In the right-hand window, click on an empty box. A downward arrow icon appears in the text box.
  - Click the box to browse to the given network library location.

  You should use the Submitted directory on the network resource that you created earlier, as in the following example:

- **Footprint Library Directories**

  Configure CIS to read OrCAD Layout footprints from libraries located in a specific directory.

  To set this option
  - Select the Footprint Library Directories section head.
  - In the right-hand window, click on an empty box. A downward arrow icon appears in the text box.
Click the box to browse to the given network library location.

You should use the OrCAD Layout Footprints directory that you created in the approved directory on the network resource earlier, as in the following example:

Note: CIS can only concurrently load 62 or fewer OrCAD Layout footprints libraries into memory. If you store more than 62 libraries in the approved OrCAD Layout Footprints directory, CIS users may not be able to access some footprints in their designs.

Browse Directories

Set the default directory for the location of files that are referenced in the browsable fields of the CIS explorer, part manager, and BOM previews.

To set this option

Select the CIS Browse Directories section head.

In the right-hand window, click on an empty box. A downward arrow icon appears in the text box.

Click the box to browse to the given network library location. You should use the Datasheets directory that you created in the Approved directory on the network resource earlier, as in the following example.
You should use the Submitted directory on the network resource that you created earlier, as in the following example:

![Directories](image)

7. To save the capture.ini, choose Save from the File menu. The master capture.ini file is saved in the same location as the administration directory.

You must run setmasterinipath.exe on each local machine so the local copy of OrCAD Capture CIS has the location of the master capture.ini file. The setmasterinipath.exe program must be copied to the local system. You need to run the program from inside a console window.

8. Inside the console window, browse to the location of the utility.

9. To set the registry setting, run the utility with the path to the master capture.ini file as a switch.

For example:

```
SETMASTERINIPATH  M:\AdminTools\Capture.ini
```

**Note:**

- Double quotes are required around the path specification if it contains a space.
- If the path is not provided, the registry entry is deleted.

**Capture.ini Settings**

The capture.ini file is an ASCII text file that contains a number of sections with switches that control the look, feel, and operation of OrCAD Capture CIS. Each section is enclosed in square brackets. Before editing the capture.ini file, make sure OrCAD Capture is closed. To add a section manually, open the capture.ini file with a text editor.
editor and add the given section at the bottom of the file. Because the capture.ini file is resorted after each use, sections may appear in different places in the file.

Following are descriptions and examples of the capture.ini file sections you can reset with the CIS Administration Tool:

**OrCAD Layout Footprints**

Change the default search location for footprint libraries. OrCAD Capture CIS will search any libraries in the specified directory for footprints.

Example:

[OrCAD Layout Footprints]
dir0=\mtn_server\e drive\OrCADwin\layout\library

**CIS Browse Directories**

Set a default directory for the location of files called out in the browsable field.

Example:

[CIS Browse Directories]
dir0=\mtn_server\e drive\OrCADwin\datasheets

**Part Library Directories**

Set the locations of the libraries CIS searches to find OrCAD Capture symbols when you are placing database parts. CIS will search all libraries in the specified directory for symbols. If CIS does not locate the correct symbol library, CIS uses the directory location in the OrCAD Capture Part Selector Configured Libraries section of the capture.ini file.

Example:

[Part Library Directories]
dir0=\mtn_server\e drive\OrCADwin\custom_symbols

dir1=Z:\OrCAD\9.1\symbols\

Uninstalling the Administration Tool

1. Run the setmasterinipath.exe file without any switches.
   This prevents local machines from using the master capture.ini registry setting.

2. Delete the contents of the Administration Tools directory from the server.

For more information, go to http://www.cadence.com/orcad

OrCAD - Viewlogic Translator

You use the OrCAD - Viewlogic Translater to see Viewlogic ViewDraw designs in OrCAD Capture or Capture CIS v7.2 or later. To download the viewer and for more information, go to the following URL:

http://www.cadence.com/orcad

OrCAD Capture CIS Starter Database Kit

The CIS Starter Database contains information for more than 66,000 parts found in the Digi-Key catalog (www.digikey.com). Over 45,000 of these Digi-Key parts have an OrCAD schematic graphical representation associated with them. Using this database, you can explore, query, filter, and place Digi-Key parts directly onto your Release 9.2x Capture CIS schematic page.

For more information, go to http://www.cadence.com/orcad.

OrCAD CIS Wizard

The CIS Wizard has been created for users of Capture CIS 7.2 (or later) to simplify and assist in the creation of the Engineering Part Database. Following the installation of the CIS Database Wizard, you can create a new database or update an existing database from your schematic design files.
The CIS Database Wizard will install and run from within your Capture CIS installation. Taking an existing schematic design, you can generate a new database in one of three different formats:

- Microsoft Access 97
- Microsoft Excel
- Comma-delimited text

The CIS Database Wizard has the ability to update an existing database using the Microsoft Access 97 format only.

For more information, go to http://www.cadence.com/orcad.

**ESP CAD Library**

The ESP CAD Library provides high quality, economical electronic CAD data for parts commonly used in PCB designs. ESP CAD Library contains over 20,000 database parts - each with schematic symbol, PCB footprint, height dimensions, and manufacturers data sheet. The library contains an extensive range of components, including resistors, capacitors, inductors, connectors, transistors, and integrated circuits from hundreds of suppliers.

For more information, go to http://www.cadence.com/orcad.
CIS Error and Warning Messages

ORCIS-6158: No Part Databases have been configured

Description

CIS is configured correctly and is pointing to the correct path and database, but still an error message appears while placing a database part.

Solution

The steps to solve this problem are:

1. Select Options > CIS Configuration. The CIS Configuration dialog box appears.
2. Click Setup. Make sure that all the tables in the database are deselected.
3. Select only those tables that you wish to be available to CIS for placing parts.

Error: ORCIS-6245

The error code 6245 can occur due to several reasons. Some of the possible causes and their solutions is described below.

ORCIS-6245: Database Operation Failed (Recordset is read-only)

Possible Solutions:

- Make sure that the database (or its user permissions), the directory where the database is stored, or the ODBC data source is not configured as read-only.
Make sure that the database field names don't contain any special characters such as apostrophes (for example, Manufacturer's Part Number), which may cause the Microsoft ODBC API to return an error to CIS that the recordset is read-only. This can happen with MS Access databases.

**ORCIS-6245: Database Operation Failed (Cannot expand named range)**

**Possible Solution:**

Remove the table size constraints. You can also extract the data from the TMPRTS table into a text file, delete the TMPRTS table, and then re-create the table without size constraints. Make sure to add the TMPRTS data back into the tables; TMPRTNO and RELPARTNO.

**ORCIS-6245: Database Operation Failed (Data type mismatch in criteria expression)**

**Possible Solutions:**

There are three possible solutions for this 6245 error:

- Make sure that data types in the database are correct. This is the most common cause of this form of the 6245 error. The data type incompatibility problem is more common in Excel databases (in reality, spreadsheets) due to the ability to set data types on a cell-by-cell basis, as opposed to defining the data type for the entire field as you must do in a true database (for example, MS Access).

- Make sure that the database configuration (.DBC) file is setup correctly, that is, the Part_Number or Part_Type property types are defined during configuration.

- Make sure that the user permissions in the database are correct. Proper data types are the key to success or, if ignored, a guaranteed path to failure when implementing CIS.

**ORCIS-6245: Database Operation Failed (Data is truncated ... )**

**Possible Solution:**
It is most likely that there is a Text data element in your Microsoft Access database that exceeds 255 characters. If possible, reduce the number of characters or try switching the data format to Memo.

**ORCIS-6245: Database Operation Failed (Invalid character value for cast specification on column number 12 (Device))**

**Possible Solution:**

This error message appears when you are using an older version of Microsoft Access driver.

You can download the latest drivers from: http://www.microsoft.com/download/driver.aspx. Also make sure that the required fields are in your local part database (see the Required Part Properties table in the OrCAD Component Information System User's Guide, and that connectivity has been established (and verified) between ODBC and the database.

**ORCIS-6245: When placing a part from SQL database**

**Possible Solution:**

CIS uses double quotes (") as the default field and table delimiter for database queries. This is the standard query delimiter supported in popular ODBC databases such as Microsoft Access, Oracle, and SQL Server. If your ODBC database does not support double quotes as the query delimiter, database queries will fail. For such databases, you can specify the default field and table delimiters by adding the following two options under the [Part Management] section in the Capture.ini file:

```
[Part Management]
Field Qualifier = <field delimiter>
Table Qualifier = <table delimiter>
```

CIS uses the function supported in databases for converting string variables in queries to uppercase. If the uppercase function supported in your database is not supported by CIS, database queries may fail. You can specify the uppercase function supported in such databases, by adding the following option under the [Part Management] section in the Capture.ini file:

```
[Part Management]
```
Upper Case Function = <name of function>

**ORCIS-6245: Part cannot be updated into the database**

**Problem Description:**

The above error message appears when deriving a new part using the Derive Database Part command in the CIS Explorer window. The new part does not get added. If you have an auto number field set as the primary key in the database, you get this error during deriving database part from CIS Explorer. The derive database part function expects to write information in the auto number cell. The database expects to auto increment that property when the new part gets added and does not allow information to be written in that cell (other than the new property the database wishes to add). The error is passed back from the database through ODBC and the 6245 error appears.

**Possible Solutions:**

1. Change the auto number field to a text field in the database

   Or

   Select the part on the schematic page and then Derive the Database part. When you derive a part from a placed part, by default, CIS does not automatically copy all placed part properties to the part database. The properties that are automatically transferred will have the following three characteristics:

   - they are mapped to database part properties in the database configuration.
   - they have been set to transfer to designs in the database configuration.
   - they have a value for the placed part.

2. In the database file, set that particular property as not to be transferred to the design. Now, when you derive a part from the placed part, this property is not created and you can add new parts.

**ORCIS-6245: Too few parameters expected 1 layout footprint libraries read from directories listed in the section "layout footprints" of the capture.ini file**
Problem Description:

The error code 6245 occurs due to several reasons. In this case, it seems that there are no entries for a layout footprint library in the Capture.ini file.

Possible Solution:

Check the Capture.ini file and make sure the section [LAYOUT FOOTPRINTS] exists with the following entry:

Dir0="C:\Program Files\Orcad\Layout\Library"

where, Dir0 is the directory containing the Layout libraries.

If the Capture.ini file is correct, then check the database configuration file, it may be corrupt. Select Options > CIS Configuration. Select the database file and save it. If you still get the error message, rebuild the database file.

ORCIS-6104: Crystal Reports could not open template file <.rpt file location>. The LocalIntranet setting is not set to FullTrust on this system.

Problem Description:

This error occurs if you do not have Crystal Reports installed on your computer. For example, this will occur if your Capture installation is on a network drive.

Possible Solution:

1. Open a command prompt and go to the following location:

   C:\WINDOWS\Microsoft.NET\Framework\v2.0.50727

2. Run the following command:

   caspol -machine -chgrp 1.2 FullTrust -quiet.

Note: Running the above command has security implications. However, if you can trust the code that will be deployable on your intranet shares, this will ensure that the Crystal reports will run off a network path.
Glossary

A

administrative preferences
Options that you can set to customize database configuration features (for example, allowing duplicate part numbers or assigning temporary part numbers automatically)

allowed part reference prefixes
The part reference prefixes that you assign to the data source tables of a part database during configuration. These assignments decrease search time when you are linking database parts by limiting the data source tables that CIS searches

applicable part reference prefix
The part reference prefixes that you assign to the part types of a part database during configuration. These assignments decrease search time when you are linking database parts by limiting the part types that CIS searches.

B

bill of materials
See “BOM” on page 265

blank property
A database part property that does not have a value.

BOM
Bill of materials. A report that includes a set of properties for all the physical parts required to build a design.

browsable property
A property that is set in the configuration (.DBC) file to allow references to datasheets, drawings, and documents in your part
database. Referenced file locations can be local or Internet URLs.

C

CIS
Component Information System. A part management system that helps you manage part properties within your schematic designs, including part information required at each step in the printed circuit board design process.

CIS explorer
The environment where you search for and retrieve a variety of part information for use in your schematic designs.

core design
A schematic design from which design variants can be created.

Crystal Reports
A widely-used report design software produced by Seagate Technology, Inc. The Crystal Reports Print, Print Preview, and Export options have been integrated into OrCAD CIS to create customized bill of materials reports for printed circuit board designs.

D

data sheets
Documents published by component manufacturers that contain the specifications engineers need to select the correct parts for their printed circuit board designs.

data source
A data source consists of a database filename or server name and an associated ODBC driver with which to access the database.

database
A collection of information related to a particular subject or purpose, such as maintenance of a list of approved parts.
database configuration (.DBC) file
The file that enables CIS to access and use your part database. When you configure CIS, you can specify the database tables that CIS uses, the part properties that will be transferred to your designs, the visibility of transferred part properties, and the part type associations. This information is stored in the .DBC file.

database field name
See “table property name” on page 274

database part
A part whose identifiers and properties are collected in a database

database table
A subset of database information with a common identifier or property, such as capacitors. Tables organize data into columns (called fields) and rows (called records).

DBC
See “database configuration (.DBC) file” on page 267

design errors
Errors in the electrical connectivity of your design. If CIS finds design errors while generating a bill of materials, a dialog box will prompt you to view the errors in the session log so that you can fix them and generate a valid bill of materials.

design variant
A variation of the core design of a project that you can use to create a bill of materials for a different version of the project. All variations are kept within a single design. For more information about design variants, see the CIS online help.

E

EE
Enterprise Edition. A previous release of the OrCAD Enterprise CIS product offering. Enterprise Edition evolved from the DDL product originally developed by an OrCAD Industry Partner called Q-Point. The software was packaged and shipped under the product names OrCAD Capture EE and OrCAD Express EE.
The current release is OrCAD Capture CIS with the option to include Express and PSpice.

Enterprise Edition
See “EE” on page 267.

ERP
Enterprise resource planning. See “MRP” on page 269

F
footprint
See “PCB footprint” on page 272

I
instance
A part or a symbol that you have placed on a schematic page.

intelligent unit conversion
The method that the database query feature uses to interpret common magnitude identifiers in part definitions. For example, intelligent unit conversion recognizes 2.7K, 2,700, 2.700K, and 0.0027M to be equal.

intelligent unit conversion
The method that the database query feature uses to interpret common magnitude identifiers in part definitions. For example, intelligent unit conversion recognizes 2.7K, 2,700, 2.700K, and 0.0027M to be equal.

Internet part
Internet part A part stored in a web-based part database that is searchable over the Internet. Parts stored at the ActiveParts or supplyframe portals are Internet parts.
keyed properties

A part property that CIS searches your preferred part database for when you are trying to link a placed part to a database part. You set which properties are keyed when you are configuring your database. Normally, you set only the Value property as a key so that CIS searches the database for parts with a specific value.

Link Database Part

The command you use to link a part you’ve placed on a schematic page with a part in your preferred parts database. Once these parts are linked, you can automatically update a placed part when the database part changes.

manufacturing resource planning

See “MRP” on page 269

MIS

Management information services. The department responsible for creating and maintaining company-wide information systems.

MRP

Manufacturing resource planning. The computerized method for planning the use of a company’s resources, including scheduling raw materials, vendors, and production equipment processes.

Not Present

See “part not present” on page 271

Term

Definition
Open Database Connectivity

Open Database Connectivity (ODBC)

ODBC stands for Open Database Connectivity. It is a Microsoft technology that provides a common interface for accessing heterogeneous databases. Using ODBC, CIS interfaces directly with whatever database or spreadsheet you want to use to create and maintain your part database.

Open Database Connectivity

See “ODBC” on page 270.

package

A physical part that contains one or more logical parts. For example, a 2N3905 transistor, a fuse, and a 74LS00 are packages. Each part in a package has a unique part reference comprised of a prefix common to all the parts in the package, and a letter unique to each part. For example, a 74LS00 whose part reference prefix is U15 would have four parts whose part references are U15A, U15B, U15C, and U15D.

parts

A part is a basic building block of a design. A part may represent a physical component, or it may represent a function, a simulation model, or a text description for use by an external application. A part’s behavior is described by a SPICE model, an attached schematic folder, HDL statements, or other means. Parts usually correspond to physical objects—gates, connectors, and so on—that come in packages of one or more parts. Packages with more than one part are sometimes referred to as multiple-part packages. See also “package” on page 270.

class database

A collection of part information. See also “database” on page 266.

part description

A brief textual description of a part.
part instance
A part placed on a schematic page.

part manager
A CIS window that summarizes the status of all the parts in a design. Using the part manager, you can update part status, link database parts to placed parts, and create design variants.

part not present
A variant part setting indicating that a core schematic's part is not installed in the footprint for a design variant. You can set parts as present or not present when you create design variants.

part number
The number that uniquely identifies a part within the database

part property
A property of a part. See also “properties” on page 272.

part reference association
An association between a particular part type and the part reference prefixes used in the part database for that part type.

part reference prefix
A single letter designator for a part type. For example, C is the part reference prefix for the part type capacitor.

part status
The status of a placed part relative to the part database. Part status can be approved and current (green), in the approval process (yellow), or incorrect in the bill of materials (red).

part type
A group of parts that have similar electrical functionality, such as capacitors or resistors

part type delimiter
The character that indicates a hierarchical level within a path in the database. You can choose your part type delimiter when you are configuring your database. By default, the delimiter is a backslash (\) character
part type property contents
The part type as defined in your database's part type property (such as resistor, capacitor, or IC). When you configure your database, you can associate these part type properties with part reference prefixes.

PATH environment variable
The directory path that a Windows application uses to search for a file if the file is not in the application’s installation directory or the current working directory.

PCB footprint
A description of the physical layout dimensions of pads for a component on a printed circuit board.

PDM
Product data management. See “MRP” on page 269.

PPD
Preferred parts database. The database in which you store and maintain all the parts and part properties you use in your designs. The database parts you place on or link to your designs from the PPD remain linked to your PPD. This way, when you change a database part, CIS can automatically update the placed parts on your designs.

preferred parts database
See “PPD” on page 272.

present
See “present part” on page 272.

present part
A variant part with a core schematic’s part installed in the footprint. You can set parts as present or not present when you create design variants.

properties
A characteristic of an object that can be edited. A property consists of a name and a value. Examples of property names are part value and color. Their respective property values can be something, such as .1uF and red.
property name
The name of a part property. You can use a different name for the same property in your database than for your placed parts. You define property names when you are configuring your database. See also “properties” on page 272

property type
The property type determines how CIS interprets the database property. Your database must include a property of type Part_Number in every table. Other examples include Normal, Schematic_Part, and Part_Type. See also “properties” on page 272.

property visibility
The property type determines how CIS interprets the database property. Your database must include a property of type Part_Number in every table. Other examples include Normal, Schematic_Part, and Part_Type. See also “properties” on page 272.

Q
query
A question about the data stored in your database tables, or a request to perform an action on the data. Using CIS, you can query your preferred part database and the part database at the ActiveParts or supplyframe portals.

R
report
A report is an organized presentation of data. Using CIS, you can create standard bills of materials as well as more advanced reports using Crystal Reports templates.

S
schematic part
The name of a part as listed in a local Capture library (.OLB files) and the database parts window. The CIS explorer searches
these libraries for schematic parts when you place, link, or derive database parts.

schematic part property
The part name property. This property is required to use the Place Database Part command. When entering a name for this property, you may include the library name, a backslash (\), and then the name of the part as listed in the Capture library.

source library
A Capture or Express library from which you can place a part.

source package
The name of a part as it appears in a Capture or Express library.

SQL
Structured query language. A language used in querying, updating, and managing relational databases.

structured query language
See “SQL” on page 274.

tab-delimited file
A file whose discrete elements of data (such as part property values) are separated by tabs. You can save CIS report files in tab-delimited format and then modify the information with a spreadsheet editor or word processor.

table property name
The name of a part property as it is defined in the part database. Also known as the database field name.

table property type
The data type for a part property. Most properties are type Text, but there may be other data types.

temporary part number
A part number that CIS automatically generates to track newly created parts. CIS enters the number into the part record in the database as well as in a special table named TMPPRTS.
temporary part number prefix
The prefix that CIS appends to temporary part numbers. You can set this prefix when you configure CIS.

TMPPRTS table
A table in your part database that CIS creates when you enable temporary part number tracking. CIS automatically monitors the TMPPRTS table and notifies you if a temporary part in the design has been promoted to an approved part.

transferable properties
Properties that CIS transfers from database parts to parts you place on your schematic. You can set the properties that CIS transfers to your designs during database configuration.

U

uniform resource locator
See “URL” on page 275.

Update Part Status
The command you use to update your design’s placed part properties to reflect changes in the part database. When you update part status for your design, CIS detects property values that you have changed for part instances and allows you to retain the values for the schematic part or, when possible, choose to automatically update the values to match those in the database. CIS displays the updated part status in the part manager.

URL
Uniform resource locator. Text used for identifying and addressing an item in a computer network (for example, http://www.orcad.com). In short, a URL provides location information so that your browser can find and display items from a remote network.
value
The part value. Examples are 1.2K, 10.0uF, and 74ALS374. CIS supports the use of common magnitude identifiers (such as K and uF).

variant information
Different property values for common components or different or not present components for identical footprints on a schematic page.

variant property
A part property with a different set of values than the same part property in the core design. Variant properties are used to create design variants.

visibility
The setting that determines whether a part property is visible on your schematic page. You can set the default visibility for part properties during database configuration. You can also override default visibility settings when you place parts and when you select placed parts on the schematic page.
Index

A

About OrCAD Capture CIS command, 192
Add Part(s) to Group command, 186
adding Variant Name property, 150
administrative preferences
   Administrative Preferences tab, 64
   setting, 63
allowed part reference prefixes
   definition of, 265
   setting, 47, 59
applicable part reference prefixes
   setting, 62
assemblies, 153
auto symbol refresh, 64

B

bill of materials variants
   creating, 137
bill of materials, See BOM
blank properties
   transferring, 64
BOM
   creating a part database from a design, 38
   creating Crystal Reports templates, 69
   creating standard CIS, 153
   creating using Crystal Reports templates, 171
   definition of, 265
   exporting Crystal Reports, 175
   previewing Crystal Reports, 175
   printing Crystal Reports, 174
   Standard CIS Bill of Materials dialog box, 39, 154
browsable properties
   setting, 35, 58
browsing part properties, 91

C

CIS
   definition of, 266
   setting up, 25
CIS bill of materials, See BOM
CIS Configuration command, 45, 50, 53, 61, 63, 193
CIS Configuration File dialog box, 45, 50, 53, 61, 63
CIS explorer
   Local Part Database tab, 18
   overview, 18
   using the window, 76
CIS explorer window, 237
CISQuery.txt file, 84
commands
   CIS Bill of Materials
      Crystal Reports, 172
      Standard, 154
   CIS Configuration, 45, 50, 53, 61, 63
   Link Database Part, 104, 106
   Open Part Manager, 74, 103, 111–112, 132
   Place Database Part, 81, 90
   Save, 137, 160, 179, 183
   Save As, 137, 160, 179, 183
   Toolbar, 75
   Update Part Manager, 133
Component Information System, See CIS
configuration files
   creating, 43
   creating manually, 50
   creating using a wizard, 45
   editing, 52
   setting up, 52
Configure Database dialog box, 51, 54
Configure Part Properties command, 203
configuring CIS, for including mechanical parts in standard CIS BOM, 166
configuring custom libraries, 89
Copy command, 186
copying properties, 112
core designs
   creating design variants from, 137
creating a standard CIS BOM with mechanical parts information, 168
creating standard CIS BOM, including information mechanical parts and assemblies, 162
Crystal Reports
   Bill of Materials dialog box, 172
   creating a report from a template, 171
   creating templates, 69
   exporting a report, 175
   previewing a report, 175
   printing a report, 174
Crystal Reports command, 195
Crystal Reports, customizing, 174
custom libraries, 89
customize variant information display, 149
customizing your Crystal Report, 174
D

data sources
  definition of, 266
  setting up ODBC, 41
Database Part command, 195
Database Part command (View menu), 203
database parts
  browsing properties, 91
  creating new, 93
  deriving new, 97
  placing, 81
  querying for, 82
  working with, 73
database parts window
  overview, 21
  using, 78
database tables
  configuring part properties, 50, 53, 56
  definition of, 267
databases
  choosing a format, 26
  creating a configuration file, 43
  creating a part database, 25
  creating from an existing design, 38
  defining part reference associations, 59
  definition of, 266
  determining the part properties, 29
  extracting part information from MRP, 40
  setting the field format, 37
  setting up the ODBC data source, 41
  using more than one table, 37
Delete command, 187
deleting a saved query, 86
Derive Database Part command, 187
Derive New Database Part command, 188
deriving new database parts, 97
design variant schematic pages, preview or print, 151
design variants, view on a schematic page, 145
Dialog box descriptions, 207
dialog boxes
  Add file to project Folder, 207
  CIS Configuration File, 45, 50, 53, 61, 63, 207
  Configure Database, 51, 54, 208
    Administrative Preferences tab, 64
    Part Reference Associations tab, 62
  Configure Database (Administrative Preferences tab), 212
  Configure Database (Part Database tab), 209
  Configure Database (Part Reference Associations tab), 214–215
  Configure Part Property Display, 216
Crystal Reports Bill of Materials, 172, 217
Enter Parameter Values, 224
Export Variant List, 236
Extended CIS Linking, 235
New Database Part, 94, 225
Occurrence Level Settings, 235
Select a Design Variant, 236
Select Footprints, 226
Select Schematic Part, 227
Standard Bill of Materials, 39, 154, 228
Unhide Columns, 232
Update Part, 134, 232
Variant Report, 233
Documentation command, 193

E

EE
definition of, 267
Enterprise Edition, See EE
enterprise resource planning, See ERP
ERP, definition of, 268
Error #8012, 259
error messages, 259
Expand/Collapse Tree Item command, 203
explorer window
  Explore tab, 20, 82
  Query tab, 20, 83
Extended CIS Linking command, 194

F

file
  CISQuery.txt, 84
Footprint command, 204

H

Hide Column command, 206

I

including mechanical parts and assemblies in standard CIS BOM, 164
instances
definition of, 268
deriving new database parts, 92
updating part status, 133

K

keyed properties
  defining part reference associations, 60
Known Problems and Solutions command, 192

L

Learning OrCAD Capture CIS command, 192
Link Database command, 197
Link Database Part command, 188
  using, 104, 106
linking placed parts to database parts, preferences, 101
linking preferences
  Extended Linking command, 102

M

management information services, See MIS
manufacturing resource planning, See MRP
mechanical parts, 153
menu commands, 185
MIS, definition of, 269
modifying a saved query, 85
MRP, definition of, 269

N

New BOM variant command, 188
New Database Part dialog box, 94
New Group command, 189
New Subgroup command, 189

O

ODBC
  definition of, 270
  setting up the data source, 41
Open command, 197
Open Database Connectivity, See ODBC
Open Part Manager command, 103, 111–112, 132
packages, definition of, 270
Part command, 204
part databases
  choosing a format, 26
  creating, 25
  creating a configuration file, 43
  creating from an existing design, 38
  defining part reference associations, 59
  determining the part properties, 29
  extracting part information from MRP, 40
  setting the field format, 37
  setting up the ODBC data source, 41
  using more than one table, 37
part descriptions
  determining part properties, 29
part instances, definition of, 271
part manager
  adjusting the display, 75
  copying part properties, 111
  displaying the toolbar, 75
  linking parts, 103
  opening, 74, 132
  overview, 21
  saving the window contents, 137
  sorting information, 75, 132
  splitting into panes, 75
  updating part status, 133
  using the window, 74
  viewing and updating part status, 131
Part manager window, 242
part not present
  display value, 66
part numbers
  determining part properties, 29
  temporary, 65
part properties
  browsing, 91
  configuring CIS for use, 50, 53
  creating reports for, 152
  determining for a part database, 29
  updating for placed parts, 133
part reference associations
  defining, 59
Part Reference Associations tab, 62
part reference prefixes
  limiting database tables searched, 59
  matching to part types, 61
  setting as allowed, 47, 59
setting as applicable, 62
part status
definition of, 271
viewing, 21
viewing and updating, 131
part type delimiter
setting, 64
part type property contents
setting up part reference associations, 62
part types
defining part reference associations, 59
part window, 19
parts
browsing properties, 91
creating new, 93
definition of, 270
placing, 81
querying for, 82
Paste command, 189
PATH environment variables, definition of, 272
PCB footprints
definition of, 272
PDM, definition of, 272
Place Database Part command, 201
using, 81, 90
placing a local database part, 88
PPD, definition of, 272
preferences, linking placed parts to database parts, 101
preferred parts database, See PPD
present, See present parts
preview or print design variant schematic pages, 151
product data management, See PDM
properties
copying, 112
definition of, 272
transferring to the design, 30
property names
assigning, 29
definition of, 273
table property name, 56
property types
CIS interpretation, 56
icons in Standard CIS Bill of Materials dialog box, 155, 181
table property types, 56
property visibility
default settings, 57
overriding default settings, 58, 90
visibility settings, 57
visibility window, 20
Q

query
database, 82
definition of, 273
delete, 86
modify, 86
retrieve, 85

R

Refresh Symbols from Libs command, 202
Remove command, 189
Remove Part(s) from Group command, 190
Rename command, 190
reports
creating a part database from a design, 38
creating Crystal Reports templates, 69
creating standard CIS, 153
creating using Crystal Reports templates, 171
definition of, 273
exporting Crystal Reports, 175
previewing Crystal Reports, 175
printing Crystal Reports, 174
Standard CIS Bill of Materials dialog box, 39, 154
Re-search Database command, 201
Resolve Ambiguity command, 190
retrieving a saved query, 84
Revert to Common command, 191

S

Save As command, 137, 160, 179, 183
Save command, 137, 160, 179, 183
saving query, 84
schematic parts, definition of, 273
search for variant information on a schematic page, 147
search variant information, 147
Set Part As Not Present command, 191
Set Part As Present command, 191
setting linking preferences
Extended Linking command, 102
Setting path for custom libraries, 89
Show/Hide Tree View command, 204
sorting
bill of materials, 159, 178
part manager, 75, 132
source libraries, definition of, 274
source packages, definition of, 274
standard CIS bill of materials
   including mechanical parts and assemblies, 162
standard CIS bill of materials, See BOM
Standard command, 196
switching back to core design from design variant view, 147

T

tab-delimited files
   saving a part status report, 137
   saving a standard CIS bill of materials, 161
table property names, definition of, 274
table property types, definition of, 274
temporary part number prefixes
   definition of, 275
   setting, 66
temporary part numbers
   definition of, 274
   description, 65
   enabling, 65
   promoting to an approved part, 65
the, 76
title block, viewing variant name, 150
TMPPRTS table
   approving temporary parts, 65
   definition of, 275
Toolbar command, 75
Toolbar command (CIS explorer), 204
Toolbar command (Part Manager), 205
transferable properties
   definition of, 275
   using the Link Database Part command, 101

U

Unhide Column command, 206
uniform resource locator, See URL
Update All Part Status command, 198
Update command, 198
Update Part dialog box, 134
Update Part Status command
   using, 133
Update Selected Part Status command, 199
URL
   browsable properties, 58
   definition of, 275
values, definition of, 276
Varaint Property Viewer window, 243
variant information display, customize, 149
variant information search on a schematic page, 147
variant mark column, 139
variant properties
  definition of, 276
variant properties viewing, 150
Variant Report command, 196
Variant View Mode command, 205
Verify Part Against (OLB) Libraries command, 193
view design variants on a schematic page, 145
view variant name in title block, 150
view variant properties, 150
visibility
  default settings, 57
  definition of, 276
  overriding default settings, 58, 90
  property visibility settings, 57, 90
  visibility window, 20
Visibility command, 205
visibility window, 20

What’s New command, 192
window
  CIS explorer, 237
  Part manager, 242
  Variant Property Viewer, 243
window descriptions, 237, 245
windows
  database parts, 21, 89
  explorer
    Explore tab, 20, 82
    Query tab, 20, 83
  part, 19
  visibility, 20
wizard, using the database configuration, 45